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Safety

This chapter contains:

®  NOLICES ANA SAFBLY ...oiiiiiiiiiieeeeeeeee e e e eeeeeaeeeaeaeeas
©  ELeCErCAl SAFELY .ovviiiiiiiiieeeeeeeeee e e e e aaaa e
e OPEratioNAl SAFELY ....cviiiiiiieeeeee e e aaa e
®  MAINtENANCE SAELY ... ..ttt e e e e ettt e e e e e et e e e e e e e nsseeeeeseennnnseeas
®  Printer SYMDOIS ..o et e e e e e e e
e Environmental, Health and Safety Contact Information ...........cccevviiiieiiiiiiiiei e,

Your printer and the recommended supplies have been designed and tested to meet strict safety
requirements. Attention to the following information ensures the continued safe operation of your
Xerox printer.
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Notices and Safety

Read the following instructions carefully before operating your printer. Refer to these instructions to
ensure the continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These
include safety agency evaluation and certification, and compliance with electromagnetic regulations
and established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox®
materials only.

¥ Note: Unauthorized alterations, which can include the addition of new functions or connection
of external devices, can affect the product certification. For more information, contact your
Xerox representative.
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Electrical Safety

General Guidelines

WARNING: Do not push objects into slots or openings on the printer. Touching a voltage point
or shorting out a part could result in fire or electric shock.

& WARNING: Do not remove the covers or guards that are fastened with screws unless you are
installing optional equipment and are instructed to do so. Power off the printer when
performing these installations. Disconnect the power cord when removing covers and guards for
installing optional equipment. Except for user-installable options, there are no parts that you
can maintain or service behind these covers.

The following are hazards to your safety:

The power cord is damaged or frayed.

e Liquid is spilled into the printer.

e The printer is exposed to water.

e The printer emits smoke, or the surface is unusually hot.

e The printer emits unusual noise or odors.

e The printer causes a circuit breaker, fuse, or other safety device to activate.
If any of these conditions occur, do the following:

1. Power off the printer immediately.

2. Disconnect the power cord from the electrical outlet.

3. Call an authorized service representative.

Power Cord
Use the power cord supplied with your printer.

& WARNING: To avoid risk of fire or electrical shock, do not use extension cords, power strips, or
power plugs.

e Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the
cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check
the outlet.

e Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have
a ground connection terminal.

o Verify that the printer is plugged into an outlet that is providing the correct voltage and power.
Review the electrical specification of the printer with an electrician if necessary.

e Secure the power cord in place using the bracket provided with the printer.
e Do not place the printer in an area where people can step on the power cord.
e Do not place objects on the power cord.

¢ Do not plug or unplug the power cord while the power switch is in the On position.

Xerox® VersalLink® B71XX Multifunction Printer 13
User Guide



Safety

e If the power cord becomes frayed or worn, replace it.

e To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power
cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is
necessary to disconnect all electrical power from the printer, disconnect the power cord from the
electrical outlet.

Emergency Power Off

If any of the following conditions occur, power off the printer immediately and disconnect the power
cord from the electrical outlet. Contact an authorized Xerox service representative to correct the
problem if:

e The equipment emits unusual odors or makes unusual noises.

e The power cable is damaged or frayed.

e A wall panel circuit breaker, fuse, or other safety device has been tripped.
e Liquid is spilled into the printer.

e The printer is exposed to water.

e Any part of the printer is damaged.

Telephone Line Cord

& WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger
telecommunication line cord.
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Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your
printer.

Operational Guidelines

e Do not remove any trays when the printer is printing.

¢ Do not open the doors when the printer is printing.

e Do not move the printer when it is printing.

e Keep hands, hair, neckties, and so on, away from the exit and feed rollers.

o Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove
the protective covers.

¢ Do not override any electrical or mechanical interlock devices.

e Do not attempt to remove paper that is jammed deeply inside the printer. Switch off the printer
promptly and contact your local Xerox representative.

& WARNING: The metallic surfaces in the fuser area are hot. Always use caution when removing
paper jams from this area and avoid touching any metallic surfaces.

& WARNING: To avoid a tip hazard, do not push or move the device with all the paper trays
extended.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone.
Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment. In other
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe.

Printer Location

e Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight.
To find the weight for your printer configuration, refer to Physical Specifications.

e Place the printer in an area where there is adequate space for operation and servicing.
e Place the printer in a dust-free area.

e Do not block or cover the slots or openings on the printer. These openings are provided for
ventilation and to prevent overheating of the printer

e Do not store or operate the printer in an extremely hot, cold, or humid environment.
¢ Do not place the printer near a heat source.
e Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.

Xerox® VersalLink® B71XX Multifunction Printer 15
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Do not place the printer where it is directly exposed to the cold air flow from an air conditioning
system.

Do not place the printer in locations susceptible to vibrations.

For optimum performance, use the printer at the elevations specified in Elevation.

Printer Supplies

Use the supplies designed for your printer. The use of unsuitable materials can cause poor
performance and a possible safety hazard.

Follow all warnings and instructions marked on, or supplied with, the product, options, and
supplies.

Store all consumables in accordance with the instructions given on the package or container.
Keep all consumables away from the reach of children.
Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame.

When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can
cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can
increase the risk of skin or eye contact.

(T Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service

e

16

Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies
not specified for this printer. The Total Satisfaction Guarantee is available in the United States
and Canada. Coverage could vary outside these areas. Please contact your Xerox representative
for details.
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Maintenance Safety

e Do not attempt any maintenance procedure that is not specifically described in the
documentation supplied with your printer.

e Clean with a dry lint-free cloth only.

e Do not burn any consumables or routine maintenance items. For information on Xerox® supplies
recycling programs, go to www.xerox.com/gwa.

& WARNING: Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when
used on electromechanical equipment.

When installing the device in a hallway or similar restricted area, additional space requirements can
apply. Ensure that you comply with all workspace safety regulations, building codes, and fire codes for
your area.
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Printer Symbols

Symbol Description

Warning:

Indicates a serious hazard that can result in death or
serious injury if not avoided.

Hot Warning:

Hot surface on or in the printer. Use caution to avoid
personal injury.

Warning: Moving parts. To avoid personal injury, use
caution.

Caution:

Indicates a mandatory action to take in order to
avoid damage to the property.

Caution:

To avoid damage to the property, be careful not to
spill toner when handling the waste cartridge.

Do not touch the part or area of the printer.

Do not expose the drum cartridges to direct sunlight.

Do not burn the toner cartridges.

Do not burn the waste cartridge.

Do not burn the drum cartridges.

Do not use paper attached with staples or any form
of binding clip.

Do not use folded, creased, curled, or wrinkled paper.
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Symbol Description

Do not use inkjet paper.

Do not use transparencies or overhead projector
sheets.

Do not reload paper previously printed on or used.

Do not copy money, revenue stamps, or postage
stamps.
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Environmental, Health and Safety Contact
Information

For more information on Environment, Health, and Safety in relation to this Xerox product and
supplies, contact:

e United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)
e Europe: EHS-Europe@xerox.com
For product safety information in the United States and Canada, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/environment_europe.
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Parts of the Printer

Front View
1. Document Guides 5. Paper Trays: Configurations vary from 1 to
2. Document Feeder Input Tray ::;rrgys. Tandem Tray shown on bottom
3. Paper Output, shown with and without the Bvpass Tra
optional Center Top Tray yp y
USB Port

4. Front Door
Control Panel
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Duplex Automatic Document Feeder

1. Document Feeder Cover 3. Duplex Automatic Document Feeder Input

2. Paper Guides Tray

4. Document Output Tray
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Document Glass Guidelines

The document glass accommodates original size documents up to 297 x 432 mm (11.7 x 17.1 in.).
Use the document glass rather than the duplex automatic document feeder to copy or scan the
following types of original documents:

e Paper with paper clips or staples attached

e Paper with wrinkles, curls, folds, tears, or notches

e Coated or carbonless paper or items other than paper, such as cloth or metal
e Envelopes

e Books

Duplex Automatic Document Feeder Guidelines

The Duplex Automatic Document Feeder accommodates the following original-size documents:

e  Width: 49-297 mm (1.9-11.7 in.)

e Length: 85-431.8 mm (8.5-17 in.)

e Weight: 38-128 g/m?

Follow these guidelines when loading original documents into the duplex automatic document feeder:
e Load original documents face up, so that the top of the document enters the feeder first.

e Only use loose sheets of undamaged paper in the duplex automatic document feeder.

e Adjust the paper guides to fit the original documents.

e Insert paper in the duplex automatic document feeder only when ink on the paper is dry.

e Do not load original documents above the MAX fill line.

Internal Parts

1. Transfer Roll 3. Toner Cartridge
2. Fuser 4, Drum Cartridge

24 Xerox® VersalLink® B71XX Multifunction Printer
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Rear View
1. USB Host Port 4. Ethernet Port
2. USB Device Port 5. Foreign Device Interface
3. Wi-Fi Connectivity Port 6. Power Connection
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Finishing Options

There are two optional finishers: The Integrated Office Finisher and the Office Finisher with or
without the Booklet Maker.

Integrated Office Finisher

1. Finisher Tray 4. Staple Cartridge
2. Finisher Tray Extension 5. Finisher Front Cover
3. Integrated Office Finisher 6. Finisher Top Cover

26 Xerox® VersalLink® B71XX Multifunction Printer
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Office Finisher

o & wnN -

Booklet Maker (optional)

Booklet Maker Side Cover (optional)
Right Tray

Booklet Maker Staple Cartridge (optional)
Finisher Top Cover

Creaser Unit (optional)

10.
11.
12.

Getting Started

Staple Cartridge

Finisher Front Cover

Office Finisher

Hole Punch Waste Container (optional)
Hole Punch Unit (optional)

Horizontal Transport Cover, Center Catch
Tray

Xerox® VersalLink® B71XX Multifunction Printer
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Control Panel

The control panel consists of a touch screen and buttons you press to control the functions available
on the printer. The control panel:

e Displays the current operating status of the printer.

e Provides access to print, copy, and scan features.

e Provides access to reference materials.

e Provides access to Tools and Setup menus.

e Prompts you to load paper, replace supplies, and clear jams.
e Displays errors and warnings.

e Provides the Power/Wake button used for powering on or off the printer. This button also supports
the power-saver modes, and blinks to indicate the power status of the printer.
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Name

Power/Wake Button

Getting Started

Description

This button serves several power-related functions.

When the printer is powered off, this button powers on the
printer.

When the printer is powered on, pressing this button displays a
menu on the control panel. From this menu, you can choose to
enter Sleep mode, restart, or power off the printer.

When the printer is powered on, but in a low-power mode or
Sleep mode, pressing this button wakes the printer.

When the printer is powered on, holding this button for 10-
seconds turns off the printer.

This button blinks to indicate the power status of the printer.

When the light blinks slowly, the printer is in low-power mode
or Sleep mode.

When the light blinks rapidly, the printer is powering down, or
exiting a low-power mode.

Touch Screen Display

The screen displays information and provides access to printer
functions.

Home Button

This button provides access to the Home menu for access to
printer features, such as copy, scan, and fax.

NFC Area
(Optional)

Near Field Communication (NFC), is a technology that enables
devices to communicate when they are within 10 cm (4 in.) of
each other. Use the NFC area to obtain a network interface or
to establish a TCP/IP connection between your device and the
printer.

Note: The indicator is visible when NFC is activated.

Status LED

This light blinks blue or amber to indicate printer status.
Blue

Blinks blue once to acknowledge a successful Authentication
request.

Blinks blue once slowly for a copy or print job initiated at the
control panel.

Blinks blue twice slowly for fax or print job received from the
network.

Blinks blue rapidly while the printer is powering up, or to signal
detection of a Wi-Fi Direct connection request.

Amber

Blinks amber to indicate an error condition or warning that
requires your attention. For example, an out of toner condition,
a paper jam, or out of paper for the current job.

It also blinks amber to indicate a system error, which typically
is associated with an error code.
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Item

Name

Notification Banner

Description

Notifications and messages are displayed in a pop-up banner
below the apps area. To view the full notification, touch the
center of the banner. After you have reviewed the information,

touch X to close.

Pause Icon

When a job is being scanned or processed, a Pause icon
appears in the notification banner area. To pause the current
job, touch the Pause icon. The job pauses with the option to
resume or delete the job.

30
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Power Options

The Power/Wake button is a single multifunction button on the control panel.

e When used in conjunction with the main power switch, the Power/Wake button powers on the
printer.

o If the printer is already powered on, the Power/Wake button can be used to:
— Restart the printer
—  Enter or exit sleep mode
— Enter or exit low-power mode

e The Power/Wake button also flashes when the printer is in low-power mode.

Powering On the Printer

To power on the printer:

1. To power on the printer, open the front door, and press the power switch to the On position.

2. At the printer control panel, press the Power/Wake button.

(1) Caution: Do not unplug the power cord while the printer powers up.

Powering Off the Printer

To power off the printer:
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1. At the printer control panel, press the Power/Wake button, then touch Power Off.

2. Open the front door, then press the power switch off.

(1) Caution: Do not unplug the power cord while the printer powers down.

Entering and Exiting Sleep Mode and Low-Power
Mode

After the printer is powered on but is in Sleep Mode or Low-Power Mode:

e The touch screen appears blank and unresponsive.

e The printer exits Low-Power mode or Sleep mode automatically when it receives data from a
connected device.

To wake the printer manually, press the Power/Wake button.

Power Saver

You can set the time the printer spends idle in ready mode before the printer transitions to a lower
power level.

There are two levels of power-saver mode.
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Low-Power Timeout: The printer shifts from Ready mode to Low-Power mode to reduce standby
power consumption.

Sleep Timeout: The printer shifts from Low-Power mode to Sleep mode for a greater reduction in
power consumption.
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Accessing the Printer

Accounting

Accounting monitors the print, copy, scan, and fax impressions produced and who produces them.

The system administrator must create user accounts and enable the accounting feature. When
accounting is enabled, you must log in to the printer before accessing services. You must also provide
your account details in the print driver before printing documents from a computer. The system
administrator can set limits to restrict the total number of jobs by type that a user can produce. The
administrator can also generate reports listing usage data for individual users and groups.

For details, refer to the System Administrator Guide at www.xerox.com/office/VLB71XXdocs.

Logging In

Logging in is the process by which you identify yourself to the printer for authentication. If
authentication is set, to access printer features, you log in with your user credentials.

Logging In at the Control Panel

1. At the printer control panel, press the Home button.

2. Touch Log In.

3. Type the User Name using the keypad, then touch Enter.
4

If prompted, enter the password, then touch Enter.

¥ Note: For more information on logging in as system administrator, refer to the System
Administrator Guide at www.xerox.com/office/VLB71XXdocs.

5. Touch OK.

/’ Note: To access each password-protected service, enter the User Name and password.

Functions Related to NIST 800-171 for Local Authentication

To improve critical cybersecurity infrastructure for organizations, the National Institute of Standards
and Technology (NIST) in the United States created the Cybersecurity Framework (CSF). The system
administrator can change the NIST 800-171r2 compatible settings through the Embedded Web
Server. The NIST 800-171r2 related functions include the following features:

Prevent Reuse of User ID

The system administrator can configure the printer to prohibit the reuse of a previous user ID
value for a specified amount of time since the user ID was last used, from 1-999 days. The system
administrator can change the number of days through the Embedded Web Server.

Auto User ID Disablement

The printer disables the user accounts that have not logged in to the printer for a specified period.
The system administrator can specify the number of days, from 1-999 days. If your account is
locked after a period of time and you cannot access the printer, contact your system administrator
for assistance.
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Password Complexity

When you change a password, the printer restricts the number of characters that you can reuse
from the previous password. The system administrator specifies the maximum number of
characters that can be reused, from 1-63. The printer rejects any new password that exceeds the
specified maximum number of reused characters. If you are changing your password and
encounter an error, contact your system administrator and comply with the password complexity
requirements for your printer.

For example, if the maximum number of characters is set to 3 characters, a password of TEST123
cannot be changed to TEST444, because it contains four characters from the previous password.
A password of GOOD123 is valid, because it contains three characters from the previous password.

Reuse of Password

To prohibit the reuse of recent passwords, the system administrator can specify the interval before
a user can reuse a password. The interval range is from 1-10. If you are changing your password
and encounter an error, contact your system administrator and comply with the password
complexity requirements for your printer.

Temporary Password

After the system administrator creates a user account or changes or resets the account password
using one of the following options, when you log in, the printer can prompt a password change:

e Add
o Edit
¢ Reset Password

When the option is enabled, the password set by the system administrator is regarded as a
temporary password. When you are logged in with a temporary password, the printer prompts you
to change the password. As a security feature, you are required to change your password before
the first login at the printer. Until the temporary password is changed, remote authentication
attempts through EIP or SNMP fail for the user. Contact your system administrator for assistance.

User Account Lock-out

After a specified number of invalid login attempts for a user account, the printer locks out the
account. If you do not log in to the printer for a long period of time, your account can be disabled
automatically. Contact your system administrator for assistance.

For more information, refer to the System Administrator Guide at www.xerox.com/office/
VLB71XXdocs.

Convenience Authentication

When Convenience Authorization is enabled, users swipe a pre-programmed identification card
through a Proximity Card Reader at the control panel. To use this method, purchase and install a USB
card reader and an authentication server that supports the Xerox® Convenience Authentication API.

Smart Card

When a Common Access Card system is installed on your Xerox device, access to the printer requires
the use of a Smart Card. There are several models of card readers that are compatible with your
device. To access the printer, insert the pre-programmed identification card into the reader, or place
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your card on the reader. If extra security credentials are required, enter the login information at the
control panel.

For more information about configuring a Common Access Card system on your device, refer to the
Xerox® VersalLink® Common Access Card System Configuration Guide at www.xerox.com/office/
VLB71XXdocs.
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Introduction to Apps

Xerox Apps are a gateway to the features and functions of your device. Standard Apps are already
installed on the device and appear on the Home screen. Some Apps are installed as standard, but
hidden the first time you use the device.

When you log in, the Apps configured for your personal account appear on the control panel.

You can download more Apps for your device from the Xerox® App Gallery. For more information,
refer to Xerox® App Gallery.
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Information Pages

Your printer has a set of information pages that you can print. These pages include configuration and
font information, demonstration pages, and more.

The following Information Pages are available:

Name Name Description

Configuration Report The Configuration Report provides printer information
including installed options, network settings, port setup, tray
information, and more.

Billing Summary Report | The Billing Summary Report provides information about the

§ device and a detailed listing of the billing meters and sheet
counts.
AR Supplies Usage Report The Supplies Usage Report provides coverage information and

part numbers for reordering supplies.

PostScript Font List The PostScript Font List provides a printout of all PostScript
fonts that are available on the printer.

PCL Font List The PCL Font List provides a printout of all PCL fonts that are
available on the printer.

Demonstration Print Demonstration Print provides a demonstration of the current
print quality.
Startup Page The Startup Page provides basic printer configuration and

network information.

1E N EE L

Job History Report The printer retains information on previous print jobs, including
the date, time, job type, document name, output color (for
color devices only), paper size, number of pages, and results.
The status of a maximum of 200 jobs prints on the Job History
Report.

5

Printing Information Pages

1. At the printer control panel, press the Home button.

2. Touch Device > About > Information Pages.

3. To print an information page, touch the needed page.
4

To return to the Home screen, press the Home button.

Configuration Report

The Configuration Report provides product information including installed options, network settings,
port setup, tray information, and more.
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Printing the Configuration Report

1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.

3. Touch Configuration Report.
4

To return to the Home screen, press the Home button.
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The Embedded Web Server

The Embedded Web Server is the administration and configuration software that is installed in the
printer. It allows you to configure and administer the printer from a Web browser.

The Embedded Web Server requires:

e ATCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux
environments.

e TCP/IP and HTTP enabled in the printer.

e A network-connected computer with a Web browser that supports JavaScript.

Accessing the Embedded Web Server

At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

Finding the IP Address of Your Printer

To install the print driver for a network-connected printer, it is often necessary to know the IP address
of your printer. Also, the IP address is used to access the settings of your printer through the
Embedded Web Server. You can view the IP address of your printer on the control panel or on the
Configuration Report.

¥ Note: To view the TCP/IP address on the control panel, wait until the printer has been on for 2
minutes. If the TCP/IP address is 0.0.0.0, or begins with 169, it indicates a network connectivity
issue. However, if Wi-Fi is set as the primary Ethernet connection, 0.0.0.0 is displayed as the IP
address for the printer.

Viewing the IP Printer Address on the Control Panel
To view the IP address of the printer on the control panel:

1. At the printer control panel, press the Home button.

2. Touch Device > About.

3. Record the IP address from the display.

4

To return to the Home screen, press the Home button.

Obtaining the Printer IP Address from the Configuration Report
To obtain the printer IP address from the Configuration Report:
1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.
3. Touch Configuration Report.
The IP address appears in the Connectivity section of the Configuration Report for IPv4 or IPvé.

4. To return to the Home screen, press the Home button.
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Certificates for the Embedded Web Server

Your device includes a self-signed HTTPS certificate. The device generates the certificate
automatically during device installation. The HTTPS certificate is used to encrypt communications
between your computer and the Xerox device.

e The Embedded Web Server page for your Xerox device can display an error message that the
security certificate is not trusted. This configuration does not lessen the security of the
communications between your computer and the Xerox device.

e To eliminate the connection warning in your Web browser, you can replace the self-signed
certificate with a signed certificate from a Certificate Authority. For information on obtaining a
certificate from a Certificate Authority, contact your Internet Service Provider.

For information on obtaining, installing, and enabling certificates, refer to the System Administrator
Guide at www.xerox.com/office/VLB71XXdocs.

Downloading the Configuration Report from the
Embedded Web Server

From the Embedded Web Server, you can download and save a copy of the Configuration Report to
your computer hard drive. Use Configuration Reports from multiple devices to compare software
versions, configurations, and compliance information.

To download a copy of the Configuration Report from the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.
For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your
Printer.

2. To download the Configuration Report scroll to the bottom of the page, then, in the Quick Links
section, click Download Configuration Report.

¢ Note: If this feature does not appear, log in as a system administrator.

The document is saved automatically as an XML file in the default download location on your
computer hard drive. To open the Configuration Report, use an XML viewer.

Using the Remote Control Panel Feature

The Remote Control Panel feature in the Embedded Web Server allows you to access the printer
control panel remotely from a Web browser.

To access the Remote Control Panel, first enable the feature. For details, contact your system
administrator or refer to the System Administrator Guide at www.xerox.com/office/VLB71XXdocs.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.
For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your
Printer.
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2.

42

In the Quick Links areq, click Remote Control Panel.

3]

Note: If the Remote Control Panel option is not displayed or fails to load, contact your
system administrator.

To restrict other users from accessing the device control panel when you are connected remotely
to the device, click the Lock Device Control Panel option.

3]

Note: If a local user attempts to access the control panel while the device control panel is
locked, the control panel does not respond. A message appears on the control panel,
confirming that the control panel is locked and the device is being controlled remotely.

To enable remote access to the device control panel, click Request Session. The remote control
panel sends a request to the local control panel.

o If the local control panel is inactive, the remote control panel session is activated
automatically.

e If alocal user is active on the device, a Remote Session Request message appears on the local
control panel. The local user chooses to accept or deny the request. If the request is accepted,
the remote control panel session is activated. If the request is denied, a Request Denied
message appears in the Embedded Web Server.

¢ Note: If the system administrator requests a remote session, if the request is denied, an
option to override the local session is displayed.
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Installation and Setup

For reference:
e Installation Guide packaged with your printer

e Online Support Assistant at www.xerox.com/office/VLB71XXdocs

Installation and Setup Overview

Before you print, ensure that your computer and the printer are plugged in, powered on, and
connected. Configure the initial settings of the printer, then install the print driver software and
utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect to a network using
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different
connection methods. Routers, network hubs and switches, modems, Ethernet cables, and USB cables
are not included with your printer and must be purchased separately. Xerox recommends an Ethernet
connection because it is typically faster than a USB connection, and it provides access to the
Embedded Web Server.

For more information, refer to the System Administrator Guide at www.xerox.com/office/
VLB71XXdocs.

Selecting a Location for the Printer
1. Select a dust-free area with temperatures from 10-32°C (50-90°F), and relative humidity 10-85%.

¢ Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold
room can cause condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight
of the printer. The printer must be horizontal with all four feet in solid contact with the surface. To
find the weight for your printer configuration, refer to Weights and Dimensions. Select a location
with adequate clearance to access supplies and to provide proper ventilation. To find the
clearance requirements for your printer, refer to Total Space Requirements.

3. After positioning the printer, connect it to the power source and computer or network.
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Connecting the Printer

Selecting a Connection Method

You can connect the printer to your computer using a USB cable, Ethernet cable, or wireless
connection. The method that you select depends on how your computer is connected to the network.
A USB connection is a direct connection and is the easiest to set up. An Ethernet connection is used
to connect to a network. If you are using a network connection, it is important to understand how
your computer is connected to the network.

® Note: Hardware and cabling requirements vary for the different connection methods. Routers,
network hubs, network switches, modems, Ethernet cables, and USB cables are not included
with your printer and must be purchased separately.

usBs

If you connect the printer to one computer and do not have a network, use a USB connection. A
USB connection offers fast data speeds, but typically not as fast as a network connection.

¢ Note: To access the Embedded Web Server, a network connection is required.

Network

If your computer is connected to an office network or home network, use an Ethernet cable to
connect the printer to the network. You cannot connect the printer directly to the computer via
Ethernet. A connection through a router or network switch is required. An Ethernet network can be
used for one or more computers and supports many printers and systems simultaneously. An
Ethernet connection is typically faster than USB and allows you direct access to the settings of the
printer using the Embedded Web Server.

Wireless Network

If your environment includes a wireless router or wireless access point, you can connect the printer
to the network with a wireless connection. A wireless network connection provides the same access
and services as a wired connection. A wireless network connection is typically faster than USB and
allows direct access to the settings of the printer using the Embedded Web Server.

Telephone

To send and receive faxes, the multifunction printer must be connected to a dedicated telephone
line.

Connecting to a Computer Using USB

e Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008 R2, Windows
Server 2012, Windows Server 2012 R2, Windows Server 2016, and Windows Server 2019.

e macOS 10.15 and later.

e UNIX and Linux: Your printer supports connection to various UNIX platforms through the network
interface.

To connect the printer to the computer using a USB cable:
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1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the
printer.

2. Connect the A end of the USB cable to the USB port on the computer.
3. If the Found New Hardware Wizard appears, close the window.
4. Install the print driver.

For more information, refer to Installing the Software.

Connecting to a Wired Network

1. Ensure that the printer is powered off.

2. Attach a Category 5 or better Ethernet cable from the printer to the network or router socket. Use
an Ethernet switch or router, and two or more Ethernet cables. Connect the computer to the
switch or router with one cable, then connect the printer to the switch or router with the second
cable. Connect to any port on the switch or router except the uplink port.

Attach the power cord, then plug in the printer and power it on.

4. Set the network IP printer address, or set up the printer for automatic printer IP detection. For
more information, refer to the System Administrator Guide at www.xerox.com/office/
VLB71XXdocs.

Connecting to a Wireless Network

A wireless local area network (WLAN) provides the means to connect 2 or more devices in a LAN
without a physical connection. The printer can connect to a wireless LAN that includes a wireless
router or wireless access point. Before connecting the printer to a wireless network, the wireless router
must be configured with a service set identifier (SSID) and any necessary credentials.

¥ Note: Wireless networking is available only on printers with the optional Wireless Network
Adapter installed.

Configuring the Printer for a Wireless Network

Y Note: Before you configure wireless network settings, install the Xerox® Wireless Network
‘ Adapter Kit.

If you purchased and installed a Wireless Network Adapter Kit, you can connect the device to a
wireless network. If the device is connected to a wired network, you can configure wireless networking
at the device, or use the Embedded Web Server. For details on configuring wireless network settings,
refer to the System Administrator Guide at www.xerox.com/office/VLB71XXdocs.

After the Wireless Network Adapter is installed, remove it only as necessary. For information on
removing the adapter, refer to Removing the Wireless Network Adapter.
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Installing the Wireless Network Adapter

The optional wireless network adapter plugs in to the back of the control board. After the adapter is
installed, and wireless networking is enabled and configured, the adapter is able to connect to a
wireless network.

To install the Wireless Network Adapter:
1. Power off the printer.

a. At the control panel, press the Power/Wake button, then touch Power Off.

b. Open the front door, then press the main power switch to the Off position.

(D Caution: To avoid damage to the printer, do not unplug the power cord while the
printer powers down.

2. Remove the packaging from the Wireless Network Adapter.
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3. Toinstall the Wireless Network Adapter, follow the instructions provided with the Wireless
Network Adapter.

(D Caution: Pulling on the adapter can cause damage. After the adapter is installed, remove it
only as needed, and as directed in the Wireless Network Adapter removal instructions.

For details, refer to Removing the Wireless Network Adapter.

4, Configure the Wi-Fi settings. For details about configuring the Wi-Fi settings, refer to the System
Administrator Guide at www.xerox.com/office/VLB71XXdocs.

Removing the Wireless Network Adapter
To remove the Wireless Network Adapter:
1. Power off the printer:

a. At the printer control panel, press the Power/Wake button, then touch Power Off.

b. Wait for the printer to complete a power-off procedure. When complete, the touch screen
appears blank.
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c. Open the front door, then press the main power switch to the Off position.

(1) Caution: To avoid damage to the printer, do not unplug the power cord while the
~ printer powers down.

2. Torelease the Wireless Network Adapter from the connection panel on the side of the printer,
gently grasp the adapter and push the release lever to the side. Carefully pull the adapter away
from the printer.

i!/‘ Caution: Do not use force to pull on the Wireless Network Adapter. If the latch is released
~ properly, the adapter pulls out easily. Pulling on the adapter can damage it.
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3. Connect the printer to your computer with a USB cable or to the network with an Ethernet cable.

4, Power on the printer:
a. Open the front door, then press the main power switch to the On position.

b. At the printer control panel, press the Power/Wake button.

If the printer was installed previously in a wireless network environment, it could retain setup and
configuration information from that environment. To prevent the printer from attempting to
connect to the previous network, reset the wireless settings. For more information, refer to the
System Administrator Guide at www.xerox.com/office/VLB71XXdocs.
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Connecting to a Wi-Fi Network at the Control Panel
To connect to a Wi-Fi network at the control panel:
1. At the printer control panel, press the Home button.

2. Login as administrator. For details, refer to the System Administrator Guide at www.xerox.com/
office/VLB71XXdocs.

Touch Device > Connectivity > Wi-Fi.
4. To enable the Wi-Fi feature, touch the enable toggle button.
5. To connect automatically to an existing Wi-Fi network:

a. Inthe list of available Wi-Fi networks, touch the required network.
If the required Wi-Fi network is not listed, or if the required network uses WPS, configure the
connection manually. For details, go to the next step.

b. If needed, to log in to the network, type the password.

c. To select a Wi-Fi frequency band, touch Wi-Fi Band, then select an option.
By default, the Wi-Fi frequency band is set to AUTO.

d. Touch OK.
6. To connect manually to a Wi-Fi Network:
a. Touch Manual Setup.
b. Inthe first field, type a name for the Wi-Fi network, then touch Enter.
c. Touch Network Type, then select an option.
d. Touch Security, then select an option.
e. Touch Wi-Fi Protected Setup (WPS), then select an option.

¢ Note: For a WPS setup with a Push Button Connection (PBC), select PBC.
f. Touch OK.

Configuring the Primary Network at the Control Panel
You can set the primary network connection type at the device control panel.

e A Primary Network setup is required only if the optional Wi-Fi network connection kit is installed
and enabled.

e By default, without a Wi-Fi network connection, the primary network is set to Ethernet. When the
kit is installed and enabled, the device acquires two network connections. One network connection
is primary, and the other network connection is secondary.
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If you remove the Wi-Fi network connection module, the primary network connection is set to
Ethernet.

The following features are available only over the primary network connection:

IPsec

SMTP

SNTP

WSD scan

Scan to SFTP, Scan to SMB, Scan to Email
LDAP

UPnP discovery

ThinPrint

EIP Web Service

To configure the primary network at the control panel:

1.
2.

At the printer control panel, press the Home button.

Log in as administrator. For details, refer to the System Administrator Guide at www.xerox.com/
office/VLB71XXdocs.

Touch Device > Connectivity > Primary Network.
Select the appropriate network connection type for the device.

To apply the changes and restart the device, at the prompt, touch Restart Now.

Connecting to Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or
smartphone, using Wi-Fi Direct. Wi-Fi Direct is disabled by default.

® Note: Wireless networking is available only on printers with the optional Wireless Network
Adapter installed.

Connecting with Wi-Fi Direct from Your Mobile Device

To connect with Wi-Fi Direct, follow the directions provided with your mobile device.

Connecting to a Telephone Line

WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger
telecommunication line cord.

Ensure that the printer is powered off.

Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on
the back of the printer.

Connect the other end of the RJ11 cable to an operating telephone line.

Power on the printer.
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5. Enable and configure the Fax functions.

Initial Printer Setup

Before installing the printer software, verify that the printer is set up correctly. Setup includes
enabling the optional features and assigning an IP address for the Ethernet network connection. The
installation wizard starts automatically the first time the printer is powered on. The installation wizard
prompts the system administrator to configure the following settings:

e Language

¢ Network Connection
e Proxy Server Setup

e Date and Time

e Measurements

e LDAP Settings

e Apps Setup

e Security Settings

For more information on configuring the printer settings, refer to the System Administrator Guide at
www.xerox.com/office/VLB71XXdocs.

Configuring AirPrint

AirPrint is a software feature that allows you to print from wired or wireless Apple
i0S-based mobile devices and macOS-based devices without the need to install a
print driver. AirPrint-enabled printers allow you to print or fax directly from a Mac,
an iPhone, iPad, or iPod touch. You can use AirPrint to print from a wired device or
a wireless device without using a print driver.

e Not all applications support AirPrint.
e Wireless devices must join the same wireless network as the printer.

e For AirPrint to function, both IPP and Bonjour® (mDNS) protocols must be enabled.

e The device that submits the AirPrint job must be on the same subnet as the printer. To allow
devices to print from different subnets, configure your network to pass multicast DNS traffic
across subnets.

e The macOS device must be macOS 10.15 and later.

e AirPrint-enabled printers work with all models of iPad, iPhone (3GS or later), and iPod touch (3rd
generation or later), running the latest version of iOS.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.
If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. Inthe Embedded Web Server, click Home > Connectivity.

¢ Note: If this feature does not appear, log in as a system administrator.
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For Mobile Printing, click AirPrint.
To enable AirPrint click the Enable toggle button.

¢ Note: AirPrint® is enabled by default when IPP and Bonjour®(mDNS) are both enabled.

e To change the printer name, in the Name field, enter a new name.
e To enter a location for the printer, in the Location field, enter the location of the printer.

e To enter a physical location or address for the printer, in the Geo-Location field, enter the
geographic latitude and longitude coordinates in decimal form. For example, use coordinates
suchas 45.325026, -122.766831 for a location.

Click OK.

To activate your changes, at the prompt, click Restart Now.
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Installing the Software

Before installing driver software, verify that the printer is plugged in, powered on, connected correctly,
and has a valid IP address. The IP address usually appears in the upper, right corner of the control
panel. If you cannot find the IP address, refer to Finding the IP Address of Your Printer.

If the Software and Documentation disc is not available, download the latest drivers from www.xerox.
com/office/VLB71XXdrivers.

Operating System Requirements

e Windows 7, Windows 8, Windows 8.1, Windows Server 2008 R2, Windows 10, Windows Server
2012, Windows Server 2016, and Windows Server 2019.

e macOS version 10.15 and later.

e UNIX and Linux: Your printer supports various UNIX platforms through the network interface.

Installing the Print Drivers for a Windows Network
Printer

1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the
installer does not start automatically, navigate to the drive, then double-click the Setup.exe
installer file.

_fg Note: If the Software and Documentation disc is not available, download the latest drivers
from www.xerox.com/office/VLB71XXdrivers.

2. Click Xerox Smart Start — Driver Installer (Recommended).
At the License Agreement, click Agree.

4. From the list of discovered printers, select your printer.
When you install print drivers for a network printer, do the following:

a. If your printer does not appear in the list, click Don’t See Your Printer?

b. Enter the IP address for your printer.
If you do not know the IP address of the printer, refer to Finding the IP Address of Your
Printer.

¢. Toinstall the recommended print driver, click Continue, then select Install.
5. Click Quick Install.
A message appears that confirms that the installation is successful.

6. To complete the installation and close the installer window, click Done.

Installing the Windows Print Driver Zip File

From Xerox.com, you can download the print driver in a *.zip file. To install the print drivers on your
computer, use the Windows Add Printer Wizard.

To install the print driver from the *.zip file:

1. Download, then extract the required *.zip file to a local directory on your computer.
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At your computer, open the Control Panel, then select Devices and Printers > Add a Printer.

Click The printer that I want isn't listed, then click Add a local printer or network printer with
manual settings.

To use a previously established port, select Use an existing port, then from the list, select a
standard TCP/IP port.

To create a standard TCP/IP port, do the following:
a. Select Create a New Port.
b. For Type of port, select Standard TCP/IP Port, then click Next.
In the Hostname or IP address field, type the printer IP address or hostname.

d. To disable the feature, clear the check box for Query the printer and automatically select
the device driver to use, then click Next.

Click Have Disk.
Click Browse, then select the driver. inf file for your printer. Click Open.
Select your printer model, then click Next.

If a prompt appears because the print driver was installed previously, click Use the driver that is
currently installed (recommended).

In the Printer name field, type a name for your printer.
To install the print driver, click Next.

If needed, set the printer as the default printer.
¢ Note: Before you select Share Printer, contact your system administrator.

To send a test page to the printer, click Print a test page.
Click Finish.

Installing the Print Drivers for a Windows USB Printer

1.

Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the
printer.

Connect the A end of the USB cable to the USB port on the computer.
If the Windows Found New Hardware Wizard appears, click Cancel.

Insert the Software and Documentation disc into the appropriate drive on your computer. If the
installer does not start automatically, navigate to the drive, then double-click the Setup.exe
installer file.

_/J Note: If the Software and Documentation disc is not available, download the latest drivers
from www.xerox.com/office/VLB71XXdrivers.

Click Xerox Smart Start — Driver Installer (Recommended).
At the License Agreement, click Agree.
From the list of discovered printers, select your printer, then click Quick Install.

A message appears that confirms that the installation is successful.
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8. To complete the installation and close the installer window, click Done.

Installing the Printer as a Web Service on Devices

Web Services on Devices (WSD) allows a client to discover and access a remote device and its
associated services across a network. WSD supports device discovery, control, and use.

Installing a WSD Printer Using the Add Device Wizard

1.
2.
3.

At your computer, click Start, then select Printers and Scanners.
To add the required printer, click Add a Printer or Scanner.

In the list of available devices, select the device, then click Next.
If the printer does not appear in the list, click Cancel. To add the printer manually, use the IP
address of the printer. For details, refer to Installing the Windows Print Driver Zip File.

Click Close.

Installing the Drivers and Utilities for MacOS

o v s wnN =

10.

11.
12.
13.

Download the latest print driver from www.xerox.com/office/VLB71XXdrivers.

Open the Xerox® Print Drivers 5.xx.x.dmg or .pkg as needed for your printer.

To run Xerox® Print Drivers 5.xx.x.dmg or .pkg, double-click the appropriate file name.
When prompted, click Continue.

To accept the license agreement, click I Agree.

To accept the current installation location, click Install, or select another location for the
installation files, then click Install.

If prompted, enter your password, then click OK.

From the list of discovered printers, select your printer, then click Next.

If your printer does not appear in the list of discovered printers:

a. Click the Network Printer Icon.

b. Type the IP address of your printer, then click Continue.

c. Select your printer in the list of discovered printers, then click Continue.

If your printer was not detected, verify that the printer is powered on and that the Ethernet or
USB cable is connected properly.

To accept the print queue message, click OK.
Select or clear the Set Printer as Default and Print a Test Page check boxes.

Click Continue, then click Close.

Adding the Printer for MacOS

For networking, set up your printer using Bonjour® (mDNS), or for an LPD, LPR connection, connect
using the IP address of your printer. For a non-network printer, create a desktop USB connection.
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For more information, go to the Online Support Assistant at: www.xerox.com/office/VLB71XXsupport.

Adding the Printer Using Bonjour
To add the printer using Bonjour®:
1. From the computer Applications folder or from the Dock, open System Preferences.
2. Click Printers & Scanners.
The list of printers appears on the left of the window.
3. For the list of printers, click the Plus icon (+).
4. At the top of the window, click the Default icon.
5. Select your printer from the list, then click Add.

® Note: If your printer is not detected, verify that the printer is powered on and that the
Ethernet cable is connected properly.

Adding the Printer by Specifying the IP Address

To add a printer by specifying the IP address, perform the following:

1. From the computer Applications folder or from the Dock, open System Preferences.
2. Click Printers & Scanners.

The list of printers appears on the left of the window.

In the list of printers, click the Plus (+) icon.

Click IP.

From the Protocol list, select the protocol.

In the Address field, enter the IP address of the printer.

In the Name field, enter a name for the printer.

From the Use list, choose Select a driver to use.

From the printer software list, select the print driver for your printer model.
Click Add.

© v ©® N o v &> W
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Installing Print Drivers and Utilities for UNIX and
Linux

For more information on installing print drivers and utilities for UNIX and Linux, refer to UNIX, Linux,
and AS/400 Printing and www.xerox.com/office/VLB71XXdrivers.
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More Information

You can obtain more information about your printer from these sources:

Resource Location

Installation Guide Packaged with the printer.
Other documentation for your printer www.xerox.com/office/VLB71XXdocs
Recommended Media List United States: www.xerox.com/rmlna

European Union: www.xerox.com/rmleu

Technical support information for your printer; www.xerox.com/office/VLB71XXsupport
including online technical support, Online Support
Assistant, and print driver downloads.

Information Pages Print from the control panel. For details, refer to
Information Pages.

Order supplies for your printer www.xerox.com/office/VLB71XXsupplies
Local sales and Technical Customer Support www.xerox.com/office/worldcontacts
Printer registration www.xerox.com/register

Xerox® Direct online store www.direct.xerox.com
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Customize and Personalize Overview

This chapter provides information on how to customize and personalize your device to meet the
specific demands of your workflows.

60
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You can customize your apps, hide, or show apps on the Home screen, and rearrange the
order to suit your job priorities. For each app, you can hide or show individual features
and configure default settings to meet the needs of your workgroup. You can save job
settings for repeated use.

Customization enables users to work more productively.

When individual user accounts are configured on the device, you can personalize the
device to meet specific user needs. You can configure your personal Home page to hide
or show only the apps you use. You can tailor each feature list to your job requirements.
You can specify default settings for each app, and save settings for regular jobs.

You can create 1-Touch Apps to save and simplify lengthy or frequent workflows. Once
created, 1-Touch Apps appear on the Home screen. To start a job, touch the app.
Configure 1-Touch Apps for use by all users, individual user groups, or for personal use.

Personalization options ensure that the features and functions displayed meet individual
user needs, improving efficiency.
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Customizing or Personalizing the Home Screen

Hiding or Showing an App on the Home Screen

1. At the printer control panel, press the Home button.
2. Touch Customize.
3. Todisplay an installed app that is hidden initially:
a. Touch the Plus (+) icon.
b. Touch the app that you want to appear on the control panel.
c. Touch Done.
4, To hide an installed app:
a. For the app, touch X.
b. Touch Done.

5. Verify that only the selected apps appear on the Home screen.

Rearranging Apps on the Home Screen

At the printer control panel, press the Home button.
Touch Customize.

Touch and hold the required app.

Drag the app to the new location.

Release the app.

Touch Done.

No v Bk wN =

Verify that the apps appear in the correct location on the Home screen.
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Customizing or Personalizing the Apps

Customization enables you to modify the features available, delete a saved preset, or remove
customized settings applied to an app.

Customizing or Personalizing the Feature List

To customize the Features list for an app:

1.

2.
3.
4

At the printer control panel, press the Home button.
Touch the app required.
Scroll to the bottom, then touch Customize.

Touch Feature List.

_/J Note: For logged-in administrators, a window appears that asks you to confirm if the
changes are for a Guest or for you.

Touch the particular option.

e To hide a feature, for the required feature, touch the Eye icon. To signify that the feature is
hidden, the Eye icon appears with a line across it.

e To show a feature, for the required feature, touch the Eye icon. To signify a feature is visible,
the Eye icon appears with no line across it.

To reorder the menu features, touch and drag the features into the appropriate order.

To save the current configuration, touch Done.

Customizing or Personalizing the Entry Screen

The Entry Screen appears when the Fax, Email, USB or Scan To Apps are selected. The Entry Screen
provides options for entering recipient or destination details for a job. Use this procedure to choose
the options that to appear on the Entry Screen.

To customize the Entry Screen for an App:

1.

2.
3.
4
5
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At the printer control panel, press the Home button.
Touch the App required.

Scroll to the bottom, then touch Customize.

Touch Entry Screen.

Touch the needed options.

¢ Note: For logged-in administrators, a window appears that asks you to confirm if the
changes are for a Guest or for you.

To save the current configuration, touch X.
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Saving Presets

You can use this feature to save a particular combination of app settings for future jobs. You can save
the settings with a name and retrieve them for later use.

To save the current app settings:

At the printer control panel, press the Home button.

Touch the app required.

Select the job settings.

Scroll to the bottom, then touch Save.

Touch Save as New Preset.

Touch Enter Preset Name, then to enter a preset name, use the keypad.
Touch Next.

Select an icon that best suits the preset that you are creating.

e N U W N =

Touch Done.

_fg Note: The preset is stored within the Preset feature.

Deleting a Saved Preset

To delete a saved preset:

At the printer control panel, press the Home button.

Touch the app required.

Scroll to the bottom, then touch Customize.

Touch Presets.

Touch the Trash icon that corresponds with the preset that you want to delete.

At the prompt, touch Delete.

No v bE wN =

Touch Done.

Removing App Customization using the Control Panel

To remove the current app customization settings:

1. At the printer control panel, press the Home button.
2. Touch the app required.

3. Scroll to the bottom, then touch Customize.

4, Touch Remove App Customization.

5. At the prompt, touch OK.

Customizing App Default Settings

To customize the default settings for an app:
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At the control panel, press the Home button.
Touch the app required.

Configure the required default settings.
Touch Save.

Touch Save Defaults. The new settings override the previous default settings.

Removing Personalizations using the Embedded Web
Server

_fg Note: Personalizations include your customized Home screen, Personal 1-Touch Apps, and

Personal Favorites. This procedure removes all personalizations from your User Account.

To remove all personalizations from your User Account:

1.

64

At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

In the Embedded Web Server, click Log In, then click on your user account. If required, enter your
password and click Log In.

To access your User Profile, click on your User Account name shown in the top right corner, then
click My Profile.

All personalizations you have configured for your User Account are displayed.
To remove all personalizations, click Reset. To confirm, click Reset.
All the personalizations configured for your User Account are removed.

To log out, click on your User Account name shown in the top right corner, then click Log Out.
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Creating and Using 1-Touch Apps

Use 1-Touch Apps to create individual Apps for completing frequent jobs or tasks. After you create a
1-Touch App, the App appears on the printer control panel Home screen. To run the job, load the
original documents, then touch the 1-Touch App.

You can create 1-Touch Apps as Public or Personal Apps. Personal 1-Touch Apps only display on the
Home screen after login.

Creating a 1-Touch App

To create a 1-Touch App:

10.
11.

12.
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At the printer control panel, press the Home button.

Touch the App required.

Select the job settings.

Scroll to the bottom, then touch Save.

Touch Save as 1-Touch App.

Touch Enter App Name, then use the keypad to enter a name. Touch Next.

Touch a color scheme option for your 1-Touch App, then touch Next.

Touch an icon that best suits the 1-Touch App that you are creating, then touch Next.
Touch the option required.

o Review Before Start: Use this option to review the job settings in the 1-Touch App. For copy
jobs, you can change the copy quantity for each job.

o Start Immediately: Use this option to start the job without reviewing the settings.
Touch Next.
If you selected Review Before Start, select the options for displaying instructions and settings.

o Enter App Instructions: Use this option to provide instructions for using the 1-Touch App.
When the 1-Touch App is selected, the instructions appear at the top of the screen. To enter
instructions, use the keypad, then touch Next.

e Show Quantity: Use this option to allow users to view and update the quantity.

e Show Settings: Use this option to display a summary of the features programmed for the 1-
Touch App.

Touch Done.

The 1-Touch App appears on the Home screen.

Creating a Personal 1-Touch App

To create a personal 1-Touch App:

1.
2.

At the printer control panel, press the Home button.

Touch Login, then enter a valid login name and password.
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11.
12.

13.
14.

15.

Touch the App required.

Select the job settings.

Scroll to the bottom, then touch Save.

Touch Save as 1-Touch App.

Touch Enter App Name, then use the keypad to enter a name. Touch Next.

Touch a color scheme option for your 1-Touch App, then touch Next.

Touch an icon that best suits the 1-Touch App that you are creating, then touch Next.
Touch the option required.

o Review Before Start: Use this option to review the job settings in the 1-Touch App. For copy
jobs, you can change the copy quantity for each job.

e Start Immediately: Use this option to start the job without reviewing the settings.
Touch Next.
If you selected Review Before Start, select options for displaying instructions and settings.

o Enter App Instructions: Use this option to provide instructions for using the 1-Touch App.
When the 1-Touch App is selected, the instructions appear at the top of the screen. To enter
instructions, use the keypad, then touch Next.

e Show Quantity: Use this option to allow users to view and update the quantity.

e Show Settings: Use this option to display a summary of the features programmed for the 1-
Touch App.

Touch Next.
Touch the option required.

e Personal (My Home Screen Only): Use this option to display the 1-Touch App on your Home
screen only when you are logged in to your user account.

e Public (Public Home Screen): Use this option to make the 1-Touch App accessible to all users.

Touch Done.

Deleting or Hiding a 1-Touch App

To delete or hide a 1-Touch App from the Home screen:

1.
2.
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At the printer control panel, press the Home button.

If deleting or hiding a Personal 1-Touch App, touch Login, then enter a valid login name and
password.

Touch Customize.
For the required 1-Touch App, touch X, then touch an option.
e Delete: Use this option to delete the 1-Touch App from the printer permanently.

e Hide: Use this option to remove the 1-Touch App from the Home screen. The 1-Touch App is
still available, and you can add the App to the Home screen at any time.

Touch Done.
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Using a 1-Touch App

To use a 1-Touch App:
1. At the printer control panel, press the Home button.

2. If you are using a personal 1-Touch App, touch Login, then enter a valid login name and
password.

Load your original documents.
Touch the 1-Touch App required.
Do one of the following.

o If the Review Before Start option was selected during 1-Touch App setup, review the settings.
If the quantity is displayed for Copy jobs, update the number of copies, as required. Touch
Start.

e If the Start Immediately option was selected during 1-Touch App setup, the device starts
automatically.

6. To return to the Home screen, press the Home button.
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Xerox® Apps are a gateway to the features and functions of your device. There are standard apps
already installed and displayed on the Home screen. There are also apps that are installed as
standard but are hidden when your device is used for the first time.

For more information about customizing the Home screen and the apps features, refer to Customize

and Personalize.

A range of apps is available for download and installation from the Xerox® App Gallery. These include
Xerox® Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on

compatible printers.
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Xerox® App Gallery

Xerox® App Gallery Overview

Use the Xerox® App Gallery to find apps that provide new features or capabilities for
your device. The Xerox® App Gallery provides direct access to apps that can improve
your productivity, simplify workflows, and enhance your user experience.

The Xerox® App Gallery enables you to browse and update apps easily. You can browse through the app
library without logging in. The moving banner provides an active display of apps, or you can scroll the full list
of apps. To get more details on an app, touch the app name in the list.

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or the wired
network connection.

_fg Note: If a local server inside a firewall hosts your device and a proxy is enabled, set a proxy
exception at the device.

For more information and instructions on using the Xerox® App Gallery, refer to the Xerox® App
Gallery User Guide available at www.xerox.com/office/VLB71XXdocs.

Creating a Xerox® App Gallery Account

With an App Gallery account, you have direct access to all the available apps for your device. An App
Gallery account allows you to view and acquire apps, install apps on your device, and manage your
apps and licenses.

® Note: If you have an existing Xerox® App Gallery Account, refer to Logging into your Xerox®
App Gallery Account.

To create an App Gallery account using the control panel:
1. At the printer control panel, press the Home button.
2. Touch Xerox App Gallery.
3. Do one of the following:
e On the blue scrolling panel, touch Create an App Gallery Account Now.

e To log in, touch the Person icon. Touch the top of the Log In page, then touch Request an
Account.

_/J Note: The keypad covers the Request an Account link. To reveal the Request an Account
link, touch the top of the Log In page, or minimize the keypad.

4, Enter a valid email address using the touch screen keypad, then touch Enter.

A message appears stating that completion instructions have been sent to the email address that
you entered. Touch Close.

Access the email account for the email address that you provided to the Xerox® App Gallery.

Open the account request email, then click the URL link provided to access the create account
page. Click Agree.
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Xerox® Apps

Review and accept the Terms of Use. To continue creating an account, click Agree.
Enter the information required into the appropriate fields:

e UserID

e Password

e Confirm Password

e First and Last Name

e Company Name

e Country

Click OK.

After the account is created, a confirmation message appears.

At the printer control panel, log in to your App Gallery Account.

Logging into your Xerox® App Gallery Account

When you are logged in to the App Gallery, you can browse available apps, and install and update
apps.

To log in to your App Gallery Account:

1.

2
3.
4
5

At the printer control panel, press the Home button.

Touch Xerox® App Gallery.

To log in, touch the Person icon.

Enter your User Name using the touch screen keypad, then touch Enter.
Enter your Password using the touch screen keypad, then touch Enter or OK.

The Xerox® App Gallery opens.

Installing or Updating an App from the Xerox® App
Gallery

Xerox® Apps add, extend, or customize the functionality of your device. You can use the Xerox® App
Gallery to browse and install apps at your device control panel.

Installing an App from the App Gallery

To install an app from the App Gallery:

1.
2.

3.

At the printer control panel, press the Home button.

Touch Xerox App Gallery. The App Gallery opens.

® Note: You can browse the App Gallery and view app descriptions without being logged in.
To install apps, you must be logged in to the App Gallery.

Touch the Person icon.
a. Enter your User Name using the touch screen keypad, then touch Enter.
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b. Enter your Password using the touch screen keypad, then touch Enter or OK.
Touch the desired app, then touch Install. The License Agreement appears.

Touch Agree. The installation process begins.

® Note: If the app does not install successfully, to attempt the installation process again,
touch Install.

When the installation completes, touch X.

The app appears in the list of installed apps.

Updating an App from the App Gallery

To update an app from the Xerox® App Gallery:

1.
2.

At the printer control panel, press the Home button.

Touch Xerox App Gallery. The App Gallery opens.

¥ Note: You can browse the App Gallery and view app descriptions without being logged in.
To update apps, you must be logged in to the App Gallery.

Touch the Person icon.
a. Enter your User Name using the touch screen keypad, then touch Enter.
b. Enter your Password using the touch screen keypad, then touch Enter or OK.

Touch Installed. The list shows all installed apps, and any apps eligible for update. You can
update apps individually or all apps at once. Touch the desired app, then touch Update or
Update All. The License Agreement appears for each app.

¢ Note: If no updates are available, the Update feature does not appear.

To accept the license agreements, touch Agree for each app.

When the update completes, touch X.

Logging out of your App Gallery Account

To log out of your Xerox® App Gallery account:

1.
2.

72

Touch the Person icon.

Touch Logout.
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Device

Device Overview

The Device App gives you access to information about your printer, including the
serial number and model. You can view the status of the paper trays, billing and
supplies information, and print Information Pages.

You can configure many Device options to meet your individual needs. For details about configuring
all Device settings, refer to the System Administrator Guide at www.xerox.com/office/
VLB71XXsupport.

Device Options

For details on configuring the printer settings, refer to the System Administrator Guide at www.xerox.
com/office/VLB71XXdocs.

The following Device options are available:

Option Description

Language Language allows you to set the language that appears on the control

panel.

About The About option provides an overview of your device and its current
settings and status. You can access Information Pages and reports using
this option.

Software Update | Use this option to check for software updates and configure update
settings.

Notifications Use the Notifications option to see details of current alerts or faults on

the device. A History button displays fault codes and the date that the
fault occurred on the device.

Paper Trays Use the Paper Trays option to see the paper size, type, and color set for
each paper tray and the tray-capacity status.

Supplies Use the Supplies option to monitor the status of the components you can
replace. The supply level and estimated number of impressions or days
left for each unit is displayed.

Billing/Usage Use the Billing/Usage option to view the serial number and the total
number of impressions made by your device.

General Use the General option to customize settings such as the power-saver
modes, date and time, and control panel brightness. You can configure
the General settings using the device control panel, or by using the
Embedded Web Server.
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Xerox® Apps

Option Description

Apps Use Apps to select settings for the apps installed on your device.
Connectivity Use the Connectivity option to configure network settings at the control
‘., panel, or join another wireless network.
Support Use this option to access and print the Support Pages to assist with
troubleshooting errors.
/ Resets Use the Resets option to reset device settings and font, forms, and macros
/ to the factory-default settings.

About

The About option provides an overview of your device and current settings and status. You can access
Information Pages and reports using this option.

Supply Status

You can check the status and percentage of life remaining for your printer supplies at the control
panel or from the Embedded Web Server. When printer supplies near their replacement time, warning
alerts appear on the control panel. You can customize the alerts that appear on the control panel and
configure email alert notifications.

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System
Administrator Guide at www.xerox.com/office/VLB71XXdocs.

Checking the Supplies Status at the Control Panel
1. To view status information for the printer supplies, touch Device > Supplies.

2. To view details about a specific item, including part numbers for reordering, touch the specific
item.

To return to the Supplies screen, touch X.

4,  To return to the Device screen, touch the back arrow.

Customizing Supplies Alert Settings
1. To customize the alerts that appear for printer supplies, touch Device > Supplies > Alerts Setup.
2. To enable supplies alerts that appear on the control panel, touch the Enable Alerts toggle button.

3. To configure the printer to display an alert when an item reaches a specific usage percentage
level, touch the item, then select the percentage.

4. To customize the alerts for each supply item, or to enable or disable an alert, touch the toggle
button.

5. To return to the Supplies screen, touch X.
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6. To return to the Device screen, touch the back arrow.

Setting Up Email Alerts

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System
Administrator Guide at www.xerox.com/office/VLB71XXdocs.

1.
2.
3.

To set up alerts to send to an email address, touch Device > Supplies > Email Alerts.
To enter an email address, touch Add Email, then touch Enter Email Address.

Use the touch screen keyboard to enter an email address, or select an entry from the Address
Book, then touch OK.

Add more email addresses if necessary.

To customize the alerts for each supply item, or to enable or disable an alert, touch the toggle
button.

To exit the menu, touch OK.

To return to the Device screen, touch the back arrow.

Billing and Usage Counters

The Billing/Usage menu displays the total number of impressions that the printer generated or
printed during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of
paper. For example, a sheet of paper that is printed on two sides counts as two impressions.

To view the Billing and Usage Counters:

1.
2.

At the printer control panel, press the Home button.

Touch Device > Billing/Usage. The impression counts appear:

e Black Impressions: Total number of pages printed with no color specified.

e Total Impressions: Total number of color impressions and black impressions.
To view more details, touch Usage Counters, then select an option.

e Impression Counters: This option provides the number of impressions made by the printer.
The number of impressions cannot equal the number of sheets counted, depending on the
printer setup. If your printer is set up to count large sheets as large impressions or as multiple
smaller impressions, the number of impressions can differ.

e Sheet Counters: This option provides the number of impressions made by the printer.
Impressions for 2-Sided sheets are identified as a separate line from 1-Sided sheets.

e Images Sent Counters: This option provides the number of images sent using the Fax, Email,
or Scan features.

e Fax Impressions Counters: This option provides the number of images sent using the Fax
features. Each fax feature is identified on a separate line.

¢ All Usage Counters: This option provides all printer usage information.

After viewing the usage readings, to return to the Home screen, press the Home button.
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Reset to Factory Defaults

The non-volatile memory (NVRAM) stores printer settings, even after the power is turned off. The
Reset to Factory Defaults feature erases all settings and returns the printer to original factory state.
All jobs, presets, apps, and device settings are reset. If the printer includes a hard disk, the disk is
reinitialized. When complete, the printer restarts, then displays the Install Wizard.

To reset the printer to factory defaults:

1.

2.
3.
4

At the printer control panel, press the Home button.
Touch Device > Resets > Reset to Factory Defaults.
At the prompt, touch Reset.

When the process is complete, the printer restarts automatically.

Remote Services

You can use the Remote Services option in the Embedded Web Server to send error and usage
information to the Xerox support team to help them resolve problems quickly.

For information about enabling Remote Services and uploading information to Xerox, refer to the
System Administrator Guide at www.xerox.com/office/VLB71XXdocs.

76

Xerox® VersalLink® B71XX Multifunction Printer
User Guide


https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB71XX&PgName=Man

Xerox® Apps

Address Book

Address Book Overview

Use the Device Address Book to create individual contacts or group contacts for use
with the Email, Fax, and Scan To Apps. You can add contacts to the Device Address

Book using the control panel or the Embedded Web Server. This feature can also be
used to scan to the Address Book contacts.

Before you can use this feature, the System Administrator must enable users to view and manage the
Device Address Book.

Editing the Address Book

You can create and save contact information for individual contacts or groups. You can manage
address book contacts at the control panel, or in the Embedded Web Server.

Adding or Editing Contacts in the Address Book at the Control
Panel

Adding Contacts in the Address Book at the Control Panel
1. At the printer control panel, press the Home button.

2. Touch Address Book.

3. Touch the Plus icon (+), then select Add Contact.

4

To enter a name, touch the Enter First Name, Enter Last Name, or Enter Company field, then
enter the information. To move to the next field, touch Next. When finished, touch Enter.

5. Enter the contact details:

e To add an email address to the contact, touch Add Email. Enter an email address, then touch
Enter.

e To add a fax number to the contact, touch Add Fax. Enter a fax number, then touch Enter.

e To add an SMB scan location, touch Add SMB. Browse to the location required, then touch
Enter.

e To add an FTP scan location, touch Add FTP. Browse to the FTP location or enter the FTP
address, then touch Enter.

¢ Note: If authentication is required for scan locations, enter a valid login name and
' password.

To mark the email address or fax number as a favorite, touch the Star icon.
To save the contact, touch OK.

To return to the Home screen, press the Home button.

Editing or Deleting Contacts in the Address Book at the Control Panel
1. At the printer control panel, press the Home button.
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Touch Address Book.
From the Address Book, touch a contact name, then touch Edit.

To change contact information, touch the information that you want to update, edit as needed,
then touch OK.

To save your contact changes, touch OK.
To delete a contact, touch Delete Contact, then touch Delete.

To return to the Home screen, press the Home button.

Adding or Editing Groups in the Address Book at the Control Panel

Adding Groups in the Address Book at the Control Panel

1.

2.
3.
4
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At the printer control panel, press the Home button, then touch Address Book.
Touch the Plus icon (+), then select Add Group.
Select the group type.

To enter a group name, touch Enter Group Name, then enter a name using the touch screen
keypad. Touch Enter.

To add group members, touch Add Member.

To add a contact name, from the Favorites or Contacts menu, select a contact.
To add more group members, touch Add Member, then select a contact.

To mark the group as a favorite, touch the Star icon.

To save the group, touch OK.

To return to the Home screen, press the Home button.

Editing or Deleting Groups in the Address Book at the Control Panel

© v ¥ N U B WN =
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At the printer control panel, press the Home button.

Touch Address Book.

From the Address Book, select a group, then touch Edit.

To add group members, touch Add Member.

To add a contact, from the Favorites or Contacts menu, select a contact.

To add more group members, touch Add Member, then select a contact.

To remove group members, for each contact, touch the Trash icon. At the prompt, touch Delete.
To save the changes, touch OK.

To delete the group, touch Delete Group, then touch Delete.

To return to the Home screen, press the Home button.
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Adding or Editing Contacts in the Address Book in the Embedded
Web Server

Adding Contacts in the Address Book in the Embedded Web Server

To add contacts:

1.

i &~ W N

At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

In the Embedded Web Server, click Address Book.

Click Add Contact.

To enter a name, click the First Name, Last Name, or Company field, then enter the details.
Enter the contact details.

e To add an email address to the contact, click the Email Plus icon (+), then enter an email
address.

e To add a fax number to the contact, click the Fax Plus icon (+), then enter a fax number.

e To add an SMB scan location, click the (Network) SMB Plus icon (+), then enter the SMB
details. Click OK.

e To add an FTP scan location, click the FTP Plus icon (+), then enter the FTP details. Click OK.
To mark the email address or fax number as a favorite, touch the Star icon.

To save the contact, click OK.

Editing or Deleting Contacts in the Address Book in the Embedded Web Server

To edit or delete contacts:

1.

At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

In the Embedded Web Server, click Address Book.

From the Address Book, select a contact.

To edit contact information, perform the following steps.

a. Click the contact name or contact information, then edit as needed.

b. To clear contact information, for the specific contact information, click the Trash icon.
c. To save the changes, click OK.

To remove the selected contact from the Address Book, click Delete. At the prompt, click Delete.

Adding or Editing Groups in the Address Book in the Embedded
Web Server

Adding Groups in the Address Book in the Embedded Web Server
To add groups:
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At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

In the Embedded Web Server, click Address Book.

Click Add Group.

For Enter Group Name, enter a name for the group.

From the menu, select the group type.

To add group members, for Members, click the Plus icon (+).

To add contacts to the group, in the Add Members window, for each contact, select the check box.
When you are finished, click OK.

To save the group, click OK.

Editing or Deleting Groups in the Address Book in the Embedded Web Server

To edit or delete groups:

1.

At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

In the Embedded Web Server, click Address Book.
Within the address book, select a group.

To add group members:

a. For Members, click the Plus icon (+).

b. Inthe Add Members window, select the check box for each required member.
c. To save the changes, click OK.

To remove group members:

a. For the required member, click the Trash icon.

b. At the prompt, click Delete.

¢. Repeat the previous two steps for each member.
d. To save the changes, click OK.

To remove the selected group from the Address Book, click Delete. At the prompt, click Delete.

Advanced Settings

The Advanced option provides more settings for importing and exporting contact details and
managing contacts. You can use the Advanced option to set up a directory service.

For details about the Advanced options, refer to the System Administrator Guide at www.xerox.com/
office/VLB71XXdocs.

Creating and Managing Favorites

You can mark contacts as Favorites. A star next to a contact in the list indicates a Favorite. You can
mark a favorite as a Global Favorite for all services or as a Favorite for email, fax, or scan-to
destinations.
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You can create Favorites as Public or Personal. Personal Favorites are created when a logged-in user
adds one or more address to the destination list of a Favorite. Once Personal Favorites are created, the
Address Book displays Personal Favorites instead of Public Favorites.

¥ Note: The maximum number of Personal Favorites that can be added for each user account is
25. Logged-in users will not see any Favorites if there no Personal Favorites and the number of
Public Favorites is greater than 25.

Creating and Managing Favorites at the Control Panel
1. At the printer control panel, press the Home button, then touch Address Book.
2. Select a contact, then touch Edit.
3. To make the contact a Global Favorite, for the contact name, touch the Star icon.
4. To mark a contact as a Favorite for email, fax, or a scan-to destination:
a. For each desired feature, touch the Star icon.
b. To save changes, touch OK.
5. To clear a contact marked as a Favorite:
a. To remove the contact as a Global Favorite, for the contact name, touch the Star icon.

b. To remove the contact from the Favorite list for a selected feature, for the selected feature,
touch the Star icon.

c. To save changes, touch OK.

6. To return to the Home screen, press the Home button.

Creating and Managing Favorites in the Embedded Web Server
1. Inthe Embedded Web Server, click Address Book.

2. Select a contact.

3. To make the contact a Global Favorite, click the Global Favorite Star icon.

4

To mark a contact as a Favorite for email, fax, or a scan-to destination, for each feature, click the
Star icon.

5. To remove a contact marked as a Favorite, for Global Favorite or the selected feature, touch the
Star icon. The contact is removed from the Global Favorite list, or the Favorite list for the selected
feature.

6. To save changes, click OK.

Creating and Managing Personal Favorites

Personal Favorites can be created for individual apps when you are logged in to your user account on
the device. You can set up Personal Favorites in the Scan To, Email, and Fax Apps. Each app can store
up to 25 Personal Favorites for each user account. You can select and create Personal Favorites from
the local Address Book for the device.

By default, there are no Personal Favorites set up. Personal Favorites are created when you log in and
add one or more addresses to the destination list of your Favorites. After you create your Personal
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Favorites, they are shown in your Favorites list each time you log in and use the device.

When a change is made to a contact in the Address Book, the information is also updated for your
Personal Favorite. When you remove a contact or address from the Address Book, the entry is also
removed from your Personal Favorites.

When you use the Embedded Web Server Cloning feature, you can import and export Personal
Favorites. For details, refer to the System Administrator Guide at www.xerox.com/office/
VLB71XXsupport.

When you reach the limit of 25 Personal Favorites within an app, you are required to delete a
Personal Favorite before you can add a new one.

Only an address registered in the Address Book for a particular app, can be set up as a Personal
Favorite within the app. For example, if a contact only has an email address entered, then it can
only added as a Personal Favorite in the Email App.

Before you can create Personal Favorites, the System Administrator is required to give you
permission to view and manage the Device Address Book, and to Customize Features Within Apps.

Creating Personal Favorites

To create a Personal Favorite:

1.

2.
3.
4
5

At the printer control panel, press the Home button.
Touch Login, then enter a valid login name and password.
Load the original documents.

Touch the app required.

Touch the address book icon, then touch Contacts. To add a recipient, select a recipient from the
list.

Select the job settings.

For details about available features, refer to Apps Features.

Scroll to the bottom, then touch Customize.

Touch Favorites, then touch Add Favorite.

A list of contacts appears.

Touch the contact to add to your Personal Favorites, then touch Done.
To complete the job, touch Send or Scan.

When you log in to your user account again, the Personal Favorite is available.

Using Personal Favorites

To use a Personal Favorite:

1.
2.

82

At the printer control panel, press the Home button.

Touch Login, then enter a valid login name and password.
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Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder,
use the document glass. Lift the document feeder, then place the original document face
down in the upper-left corner of the document glass.

e For single, multiple, or 2-sided pages, use the duplex automatic document feeder. Remove any
staples and paper clips from the pages. Insert the original documents face up in the
document feeder, with the top of the page entering the feeder first. Adjust the paper guides
so that they fit against the documents.

Touch the app required.
To select a Personal Favorite, touch the Address Book icon, then touch Favorites.
A list of Personal Favorites appears for the app.

To add the recipient or scan destination details, touch the Personal Favorite required. Repeat the
procedure to add more recipients or destinations.

If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an
option.

Adjust the job settings as needed.

For details about available features, refer to Apps Features.

Touch Send or Scan.

If you are scanning from the document glass, when prompted, do one of the following:
e To complete the job and return to the app, touch Done.

e To scan another page, load a new original document on the document glass, then touch Add
Page.

e To delete the scan and return to the app, touch Cancel, then touch Delete.

¥ Note: If you are scanning a document from the automatic document feeder, a prompt
does not appear.

To return to the Home screen, press the Home button.

Deleting a Personal Favorite using the Control Panel

To delete a Personal Favorite:

1.

2.
3.
4
5

At the printer control panel, press the Home button.
Touch Login, then enter a valid login name and password.
Touch the app required.

Scroll to the bottom, then touch Customize.

Touch Favorites, then touch the Trash icon that corresponds with the Personal Favorite that you
want to delete.

Touch Done.
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Removing Personalizations using the Embedded Web Server

® Note: Personalizations include your customized Home screen, Personal 1-Touch Apps, and

Personal Favorites. This procedure removes all personalizations from your User Account.

To remove all personalizations from your User Account:

1.

84

At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

In the Embedded Web Server, click Log In, then click on your user account. If required, enter your
password and click Log In.

To access your User Profile, click on your User Account name shown in the top right corner, then
click My Profile.

All personalizations you have configured for your User Account are displayed.
To remove all personalizations, click Reset. To confirm, click Reset.
All the personalizations configured for your User Account are removed.

To log out, click on your User Account name shown in the top right corner, then click Log Out.
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Jobs

Jobs Overview

— Use Jobs to view current jobs, print saved, personal, and secure jobs, and view details of
o completed jobs. You can pause, delete, print, or view job progress or job details for a

- selected job.

Managing Jobs

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs.
You can pause, delete, print, or view job progress or job details for a selected job. From the Jobs
window in the Embedded Web Server, you can view a list of active and completed print jobs. For more
information, refer to Managing Jobs Using the Embedded Web Server.

A print job can be held by the printer when it is unable to complete a print job. For example, when the
printer needs attention, paper, or supplies. When the condition is resolved, the printer automatically
resumes printing. When you send a Secure Print job, the job is held until you release it by typing a
passcode at the control panel. For more information, refer to Printing Special Job Types.

Pausing the Print Job with the Option to Delete It
1. At the printer control panel, press the Home button.
2. Touch Jobs, then touch the name of the print job.
3. Do one of the following:
e To pause the print job, touch Pause. To resume the print job, touch Resume.

e To delete the print job, touch Delete. At the prompt, touch Delete.
¢ Note: If you do not make a selection within 60 seconds, the job resumes automatically.

4, To return to the Home screen, press the Home button.

Viewing, Printing, or Deleting Saved and Secure Jobs

The system administrator can restrict users from deleting jobs. If a system administrator has
restricted job deletion, you can view the jobs, but not delete them. Only the user that sent the job or
the system administrator can delete a Secure Print job.

1. At the printer control panel, press the Home button.

2. Toview a list of active and completed jobs, touch Jobs.
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3. Toview a list of specific job types, touch an option.

e To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then
touch OK. To delete the job, touch the Trash icon, then touch Delete.

e To view Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then
touch Print All, or Delete All.

e For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number,
then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder,
touch Print All, or Delete All.

4. To view details about a job, touch the job.

5. To return to the Home screen, press the Home button.

Printing a Job Held for Resources
1. At the printer control panel, press the Home button.
2. Touch Jobs.

3. From the jobs list, touch the held job name. The resources required for the job appear on the
control panel.

4. Do one of the following:

e To print the job, replenish the resources required. The job resumes automatically when the
required resources are available. If the job does not print automatically, touch Resume. Select
from the following options:

e Delete Job: To delete the print job that is on hold, touch Delete.
¢ Reload Media: To load recommended media in the feeder, touch Reload Media.

e Change Media: If the recommended media is unavailable, to print on alternate media,
touch Change Media.

¥ Note: If the new media size is smaller than the size specified in original print
job, data outside the printable area of the new media can be cut off.

e To delete the print job, touch Delete. At the prompt, touch Delete.

5. To return to the Home screen, press the Home button.

Managing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer
control panel. Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Jobs

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use. Any
user can print or delete a Saved Job.

To print a Saved Job, refer to Printing a Saved Job.
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Printing a Saved Job

1. In your software application, access the print settings. For most software applications, press CTRL
+P for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.

e For Windows, click Printer Properties. Depending on your application, the title of the button
can vary.

e For Macintosh, in the Print window, click Print Options, then select Xerox Features.
3. For Job Type, select Saved Job.

Type a job name or select a name from the list, then click OK.

Select any other required printing options.

e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Saved Job

1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. To view Saved Jobs, touch Saved Jobs.

4, To print a Saved Job, touch the job name, enter the quantity, then touch OK.
5

To delete the document after printing, for that job, touch the Trash icon, then at the prompt,
touch Delete.

6. To return to the Home screen, press the Home button.

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the
printer until you enter your passcode at the printer control panel.

To print a Secure Print job, refer to Printing a Secure Print Job.

Printing a Secure Print Job

1. In your software application, access the print settings. For most software applications, press CTRL
+P for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.

e For Windows, click Printer Properties. Depending on your application, the title of the button
varies.

e For Macintosh, in the Print window, click Preview, then select Xerox Features.
3. For Job Type, select Secure Print.
4. Type the passcode, confirm the passcode, then click OK.
5. Select any other required printing options.

e For Windows, click OK, then click Print.

e For Macintosh, click Print.
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Releasing a Secure Print job

At the printer control panel, press the Home button.
Touch Jobs.

To view Secure Print jobs, touch Personal & Secure Jobs.
Touch your folder.

Enter the passcode number, then touch OK.

o s w N =

Select an option:

e To print a Secure Print job, touch the job.

e To print all the jobs in the folder, touch Print All.

e To delete a Secure Print job, touch the Trash icon. At the prompt, touch Delete.
e To delete all the jobs in the folder, touch Delete All.

¢ Note: After a Secure Print job is printed, it is deleted automatically.

7. To return to the Home screen, press the Home button.

Personal Print

Personal Print allows you to store a document in the printer, then print it from the control panel.

® Note: The Personal Print feature is only available on a Windows computer printing to a network
printer.

Personal Print is a type of saved job with these features:

e A Personal Print job appears in a folder named after the user ID associated with the print job.
e A Personal Print job does not use a passcode.

e Any user can print or delete a Personal Print job.

e You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list.

e After a Personal Print job is printed, it is deleted automatically.

To print a Personal Print job, refer to Printing Using Personal Print.

Printing Using Personal Print

1. In your software application, access the print settings. For most software applications, click File or
for Windows, press CTRL+P.

2. Select your printer, then click Printer Properties. Depending on your application, the title of the
button varies.

3. For Job Type, select Personal Print.
4. Select any other required printing options, then click OK.
5. To send the job to the printer, click Print.

Releasing a Personal Print Job

1. At the printer control panel, press the Home button.
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Touch Jobs.
To view Personal Print jobs, touch Personal & Secure Jobs.
Touch your folder.

If prompted for a passcode, touch Skip.

¢ Note: When your folder contains Secure Print jobs and Personal Print jobs, the passcode
prompt appears.

Select an option.

e To print a Personal Print job, touch the job.

e To print all the jobs in the folder, touch Print All

e To delete all the jobs in the folder, touch Delete All.

To return to the Home screen, press the Home button.

Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining
copies. After reviewing the sample set, you can either print the remaining copies or delete them at
the printer control panel.

Sample Set is a type of saved job with these features:

A Sample Set job appears in a folder named after the user ID associated with the print job.
A Sample Set job does not use a passcode.
Any user can print or delete a Sample Set job.

A Sample Set prints one copy of a job to allow you to proofread the job before printing any
remaining copies.

After a Sample Set job is printed, it is deleted automatically.

To print a Sample Set, refer to Printing a Sample Set.

Printing a Sample Set

1.

In your software application, access the print settings. For most software applications, press CTRL
+P for Windows or CMD+P for Macintosh.

Select your printer, then open the print driver.

e For Windows, click Printer Properties. Depending on your application, the title of the button
varies.

e For Macintosh, in the Print window, click Preview, then select Xerox Features.
For Job Type, select Sample Set.

Select any other required printing options.

e For Windows, click OK, then click Print.

e For Macintosh, click Print.
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Releasing a Sample Set

1. At the printer control panel, press the Home button.
2. To view available jobs, touch Jobs.

3. Touch the Sample Set job.

¥ Note: The Sample Set file description shows the job as Held for Future Printing, and shows
the number of remaining copies of the job.

4. Select an option.
e To print the remaining copies of the job, touch Release.
o To delete the remaining copies of the job, touch Delete.

5. To return to the Home screen, press the Home button.

Managing Jobs Using the Embedded Web Server

You can view a list of active jobs and delete print jobs from the Active Jobs list in the Embedded Web
Server. You can use the Embedded Web Server to submit jobs for printing at the device. You can print
* _pdf, *.ps, *.pcl, *.prn, *.xps, *.Jjpg, *.tif and *. txt files directly from the Embedded
Web Server without opening another application or the print driver. The files can be stored on a local
computer hard drive, mass storage device, or network drive.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

2. Inthe Embedded Web Server, click Jobs.
Click the job name.

4. Do one of the following:
e To pause the print job, click Pause. To resume the print job, click Resume.
o To delete the print job, click Delete. At the prompt, click Delete.

5. To return to the Home screen, click Home.

Submitting Jobs for Printing Using the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

In the Embedded Web Server, click Home.
In the Quick Links area, click Submit File.
Click the Submit field.

In the selection window, select a file to print, then click Open.

o v s W N

To print the document, click Submit.
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Copy

Copy Overview

To make a copy, the device scans your original documents and temporarily stores the
images. The image print based on the options selected.

If Authentication or Accounting has been enabled on your device, enter your login details to access

Copy features.

You can adjust various settings for individual Copy jobs and save settings as Presets for future jobs.
The list of features can be customized, and some features could be hidden from view when the app is
installed. To view all available features and to find out more about customizing the Copy App, refer to
Customize and Personalize.

For information about all the app features and available settings, refer to Apps Features.

Making a Copy

To make a copy:
1. At the printer control panel, press the Home button.

2. To clear previous app settings, touch Reset.
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3. Load your original documents.

e Use the document glass for single pages or paper that cannot be fed using the duplex
automatic document feeder. Lift the document feeder cover, then place the original
document face down in the upper-left corner of the document glass.

e For single, multiple, or 2-sided pages, use the duplex automatic document feeder. Remove any
staples and paper clips from the pages. Insert the original documents face up in the
document feeder, with the top of the page entering the feeder first. Adjust the paper guides
so that they fit against the original documents.

4. Touch Copy, then enter the number of copies needed.

¢ Note: To amend the number of copies entered, touch the X button, then enter the required
quantity.

If scanning from 2-sided original documents, touch 2-Sided, then select an option.

6. Adjust copy settings as needed.
For details about available features, refer to Apps Features.

Touch Start. If you placed documents in the feeder, scanning continues until the feeder is empty.
If you are scanning from the document glass, when prompted, do one of the following:
e To complete the job and return to the Copy App, touch Done.

e To scan another page, load a new original document on the document glass, then touch Add
Page.

e To delete the scan and return to the Copy app, touch Cancel Job, then touch Delete.

¢ Note: If you are scanning a document from the duplex automatic document feeder, a
prompt does not appear.

9. To return to the home screen, press the Home button.
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Copy Workflows

® Note: Some features are hidden from view when the Copy App is installed. For more
information, refer to Customizing or Personalizing the Feature List.

Changing the Page Layout

You can use Page Layout to place a defined number of pages on one or both sides of the paper.
To change the page layout:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Page Layout.

4. Select the required number of pages per side.

5

To change the Original Orientation, touch Page Layout, then touch More. Select Portrait or
Landscape.

¥ Note: The Original Orientation option is only available when the selected number of pages
per slide is 2, 4, or 8.

6. To change the Image Order, touch Page Layout, then touch More. Select one of the following
options.

¢ Right then Down: This option prints the images across the page, row by row.

e Down then Right: This option prints the images down the page, column by column.

¥ Note: The Image Order option is only available when the selected number of pages per
slide is 4 or 8.

Touch OK.

N

Adjusting Contrast Settings

You can adjust the variation between light and dark areas of your copy using the Contrast feature.
You can reduce the sensitivity of the printer to variations in light background colors using Auto
Background Suppression.

To adjust the Auto Background Suppression and Contrast:

At the printer control panel, press the Home button.

Touch Copy.

Touch Image Enhancement.

To enable Auto Background Suppression, touch the Auto Background Suppression toggle button.
To enable Auto Contrast, touch the Auto Contrast toggle button.

o s whN =

To adjust the Contrast manually, ensure that the Auto Contrast toggle button is off, then move
the slider to increase or decrease the contrast.

7. Touch OK.
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Book Copying

You can use the Book Copying feature to copy books, magazines, or other bound documents. You can
use this feature to copy images for different results.

e Copy either the left or right page onto a single sheet of paper.

e Copy both the left and right pages onto individual sheets of paper.

e Copy both the left and right pages as a single image onto one sheet of paper.
e Copy either the top or bottom page onto a single sheet of paper.

e Copy both the top and bottom pages onto individual sheets of paper.

e Copy both the top and bottom pages as a single image onto one sheet of paper.

® Note: To make copies from books, magazines, or other bound documents, use the document
glass only. Do not place bound original documents in the duplex automatic document feeder.

To set up book copying:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Book Copying.

4

Touch Mode, then select the typical page-reading order for the document, if needed. Off is the
default setting.

5. Touch Pages, then select the pages that you want to copy.
¢/ Note: Available options vary, based on the Mode selection you have chosen.

6. To reduce the amount of white space in copies near the binding, touch Binding Edge Erase, then
move the slider to the right to erase up to 50 mm (2 in).

7. Touch OK.

Shifting the Image

You can change the placement of an image on the copy page. This is useful if the image is smaller
than the page size. For image shift to work correctly, position original documents as follows:

e Document Feeder: Position original documents face up, short edge entering the feeder first.

e Document Glass: Position original documents face down, in the upper-left corner of the document
glass, short edge to the left.

To change the placement of the image:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Image Shift.
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4. Select one of the following options.
e Off: This option is the default setting.
e Auto Center: This option centers the image on the page.

e Snap to Edge: This option shifts the image to the edge of the document. Select one of the
image-position options.

e Mirror Side 1: This option allows you to set the Image Shift for Side 1, and matches the
Side 2 Image Shift accordingly. To move the image to the required edge of the page,
touch the appropriate arrow.

e Independent Sides: This option allows you to position the images on Side 1 and Side 2
independently of each other. To move each image to the required edge of the page, touch
the appropriate arrow.

e Manual: This option allows you to specify the amount of Image Shift required. Select one of
the image-position options.

e Mirror Side 1: This option allows you to set the Image Shift for Side 1, and matches the
Side 2 Image Shift accordingly. Touch the appropriate fields. To adjust the image shift,
move the slider.

¢ Independent Sides: This option allows you to position the images on Side 1 and Side 2
independently of each other. Touch the appropriate fields. To adjust the image shift, move

the slider.
5. To specify the orientation of the original document, touch Original Orientation, then select an
option.
6. Touch OK.

Creating a Booklet

The booklet feature reduces the original page images to fit two images on each side of the printed
page. You can print copies in booklet format.

e In Booklet mode, the printer scans all the original documents before it prints the copies.
e This feature is only available if a hard drive is installed.

To create a booklet:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Booklet Creation.

e If you adjusted the Reduce/Enlarge setting, a message appears that confirms that Reduce/
Enlarge changed to Auto%.

o If you set Paper Supply to Auto Select, a message appears that confirms that the paper
supply changed to Tray 1.

4. Touch the Booklet Creation toggle button.
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5. Touch Original Document, then select the option that matches your original documents.

e 1-Sided Original: This option scans only one side of the original image and produces 1-sided
output files.

e 2-Sided Original: This option scans both sides of the original image.

e 2-Sided, Rotate Side 2: This option scans both sides of the original image, rotating the
second side.

6. If acover sheet is required, touch the Cover toggle button, then adjust Paper Supply and Print
On Cover as needed.

If your printer has a finisher installed, select a staple or fold option.

To increase or reduce the amount of white space in the margin between the two pages, touch
Gutter Margin, then touch the Plus icon (+) or the Minus icon (-).

9. To print booklets containing an odd number of pages, touch Odd Page Management. To specify
the location of extra blank pages, touch Blank Page Front or Blank Page Back, as needed.

10. To set the number of sheets in the booklet, touch the Sheets per Signature toggle button. To
adjust the number of sheets, touch Plus icon (+) or Minus icon (-), as needed.

11. Touch OK.

Adding a Front Cover

You can print the first page of your copy job on different paper, such as colored or heavyweight
paper. The printer selects the special paper from a different tray. The cover can be blank or printed.

To add a front cover to your copy job:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Front Cover.

4. Touch the Front Cover toggle button.

¥ Note: If Paper Supply is set to Auto Select, a notification appears confirming that the
Paper Supply has been changed to Tray 1.

5. Touch Printing Options, then select an option.
e Blank: This option inserts a blank front cover.
e Print on Side 1 Only: This option prints on the front side of the cover only.
e Print on Side 2 Only: This option prints on the back side of the cover only.
e Print on Both Sides: This option prints on both sides of the cover.
Touch Paper Supply, then select the required paper source.
Touch OK.
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Erasing the Edges of Copies

You can erase content from the edges of your copies using the Edge Erase feature. You can specify
the amount to erase on the right, left, top, and bottom edges.

To erase the edges of copies:

1.

2.
3.
4

At the printer control panel, press the Home button.
Touch Copy.

Touch Edge Erase.

Select one of the following options.

o All Edges: This option erases all four edges by the same amount. To adjust the amount to
erase, move the slider.

o Print to Edge: This option prints with no edge erase.

e Individual Edges: This option allows you to specify different amounts to erase from the
edges. Select an erase option.

e Mirror Edges: This option allows you to set the Edge Erase for Side 1, and matches the
Side 2 Edge Erase accordingly. To adjust the edge erase, move the slider.

e Independent Edges: This option allows you to set the Edge Erase on Side 1 and Side 2
independently of each other. Touch the appropriate field. To adjust the Edge Erase, move
the slider.

To specify the orientation of the original document, touch Original Orientation, then select an
option.

Touch OK.

Printing a Sample Copy

Sample Copy allows you to print a test copy of a job to inspect before printing multiple copies. This
feature is useful for complex or high-volume jobs. After you print and inspect the test copy, you can
choose to print or cancel the remaining copies.

To print a sample copy of your job:
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At the printer control panel, press the Home button.

Touch Copy.

Adjust the copy settings as needed.

Enter the number of copies needed.

Touch the Sample Copy toggle button.

Touch the Start button. The sample copy prints.

Inspect the sample copy, then select one of the following options.

e If the copy is unsatisfactory, touch Delete. The job is canceled and no more copies are
printed.

o If the copy is satisfactory, touch Release. The remaining copies are printed.

To return to the home screen, press the Home button.
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Adding Annotations

You can use the Annotations feature to add a page number, comment, date, or Bates Stamp to your
copies.

¢ Note: If Booklet Creation is selected, you cannot add Annotations.

To add annotations:

1.

2.
3.
4

98

At the printer control panel, press the Home button.

Touch Copy.

Touch Annotations.

To insert page numbers:

a.
b.

C.

d.

Select the required page location, then touch Page Number.
Enter the starting page number.

To adjust which pages contain the selected annotation, touch Apply To, then select All Pages
or All Pages Except First.

Touch OK.

To insert a comment:

a.
b.

d.

Select the required page location, then touch Comment.

Select the required entry, then touch OK.

® Note: To create a comment, touch the edit icon for Not in Use. Enter the required text,
then touch OK.

To adjust which pages contain the selected annotation, touch Apply To, then select the
required option.

Touch OK.

_/’ Note: To create a prefix, touch the edit icon for Not in Use. Enter the required text, then

touch OK.

To insert the current date:

d.

Select the required page location, then touch Date Stamp.
Touch Format, then select the required date format.

To adjust which pages contain the selected annotation, touch Apply To, then select the
required option.

Touch OK.

To insert a Bates Stamp:

a.
b.

C.

Select the required page location, then touch Bates Stamp.

Touch Prefix, then select the required entry. Touch OK.

® Note: To create a prefix, touch the edit icon for Not in Use. Enter the required text,
then touch OK.

Touch Starting Number. Enter the required starting number, then touch OK.
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d. Touch Number of Digits, then select the required option.

e. To adjust which pages contain the selected annotation, touch Apply To, then select the
required option.

f. Touch OK.

To change the text formatting, touch Format & Style. Adjust the settings as required, then touch
OK.

Touch OK.

If necessary, to remove all entered annotations, touch Delete All.

¢ Note: Not all annotations are available in all page locations.
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ID Card Copy
ID Card Copy Overview

s

onto one side of paper. To copy the card, place each side in the upper-left corner of the
document glass. The printer stores both sides of the document, then prints them side
by side on the paper.

B You can use the ID Card Copy App to copy both sides of an ID card or small document

The ID Card Copy App is hidden from view on initial device setup. The list of features can be
customized, and some features can be hidden from view. For more information about adding and
customizing apps, refer to Customizing or Personalizing the Feature List.

For information about all the app features and available settings, refer to Apps Features.

Copying an ID Card

To copy an ID card:

1.
2.

N o v B

At the printer control panel, press the Home button.
To clear previous app settings, touch Reset.

Lift the automatic document feeder, then place the original document in the upper-left corner of
the document glass.

Touch ID Card Copy.
Adjust the settings as required.
Touch Scan.

When scanning is finished, lift the automatic document feeder. Flip the original document, then
place it in the upper-left corner of the document glass.

To scan the second side of the original document and print the copies, touch Scan.

To return to the home screen, press the Home button.
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Email

For information on previewing and building jobs, refer to Previewing and Building Jobs.

Email Overview

You can use the Email app to scan images and attach them to emails. You can specify
the file name and format of the attachment, and include a subject heading and
message for the email.

# Note: Before using Email, set up and configure the Email features on the
printer. For details, refer to the System Administrator Guide at www.xerox.com/
office/VLB71XXdocs.

You can adjust various settings for individual Email jobs and save settings as Presets for future jobs.
The list of features can be customized, and some features could be hidden from view when the app is
installed. To view all available features and to find out more about customizing the Email App, refer to
Customizing or Personalizing the Feature List.

For information about all the app features and available settings, refer to Apps Features.

Sending a Scanned Image in an Email

To send a scanned image in an email:
1. At the printer control panel, press the Home button.

2. To clear previous app settings, touch Reset.
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3. Load your original documents.

For single pages or paper that cannot be fed using the single-pass duplex automatic
document feeder, use the document glass. Lift the automatic document feeder, then place
the original documents face down in the upper-left corner of the document glass.

For multiple, single, or 2-sided pages, use the single-pass duplex automatic document feeder.
Remove any staples or paper clips from the pages. Insert the original documents face up in
the automatic document feeder, with the top of the page entering the feeder first. Adjust the
paper guides so that they fit against the document originals.

4. Touch Email.

5. Enter recipients:

To enter the email address manually into the To field, type the address using the touch screen
keypad. Touch Enter.

To select a contact or group from the Address Book, touch the Address Book icon. Touch
Favorites or Contacts, then select a recipient.

If you have created Personal Favorites, to select a Personal Favorite, log in with your user

credentials. Touch the Address Book icon. Touch Favorites, then select a Personal Favorite
from the list.

For details about using the Address Book and managing and creating Favorites and Personal
Favorites, refer to Address Book.

6. If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
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Adjust the email settings as needed:

e To save the scanned document with a specific file name, touch the attachment file name,
enter a new name using the touch screen keypad, then touch Enter.

e To save the scanned document with a specific file format, touch the attachment file format,
then select the required format.

To create a searchable file or to add password protection, from the File format, select More.

e To change the subject line, touch Subject, enter a new subject line using the touch screen
keypad, then touch Enter.

e To change the email body message, touch Message, enter a new message, then touch OK.
For details about available features, refer to Apps Features.
To start the scan, touch Send.

If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan
another page, touch Add Page. To cancel a job, touch Cancel Job.

¥ Note: If you are scanning a document from the automatic document feeder, a prompt
does not appear.

To return to the Home screen, press the Home button.
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Scan To

For information on previewing and building jobs, refer to Previewing and Building Jobs.

Scan To Overview

The Scan To feature provides several methods for scanning and storing an
original document. The scanning procedure using your printer differs from
that of desktop scanners. The printer is connected typically to a network
rather than a single computer, so you select a destination for the scanned
image at the printer.

The printer supports the following scanning functions:

e Scan original documents to an email address.

e Scan original documents to your home folder.

e Scan original documents to a shared network location using SMB and FTP transfer protocols.

The printer supports scanning to and from a USB. For more information, refer to USB.

Scan destinations and email addresses can be added to the device Address Book and set up as
Favorites and Personal Favorites. For details about using the Address Book and managing and
creating Favorites and Personal Favorites, refer to Address Book.

You can adjust various settings for individual Scan To jobs, and save settings as Presets for future jobs.
You can customize the features list. When the Scan To App is installed, some features can be hidden
from view. To view all available features and to find out more about customizing the Scan To App,
refer to Customize and Personalize.

For information about all app features and available settings, refer to Apps Features.

Scanning to an Email Address

Before you scan to an email address, ensure that you configure the printer with the email server
information. For details, refer to the System Administrator Guide at www.xerox.com/office/
VLB71XXdocs.

To scan an image and send it to an email address:

1. Load the original document on the document glass or into the duplex automatic document
feeder.

2. At the control panel, touch the Home button.
3. Touch Scan To.
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Enter recipients.
e To enter the email address manually, touch Email, then enter an email address. Touch Enter.

e To select a contact or group from the Address Book, touch the Address Book icon. Touch
Favorites or Contacts, then select a recipient.

e If you have created Personal Favorites, to select a Personal Favorite, log in with your user
credentials. Touch the Address Book icon. Touch Favorites, then select a Personal Favorite
from the list.

For details about using the Address Book and managing and creating Favorites and Personal
Favorites, refer to Address Book.

To save the scanned document as a specific file name, touch the attachment file name, then
enter a new name using the touch screen keypad. Touch Enter.

To save the scanned document as a specific file format, touch the attachment file format, then
select the required format.

® Note: To make scanned documents searchable, your system administrator can enable the
Searchable feature.

Adjust scanning options as needed.

To change the subject line, from Email Features, touch Subject, then enter a new subject line
using the touch screen keypad. Touch Enter.

To change the email body message, from Email Features, touch Message, then enter a new
message. Touch OK.

To begin the scan, touch Scan.

If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan
another page, touch Add Page.

¢ Note: If you are scanning a document from the automatic document feeder, a prompt
does not appear.

To return to the Home screen, press the Home button.

Scanning to a User Home Folder

Scan to Home allows you to scan documents that are saved to a home directory on an external
server. The home directory is distinct for each authenticated user. The directory path is established
through LDAP.

Before You Begin

To scan to the home folder defined in an LDAP directory, first ensure that the home folder locations
are defined for each user.

If you want to scan to a shared folder on the network, create a shared folder on your network with
read and write access privileges.
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Scanning to a Home Folder

Y Note: If LDAP Network Authentication is configured, the Home button appears as an option
' that you can select on the Scan To screen.

1. Load the original document on the document glass or into the duplex automatic document
feeder.

At the printer control panel, press the Home button.
To log in to the printer, touch Log In.
Enter your user name, then touch Next.

Enter your password, then touch OK.

o v & w N

To scan to a home folder, select an option:
e Touch Scan To. On the Scan To screen, touch Home.
e Touch My Folder.

7. To save the scanned document as a specific file name, touch the attachment file name, enter a
new name using the touch screen keypad, then touch Enter.

8. To save the scanned document as a specific file format, touch the attachment file format, then
select the desired format.

Adjust scanning options as needed.
10. To begin the scan, press Scan.

If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan
another page, touch Add Page.

¢ Note: If you are scanning a document from the automatic document feeder, a prompt
does not appear.

11. To return to the Home screen, press the Home button.

Scanning to a USB Flash Drive

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function
produces scans in .jpg, .pdf, .pdf (a), .xps, and tif file formats.

e If the device is in Power Saver mode, press the Power/Wake button.

e Only USB Flash drives formatted to the typical FAT32 file system are supported.

To scan to a USB Flash drive:

1. Load the original document on the document glass or in the duplex automatic document feeder.
2. At the printer control panel, press the Home button.

3. Insert your USB Flash drive into the USB memory port on the front of the printer.

4. When the USB Flash drive is detected, touch Scan to USB.

¢ Note: If this feature does not appear, enable the feature or contact the system
' administrator. To save the scanned file to a folder on the USB Flash drive, navigate to the
desired directory. Touch OK.
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To save the scanned document with a specific file name, touch the attachment file name. To
enter a new file name, use the touch screen keypad. Touch Enter.

To save the scanned document to as a specific file format, touch the attachment file format, then
select the required format.

Adjust scanning features as needed.
To begin the scan, press Scan.
The printer scans your images to the folder that you specified.

If you are scanning from the document glass, when prompted to finish, touch Done. To scan
another page, load a new original document on the document glass, then touch Add Page.

¢ Note: If you are scanning a document from the duplex automatic document feeder, a
prompt does not appear.

(T Caution: Do not remove the USB Flash drive while the device is scanning and processing the
~* job. If you remove the Flash drive before the transfer is complete, the file can become
unusable and other files on the drive can be damaged.

To return to the Home screen, press the Home button.

Scan to Desktop

Before you begin:

Before scanning, ensure that your computer and the printer are plugged in, powered on, and
connected to an active network.

On your computer, ensure that you have the correct print driver software installed. For details,
refer to Installing the Software.

On your computer, ensure that the printer is installed using WSD. For details, refer to Installing the
Software.

On your printer, ensure that WSD is enabled. Enable the feature or contact the system
administrator.

To use the Scan to Desktop feature:

1.
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Load the original document on the document glass or into the duplex automatic document
feeder.

At the printer control panel, press the Home button.
Touch Scan to Desktop.

To select a destination, touch the computer address.
To begin the scan, press Scan.

The Windows Fax and Scan application opens on your PC desktop. The image file of your scan is
saved to the Scanned Documents folder.
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6. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan
another page, touch Add Page.

® Note: If you are scanning a document from the automatic document feeder, a prompt
does not appear.

7. To return to the Home screen, press the Home button.

Scanning to an FTP or SFTP Server

To scan an image and send it to an FTP or SFTP server:

1. Load the original document on the document glass or into the duplex automatic document
feeder.

At the control panel, press the Home button.

Touch Scan To.

Touch FTP or SFTP, then enter the server address.

If prompted, enter a valid user name and password, then touch Enter.

Select a folder location for your scanned document, then touch OK.

No u B WwN

To save the scanned document as a specific file name, touch the attachment file name. Enter a
new name using the touch screen keypad, then touch Enter.

8. To save the scanned document as a specific file format, touch the attachment file format, then
select the required format.

Adjust scanning options as needed.
10. To begin the scan, touch Scan.
The printer scans your images to the folder that you specified.

11. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan
another page, touch Add Page.

¢ Note: If you are scanning a document from the automatic document feeder, a prompt
does not appear.

12. To return to the Home screen, press the Home button.

Scanning to a Shared Folder on a Network Computer

Before you can use the printer as a scanner on a network:
e Create a shared folder on your computer hard drive.

e Access the Embedded Web Server, then create an address that points the scanner to the
computer.

Sharing a Folder on a Windows Computer
1. Open Windows Explorer.

2. Right-click the folder you want to share, then select Properties.
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Click the Sharing tab, then click Advanced Sharing.

Select Share this folder.

Click Permissions.

Select the Everyone group, and verify that all permissions are enabled.
Click OK.

/’ Note: Remember the Share name for later use.

Click OK again.
Click Close.

Sharing a Folder in macOS Version 10.15 and Later

_— )
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From the Apple menu, select System Preferences.

From the Internet & Wireless menu, select Sharing.

From the Service menu, select File Sharing.

At the bottom of the Shared Folders list, click the Plus icon (+).

Browse to the folder that you want to share on the network, then click Add.

To modify access rights for your folder, select the folder. The users become available for selection.
From the Users list, click Everyone, then use the arrows to select Read & Write.
Click Options.

To share the folder, select Share files and folders using SMB.

To share the folder with specific users, next to the user name, select On.

Click Done.

Close the System Preferences window.

¥ Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the
folder and subfolders.

Adding an SMB Folder as an Address Book Entry from the
Embedded Web Server

1.

2.

At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

¢ Note: If you do not know the IP address for your printer, refer to Finding the IP Address of
Your Printer.

Click Address Book, then click Add Contact.
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For Network (SMB), click the Plus icon (+), then enter the following information:
¢ Nickname: Enter the name that you want to appear in the Address Book.

e Type: Select the network connection type.

e IP Address: Port / Host Name: Port or IPv6 Address/Prefix : Port: The option selected forType

determines which option displays in this field. Enter the IP address of your computer, then
enter the default port number.

e Share: Enter a name for the directory or folder. For example, to save scanned files to a shared
folder named scans, type scans.

e Document Path: Enter the path of the folder on the SMB server. For example, to save the
scanned files to a folder named colorscans inside the scans folder, type colorscans.

e Login Name: Enter your computer user name.

e Password: Enter your computer login password.

e Retype Password: Enter your login password again.
To save your network information, click OK.

To save your contact, click OK.

Adding a Folder as an Address Book Entry Using the Control Panel

1.

2
3.
4,
5

At the printer control panel, touch the Home button.
Touch Address Book.

Touch the Plus icon (+), then select Add Contact.
Enter the name to appear in the address book.

Touch Add (SMB), then navigate to the desired folder.

¢/ Note: Login credentials are required for computers on secured networks.

To save changes, touch OK.

Scanning to a Shared Folder on a Networked Computer

1.
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Load the original document on the document glass or into the duplex automatic document
feeder.

At the printer control panel, press the Home button.
Touch Scan To.

Touch Contacts.

From the Contacts list, select the shared folder.

To save the scanned document as a specific file name, touch the attachment file name, enter a
new name using the touch screen keypad, then touch Enter.

To save the scanned document as a specific file format, touch the attachment file format, then
select the needed format.

Adjust scanning options as needed.
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To begin the scan, press Scan.

If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan
another page, touch Add Page.

¥ Note: If you are scanning a document from the automatic document feeder, a prompt
does not appear.

To return to the Home screen, press the Home button.

Scanning Images into an Application on a
Connected Computer

You can import images directly from the scanner into a folder on your computer. With a Macintosh®
computer and some Windows® applications, you can import the images directly into an application.

Scanning an Image into an Application

EwN =

® Note: Some Windows applications, including Microsoft Office 2007 and newer, do not support
this feature.

Load the original document on the document glass or in the duplex automatic document feeder.
At your computer, open the application into which you want to scan the image.
In the application, select the menu item to acquire the image.

From the Paper Source menu in Windows, or from the Scan From menu on a Macintosh®
computer, select one of the following:

e For the Document Glass, select Flatbed.

e For the Duplex Automatic Document Feeder, select Document Feeder.
Specify other scan driver settings as needed.

To begin the scan, click Scan.

The printer scans the document and places the image in your application.

Scanning Using the Windows Web Services on Devices Application

Before you begin:

I

On your computer, ensure that the printer is installed using WSD and is available for use on the
network. For details, refer to Installing the Software.

On your printer, ensure that WSD is enabled. For details, refer to the System Administrator Guide
at www.xerox.com/office/VLB71XXdocs.

Load the original document on the document glass or in the duplex automatic document feeder.
On your computer, select the Windows Fax and Scan application, then click Run.
Click New Scan.

To choose the device, click Change. From the list, select your device.
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5. Inthe New Scan window, click the Profile list. Depending on the type of documents that you are
scanning, choose an option.

e For text-based documents or documents containing line art, choose Documents.
e For documents containing graphic images, or for photographs, choose Photo.
The default settings for scanning a document or photo appear automatically.
Adjust scanning options as needed.

To view how your document appears when scanned, click Preview.

To scan the original document, click Scan.

The scanned image is stored in the default Documents folder, in the Scanned Documents
subfolder.

9. You can forward scanned images to an email address or a network folder automatically. To
choose a forwarding option, click Tools, then click Scan Routing. Select your preferred option,
enter the destination details, then click Save.

The scanned images are forwarded to the specified destination.
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Fax

For information on previewing and building jobs, refer to Previewing and Building Jobs.

Fax Overview

When you send a fax from the printer control panel, the document is scanned and
transmitted to a fax machine, using a dedicated telephone line. You can use the Fax
feature to fax documents to a fax number, or individual contact, or to a group of
contacts.

You can use the Fax feature to do the following tasks:

e Delay the send of your fax job for up to 24 hours.

e Send a fax from your computer.

e Forward fax documents to an email address.

e Print a fax from a secure folder.

The fax function works best with an analog phone line. Voice-Over-Internet Protocols (VOIPs) such as

FIOS and DSL are not supported. Before you use the fax, configure the Fax Settings to ensure that the
settings are compatible with your local connection and regulations. The Fax Settings include optional

features that you can use to configure the printer for faxing.

j’ Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

For details, refer to the System Administrator Guide at www.xerox.com/office/VLB71XXdocs.

You can adjust various settings for individual Fax jobs and save settings as Presets for future jobs. The
list of features can be customized, and some features could be hidden from view when the app is
installed. To view all available features and to find out more about customizing the Fax App, refer to
Customize and Personalize.

For information about all the app features and available settings, refer to Apps Features.

Sending a Fax

To send a fax:
1. At the printer control panel, press the Home button.

2. To clear previous App settings, touch Reset.
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3. Load your original documents.

e Use the document glass for single pages or paper that cannot be fed using the duplex
automatic document feeder. Lift the document feeder, then place the original document face
down in the upper-left corner of the document glass.

e For single, multiple, or 2-sided pages, use the duplex automatic document feeder. Remove any
staples and paper clips from the pages. Insert the original documents face up in the
document feeder, with the top of the page entering the feeder first. Adjust the paper guides
so that they fit against the documents.

4. Touch Fax.
5. Enter recipients:

e To enter a recipient fax number, use the touch screen keypad, then touch Enter.

¥ Note: To insert a pause as needed, touch the Special Characters icon, then touch Dial
Pause. To enter longer pauses, touch Dial Pause multiple times. You can also enter
special characters for Wait, Mask, Pulse-to-Tone, and Password.

e To select a contact or group from the Address Book, touch the Address Book icon. Touch
Favorites or Contacts, then select a recipient.

e If you have created Personal Favorites, to select a Personal Favorite, log in with your user
credentials. Touch the Address Book icon. Touch Favorites, then select a Personal Favorite
from the list.

For details about using the Address Book and managing and creating Favorites and Personal
Favorites, refer to Address Book.

If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
Adjust fax settings as needed.
For details about available features, refer to Apps Features.

8. Touch Send.
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If you are scanning from the document glass, when prompted, do one of the following:
e To complete the job and return to the Fax app, touch Done.

e To scan another page, load a new original document on the document glass, then touch Add
Page.

e To delete the scan and return to the Fax app, touch Cancel, then touch Delete.

" Note:If you are scanning a document from the automatic document feeder, a prompt
does not appear.

To return to the Home screen, press the Home button.

Fax Workflows

Sending a Delayed Fax

You can set a time in the future for the printer to send your fax job. You can delay the send of your
fax job for up to 24 hours.

¥ Note: Before you use this feature, ensure that the printer is set to the current time. For details,

refer to the System Administrator Guide at www.xerox.com/office/VLB71XXdocs.

To specify the time to send your fax:

1.
2.
3.
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At the printer control panel, press the Home button.
Touch Fax.

To add a recipient fax number, use the touch screen keypad, or, to add a contact from the
Address Book, touch the Address Book icon.

Load original documents into the printer, then adjust the settings as needed. For details, refer to
Sending a Fax.

Touch Delay Send.

Touch Specific Time, enter the required time, then touch OK.

Touch Send. The fax is scanned and saved, then sent at the time that you specified.

If you are scanning from the document glass, when prompted, do one of the following:
e To complete the job and return to the Fax App, touch Done.

e To scan another page, load a new original document on the document glass, then touch Add
Page.

e To delete the scan and return to the Fax App, touch Cancel, then touch Delete.

¢ Note: If you are scanning a document from the automatic document feeder, a prompt
does not appear.

To return to the Home screen, press the Home button.

Xerox® VersalLink® B71XX Multifunction Printer 115
User Guide


https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB71XX&PgName=Man

Xerox® Apps

Sending a Cover Sheet with a Fax

You can send an automatically generated cover sheet with your fax. The cover sheet lists recipient
information from the fax address book, and sender information from the Company Name Fax Line
setting.

To send a cover sheet with a fax:

1. At the printer control panel, press the Home button, then touch Fax.

2. Add fax recipient names and adjust fax settings, as needed. For details, refer to Sending a Fax.
3. Touch Cover Sheet.

4. Touch Add Cover Sheet.

5

To add predefined comments in the From or To fields, touch Blank Comment, then select from
the list of predefined comments.

¥ Note: If no predefined comments have been added, the list is unavailable. To populate the
list with predefined comments, refer to Adding Predefined Comments.

6. Touch OK.

Adding Predefined Comments
To add a predefined comment:

1. At the printer control panel, press the Home button.

2. Login as Admin.

¥ Note: For information on logging in as a system administrator, refer to the System
Administrator Guide at www.xerox.com/office/VLB71XXdocs.

Touch Device > Apps > Fax.
Touch Cover Sheet Comments.
Select a Not in Use comment.

Enter up to 18 characters of text, then touch OK.

N o v~ ow

To return to the Home screen, press the Home button.

Forwarding a Fax to an Email Address

You can configure the device to forward faxes to an email address. You can specify the types of faxes
to forward, for example, received faxes, sent faxes, or sent and received faxes. Up to five email
addresses can be set as forwarding addresses.

¢ Note: Before you can forward a fax to an email address, ensure that the following items are set
) up:

e Email service is available.

e The SMTP server is identified within the Device App software.

e The Default From address is identified within the Device App software.
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The Fax Forwarding feature is enabled.

The SMTP server and Device Email address can be set up using the Embedded Web Server or the
device Control Panel Connectivity option.

For details about configuring Fax Forwarding, refer to the System Administrator Guide at www.xerox.
com/office/VLB71XXdocs.

To forward a fax to an email address:

1.
2.
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10.
11.

At the printer control panel, press the Home button.

Log in as Admin.

¥ Note: For information on logging in as a system administrator, refer to the System
Administrator Guide at www.xerox.com/office/VLB71XXdocs.

Touch Device > Apps > Fax.
Touch Fax Forwarding > Fax Forwarding.
Select Off, Receive Only, Send Only, or Send & Receive.

Touch Add Email. To enter an email address, use the touch screen keypad, or select a contact
from the Address Book.

To add a subject line, touch Subject, enter your subject line text, then touch OK.
To add a filename for attachments, touch Attachment, then enter a filename.

To change the file format for attachments, touch the current format extension, then select a new
format.

¢ Note: The default file format is .pdf.
To save the settings, touch OK.

For the new settings to take effect, press the Home button. At the prompt, touch Restart Now.

Printing a Secure Fax

When the Fax Secure Receive option is enabled, all faxes that the device receives are held in the Job
list until you enter a passcode. After you enter the passcode, the faxes are released and printed.

¥ Note: Before you can receive a Secure Fax, ensure that the Secure Fax Receive feature is

enabled. For details, refer to the System Administrator Guide at www.xerox.com/office/
VLB71XXdocs.

To print a secure fax:

o v &~ w N =

At the printer control panel, press the Home button, then touch Jobs.
Touch Personal & Secure Jobs.

Touch your assigned private folder.

Enter your passcode, then touch OK.

Select a job to print, or touch Print All

To return to the Home screen, press the Home button.
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Sending a Fax Manually

You can use the Manual Send feature to enable the fax modem speaker temporarily. This feature is
helpful to dial international numbers, or to use phone systems that require you to wait for a specific
audio tone.

To send a fax manually:

1. At the printer control panel, press the Home button, then touch Fax.
2. Adjust the fax settings as needed.

3. Touch Manual Send.

j’ Note: To display the menu without entering a fax number, at the top of the screen, touch
Fax.

4. Touch Dial, then enter a fax number using the touch screen keypad.
To send the fax, touch Scan.

6. If you are scanning from the document glass, when prompted, do one of the following:
e To complete the job and return to the Fax App, touch Done.

e To scan another page, load a new original document on the document glass, then touch Add
Page.

e To delete the scan and return to the Fax App, touch Cancel, then touch Delete.

¢ Note: If you are scanning a document from the duplex automatic document feeder, a
prompt does not appear.

7. To return to the Home screen, press the Home button.

Polling a Remote Fax Machine

Fax Polling allows the printer to retrieve a fax stored on another fax machine that supports fax
polling.

¥ Note: This feature is hidden from view when the Fax App is installed, for more information refer
to Customize and Personalize.

To poll a remote fax machine:

1. At the printer control panel, press the Home button, then touch Fax.
2. Touch Polling.

¢ Note: To display the menu without entering a fax number, at the top of the screen, touch
Fax.

3. Enter the fax number of the fax machine that you want to poll.

e To enter a fax number manually, touch Enter Fax Number.

e To add a number from the fax address book, touch the Address Book icon.
4. To initiate the polling process, touch Retrieve.

5. To return to the Home screen, press the Home button.

118  Xerox® VersalLink® B71XX Multifunction Printer
User Guide



Xerox® Apps

Sending a Fax From Your Computer

You can send a fax to the printer from an application on your computer.

Sending a Fax from Windows Applications
You can use the print driver to send a fax from Windows applications.

You can use the fax window to enter recipients, create a cover page with notes, and set options. You
can send a confirmation sheet, set the send speed, resolution, send time, and dialing options.

To send a fax from Windows applications:

1. With the desired document or image open in your application, open the Print dialog box. For
most software applications, click File > Print or press CTRL+P.

Select the required printer. To open the print driver dialog box, click Printer Properties.
On the Printing Options tab, from the Job Type list, select Fax.

In the Fax window, click the Recipients tab.
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To add recipients manually:

a. Click the Add Recipient icon.

b. Type the recipient name and fax number, then add other information as required.
c. Click OK.

d. To add more recipients, repeat this procedure.

6. To add existing contacts from a phonebook:

a. Click the Add From Phonebook icon.

Select the required phonebook from the list.

=

Select names from the list, or search for a contact using the search bar.

C
d. To add the selected contacts to the Fax Recipients list, click the Down Arrow.
e. Click OK.

f. To add more recipients, repeat this procedure.

7. To include a cover sheet, click the Cover Sheet tab. From the Cover Sheet Options list, select Print
a Cover Sheet. Enter the details as needed, then click OK.

8. On the Options tab, select the required options, then click OK.
9. To save your settings and return to the main print dialog page, click OK.
10. Click Print. In the Fax Confirmation window, click OK.

Sending a Fax from Macintosh Applications

You can use the fax driver to send a fax from many Macintosh applications. To install the fax driver,
refer to Installing the Software.

To send a fax from Macintosh applications:

1. With the desired document or image open in your application, open the Print dialog box. For
most software applications, click File > Print or press CMD+P.

2. Select the required printer.
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3. To access the fax driver settings, click Preview, select Xerox Features, then from Job Type list,
select Fax.

To add a recipient, in the Fax window, click the Recipients tab, then click the Add Recipient icon.
Type the recipient name and fax number, add other information as needed, then click OK.

To add more recipients, repeat this procedure.

To include a cover sheet, click the Cover Sheet tab.

From the Cover Sheet list, select Print a Cover Sheet, then enter the details as needed.

W e NSO uoBE

On the Options tab, select the required options. To save your settings and return to the main print
dialog window, click OK.

10. To send the fax, click Print.
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Server Fax

For information on previewing and building jobs, refer to Previewing and Building Jobs.

Server Fax Overview

Server Fax allows you to send a fax over a network to a fax server. The fax server
sends the fax to a fax machine over a phone line.

Before you can send a server fax, configure a fax filing repository or filing location. The fax server
retrieves the documents from the filing location, then transmits the files over the telephone network.
You can print a confirmation report.

¥ Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

For details, refer to the System Administrator Guide at www.xerox.com/office/VLB71XXdocs.

You can adjust settings for individual server fax jobs, save settings as Presets for future jobs, and
customize server fax features. Some features are hidden from view when the app is installed. To view
all available features and to find out more about customizing the Server Fax App, refer to Customize
and Personalize.

For information about all the app features and available settings, refer to Apps Features.

Sending a Server Fax

To send a server fax:
1. At the printer control panel, press the Home button.

2. To clear previous app settings, touch Reset.

Xerox® VersalLink® B71XX Multifunction Printer 121
User Guide


https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB71XX&PgName=Man

Xerox® Apps

3. Load your original documents.

e Use the document glass for single pages or paper that cannot be fed using the duplex
automatic document feeder. Lift the document feeder, then place the original document face
down in the upper-left corner of the document glass.

e For single, multiple, or 2-sided pages, use the duplex automatic document feeder. Remove any
staples and paper clips from the pages. Insert the original documents face up in the
document feeder, with the top of the page entering the feeder first. Adjust the paper guides
so that they fit against the documents.

4. Touch Server Fax.
5. Enter recipients:

e To enter a recipient fax number, use the touch screen keypad, then touch Enter.

¥ Note: To insert a pause as needed, touch the Special Characters icon, then touch Dial
Pause. To enter longer pauses, touch Dial Pause multiple times.

e To select a contact or group from the Address Book, touch the Address Book icon. Touch
Favorites or Contacts, then select a recipient.

For details about using the Address Book and managing and creating Favorites, refer to
Address Book.

If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
Adjust server fax settings as needed.
For details about available features, refer to Apps Features.

8. Touch Send.
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If you are scanning from the document glass, when prompted, do one of the following:
e To complete the job and return to the Server Fax App, touch Done.

e To scan another page, load a new original document on the document glass, then touch Add
Page.

e To delete the scan and return to the Server Fax App, touch Cancel, then touch Delete.

¢ Note: If you are scanning a document from the automatic document feeder, a prompt
does not appear.

10. To return to the Home screen, press the Home button.

Sending a Delayed Server Fax

You can set a time in the future for the printer to send your server fax job. You can delay the send of
your server fax job for up to 24 hours.

¢ Note: Delaying the send of your server fax job is not possible if the transfer protocol is SMTP.

® Note: Before you use this feature, ensure that the printer is set to the current time. For details,

refer to the System Administrator Guide at www.xerox.com/office/VLB71XXdocs.

To specify the time to send your server fax:

1.
2.
3.
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At the printer control panel, press the Home button.
Touch Server Fax.

To add a recipient fax number, use the touch screen keypad. To add a contact from the Address
Book, touch the Address Book icon.

Load original documents into the printer, then adjust the settings as needed. For details, refer to
Sending a Server Fax.

Touch Delay Send.

Touch Specific Time. Set the numbers to the correct time, then touch OK.

Touch Send. The server fax is scanned, saved, then sent at the time that you specified.
If you are scanning from the document glass, when prompted, do one of the following:
e To complete the job and return to the Server Fax App, touch Done.

e To scan another page, load a new original document on the document glass, then touch Add
Page.

e To delete the scan and return to the Server Fax App, touch Cancel, then touch Delete.

¢ Note: If you are scanning a document from the duplex automatic document feeder, a
prompt does not appear.

To return to the Home screen, press the Home button.
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USB
USB Overview

Use the Print from USB feature to print jobs already stored on a USB drive. Jobs in a
print-ready format, such as PDF, TIFF, or JPEG, can be printed.

To create a print-ready file, select the Print to File option when you print your documents from
programs such as Microsoft Word. From advanced publishing programs, there may be several
methods to create print-ready files.

Scanning to a USB Flash Drive

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function
produces scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats.

e If the device is in Power Saver mode, press the Power/Wake button.

e Only USB Flash drives formatted to the typical FAT32 file system are supported.

To scan to a USB Flash drive:

1. Load the original document on the document glass or in the duplex automatic document feeder.
2. At the printer control panel, press the Home button.

3. Insert your USB Flash drive into the USB memory port on the front of the printer.

4. When the USB Flash drive is detected, touch Scan to USB.

¢ Note: If this feature does not appear, enable the feature or contact the system
' administrator. To save the scanned file to a folder on the USB Flash drive, navigate to the
desired directory. Touch OK.

5. To save the scanned document with a specific file name, touch the attachment file name. To
enter a new file name, use the touch screen keypad. Touch Enter.

6. To save the scanned document to as a specific file format, touch the attachment file format, then
select the required format.

Adjust scanning features as needed.
To begin the scan, press Scan.
The printer scans your images to the folder that you specified.

9. If you are scanning from the document glass, when prompted to finish, touch Done. To scan
another page, load a new original document on the document glass, then touch Add Page.

¢ Note: If you are scanning a document from the duplex automatic document feeder, a
prompt does not appear.

(T Caution: Do not remove the USB Flash drive while the device is scanning and processing the
~* job. If you remove the Flash drive before the transfer is complete, the file can become
unusable and other files on the drive can be damaged.
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10. To return to the Home screen, press the Home button.

Printing from a USB Flash Drive

You can print a file stored on a USB Flash drive. The USB port is on the front of the printer.

If the device is in Power Saver mode, before proceeding with the Print job, to wake the device,
press the Power/Wake button.

Only USB Flash drives formatted to the typical FAT32 file system are supported.
Insert the USB Flash drive into the USB memory port on the printer.
At the USB Drive has been detected screen, touch Print from USB.

3]

Note: If this feature does not appear, enable the feature or contact the system
administrator. For more information, see the System Administrator Guide at www.xerox.
com/office/VLB71XXdocs.

Add files using the Browse USB screen.

e To print a group of print-ready files, for the USB drive or folder, touch the Select All icon.
Verify that your files are selected.

e To print a specific file, browse to that file, then touch the file name or icon.
Touch OK.

Confirm that the required files are listed.

o To select more files, touch Add Documents, then touch OK.

e Toremove a file name from the list, touch the file name, then touch Remove.
Select the paper supply, quantity, output color, and 2-sided printing options.
Touch Print.

When you are finished, remove the USB Flash drive.
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@PrintByXerox

@PrintByXerox Overview

You can use the Xerox® @PrintByXerox App to print email attachments and documents
sent to your printer from mobile devices.

When your Xerox device is connected to the Internet, the @PrintByXerox App works with
the Xerox® Workplace Cloud for simple email-based printing.

/’ Note: The @PrintByXerox App and Xerox® Workplace Cloud software require specific licenses,
configuration settings, and minimum system specifications. For details, refer to the Xerox®
@PrintByXerox App Quick Start Guide available at www.xerox.com/XeroxAppGallery.

Printing with the @PrintByXerox App

1. Send an email with an attachment containing a supported file type to Print@printbyxerox.com.
First-time users receive a response email with a user ID and password.

At the Xerox device control panel, press the Home button.

Touch @PrintByXerox.

Enter your email address, then touch Save.

voswN

On the Enter password screen, use the onscreen keyboard to enter your password, then touch
Save.

Select the documents that you want to print.

Touch Print Settings, then touch OK.

Touch Print.

e The Submitting Jobs to Print message and conversion state appears.

e When the documents begin to print, a green check mark appears.
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Previewing and Building Jobs

Use the Preview option to view and check scanned images, or to build jobs that contain more than 50
original documents.

If you are using Preview to build a job, divide your job into segments of 50 or fewer pages. After all
the segments are scanned and previewed, the job is processed and sent as a single job.

If the Preview option is hidden from view, refer to Customize and Personalize.

1.
2.
3.

N o »n B

10.

At the printer control panel, press the Home button.
To clear previous app settings, touch Reset.
Load your original documents.

e Use the document glass for single pages, or for paper that cannot be fed using the duplex
automatic document feeder. Lift the automatic document feeder, then place the original
document face down in the upper-left corner of the document glass.

e For single, multiple, or 2-sided pages, use the duplex automatic document feeder. Remove any
staples and paper clips from the pages. Insert the original documents face up in the
automatic document feeder, with the top of the page that entersthe feeder first. Adjust the
paper guides so that they fit against the documents.

e For jobs that contain more than 50 original documents, divide the documents into segments
of 50 or fewer pages. Load segment one into the duplex automatic document feeder.

e Thin paper: 38-49 g/m2, and a maximum of 130 sheets. Standard paper: 50-80 g/m2, and
a maximum of 130 sheets.

e Heavyweight paper: 81-128 g/m2, and a maximum of 85 sheets.

® Note: If you are scanning multiple segments, use the same input area for each segment.
Scan all segments using the document glass, or scan all segments using the automatic
document feeder.

Touch the app required.
Select the job settings.
Touch Preview.

If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an
option.

To start scanning, touch Preview.
The original documents are scanned and preview images appear on the screen.

Scroll through and check the preview images. To change the view orientation, touch Rotate. Do
one of the following.

e To scan more original documents, continue scanning your original documents using the same
input area. After you finish scanning, scroll to the end of the preview images, then touch the
Plus icon (+). Continue this procedure until you have scanned all the original documents.

e To process the job and send the scanned images, touch Send.
e To discard the job, touch X, then touch Delete and Close.

To return to the Home screen, press the Home button.
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Printing Overview

Before you print, ensure that your computer and the printer are plugged in, powered on, and
connected to an active network. Ensure that you have the correct print driver software installed on
your computer. For details, refer to Installing the Software.

Not all options described are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, print driver type.

The Windows PostScript print driver and the Macintosh print driver provide the widest range of
features.

To send a job to the printer:

1.
2.

Select the appropriate paper.

Load paper in the appropriate tray. At the printer control panel, specify the paper size, color, and
type.

Access the print settings in your software application. For most software applications, press CTRL
+P for Windows, or CMD+P for Macintosh.

Select your printer.

To access the print driver settings, for Windows, select Printer Properties, Print Options, or
Preferences. For Macintosh, select Xerox Features. The title of the button can vary depending on
your application.

Modify the print driver settings as necessary, then click OK.
To send the job to the printer, click Print.

Note: To print a file stored on a USB Flash drive, refer to Printing from a USB Flash Drive.
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Selecting Printing Options

Printing options, also called print driver software options, are specified as Printing Preferences in
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing,
page layout, and print quality. Printing options that are set from Printing Preferences become the
default setting. Printing options that are set from within the software application are temporary. The
application and the computer do not save the settings after the application is closed.

Print Driver Help

Xerox® print driver software Help information is available from the Printing Preferences window. To
see the help, click the Help (?) button in the bottom-left corner of the Printing Preferences window.

Information about Printing Preferences appears in the Help window. From there, you can select by
topic, or use the search field to find the information or function you need.

Windows Printing Options

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings specified in the
Printing Preferences window. You can specify your most common printing options and save them so
that you do not have to change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in
Printing Preferences.
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Navigate to the list of printers on your computer:

e For Windows Server 2008 and later, click Start > Settings > Printers.
e For Windows 7, click Start > Devices and Printers.

e For Windows 8, click Start > Control Panel > Devices and Printers.

e For Windows 10, click Start > Settings > Devices > Printers & scanners. Scroll down in the
window, then under Related settings, click Devices and printers.

¢ Note: If you are using a custom Start Menu application, it can change the navigation path
to your list of printers.

For your printer, select Printing preferences:

e For Windows Server 2008 or later, Windows 7, or Windows 8, right-click the icon for your
printer, then click Printing preferences.

e For Windows 10, click the icon for your printer, then click Manage > Printing preferences.

In the Printing Preferences window, click a tab, then select the options. To save the settings, click
OK.

/’ Note: For more information about Windows print driver options, click the Help button (?) in the

Printing Preferences window.

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, you can change the Printing Preferences before
sending the job to the printer.

1.

With the document open in your software application, access the print settings. For most
software applications, click File > Print or press CTRL+P.

Select your printer and click the Properties or Preferences button to open the Printing
Preferences window. The title of the button can vary depending on your application.

Click a tab in the Printing Preferences window, then make selections.
To save and close the Printing Preferences window, click OK.

To send the job to the printer, click Print.

Selecting Finishing Options for Windows

If your printer has a finisher installed, you can select finishing options in the Properties window of the
print driver. Finishing options allow you to select how your document is delivered. For example, you
can select hole-punching, stapling, folding, or printing in a booklet format.

¥ Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

To select finishing options in the PostScript and PCL print drivers:

1.

132

In the print driver, click the Printing Options tab.

Xerox® VersalLink® B71XX Multifunction Printer
User Guide



4.

Printing

To select a finishing option, for Finishing, click the arrow.

® Note: The print driver displays stapling positions for paper fed on the long edge. If paper
feeds on the short edge instead of the long edge, the finisher can insert the staple in the
wrong location.

To select the output tray, for Output Destination, click the arrow, then select an option.

e Automatic: Use this option to have the printer determine the output destination based on
the number of sets and the stapling option selected. The printer sends multiple sets or stapled
sets to the finisher output tray.

e Center Tray: Use this option to select the output tray in the center of the printer.
e Center Top Tray: Use this option to select the upper output tray in the center of the printer.

e Center Bottom Tray: Use this option to select the lower output tray in the center of the
printer.

e Finisher Tray: Use this option to select the output tray on the right side of the Office Finisher
or the Office Finisher with Booklet Maker.

To send the job to the printer, click OK, then click Print.

Selecting Printing Defaults in Windows for a Shared Network
Printer

1.

o v & ow

Navigate to the list of printers on your computer:

e For Windows Server 2008 and later, click Start > Settings > Printers.
e For Windows 7, click Start > Devices and Printers.

e For Windows 8, click Start > Control Panel > Devices and Printers.

e For Windows 10, click the Windows Start > Settings > Devices > Printers & Scanners. Scroll
down in the window, then under Related settings, click Devices and printers.

¥ Note: If the Control Panel icon does not appear on the desktop, right-click the desktop,
then select Personalize > Control Panel Home > Devices and Printers.

For your printer, select Printer properties:

e For Windows Server 2008 or later, Windows 7, or Windows 8, right-click the icon for your
printer, then click Printer properties.

e For Windows 10, click the icon for your printer, then click Manage > Printer properties.
In the printer Properties dialog box, click the Advanced tab.

On the Advanced tab, click Printing Defaults.

Make your selections on the print driver tabs as needed, then click Apply.

To save the settings, click OK.
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Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs. In Xerox®
App Gallery, you can save an app as default, so you can have app-by-app default settings for printing.

To save a set of printing options:
1. With the document open in your application, click File > Print.
2. To open the Printing Preferences window, select your printer, then click Properties or Preferences.
3. Inthe Printing Properties window, click the tabs, then select the required settings.
4. In the Printing Properties window, click Saved Settings or Presets, then click Save As.
5. Type a name for the saved setting or preset, then choose preset options, if available:
a. Choose an icon for the preset.
b. To enable the preset as 1-Touch, select 1-Touch Preset.
c. Toshare the preset in all print drivers, select Show this Preset in All Drivers.
Click OK.
To print with these settings:
a. From the Saved Settings or Presets list, select the name of the preset.

b. For a 1-Touch preset, click 1-Touch, then click the required 1-Touch preset.

Macintosh Printing Options

Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.
1. With the document open in your application, click File > Print.

2. Select your printer.

3. Open the Print dialog box, then click Show Details. Click the application menu for your current
application, then select Xerox Features.

4. Select any other required printing options from the lists.

Click Print to send the job to the printer.

Selecting Finishing Options for Macintosh

If your printer has a finisher installed, select finishing options in the Xerox® Features of the print
driver.

To select finishing options in the Macintosh print driver:

1. Open the Print dialog box, then click Show Details. Click the application menu for your current
application, then select Xerox Features.

2. To select stapling options, for Finishing, click the arrow, then select an option.
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3. To select the output tray, for Output Destination, click the arrow, then select an option.

e Automatic: Use this option to have the printer determine the output destination based on
the number of sets and the stapling option selected. The printer sends multiple sets or stapled
sets to the finisher output tray.

e Center Tray: Use this option to select the output tray in the center of the printer.
o Center Top Tray: Use this option to select the upper output tray in the center of the printer.

e Center Bottom Tray: Use this option to select the lower output tray in the center of the
printer.

e Finisher Tray: Use this option to select the output tray on the right side of the Office Finisher
or the Office Finisher with Booklet Maker.

4, To send the job to the printer, click Print.

Saving a Set of Commonly Used Printing Options for Macintosh
You can define and save a set of options, so that you can apply them to future print jobs.
To save a set of printing options:
1. With the document open in your application, click File > Print.
2. Select your printer from the Printers list.
3. Select the required printing options from the lists in the Print dialog box.
j’ Note: To see all printing options, click Show Details.

4. Click Presets > Save Current Settings as Preset.
Type a name for the printing options. To save the set of options in the Presets list, click OK.

To print using these options, select the name from the Presets list.

UNIX, Linux, and AS/400 Printing

The Xerox® Print Driver package provides tools for you to manage printers connected in UNIX and
Linux environments.

To provide printer spooling and network print server functionality, UNIX-based printing uses LPD/LPR
port 515 or Ip to port 9100. Xerox printers can communicate using either protocol.

Xerox® Printer Manager

Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in
UNIX and Linux environments.

Xerox® Printer Manager allows you to:
e Configure and check the status of network connected printers.

e Set up a printer on your network, and monitor the operation of the printer once installed.

e Perform maintenance checks, and view supplies status at any time.
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e Provide a common look and feel across the many different suppliers of UNIX and Linux operating
systems.

Installing the Xerox® Printer Manager

Before you begin:

Ensure that you have root or superuser privileges to install Xerox® Printer Manager.
To install the Xerox® Printer Manager:

1. Download the appropriate package for your operating system. To locate print drivers for your
printer, go to www.xerox.com/drivers.

On the print driver website, navigate to your printer model.
For your printer model, click Drivers & Downloads.

From the Operating System menu, select your operating system.

v &~ W N

To identify the print driver for your printer model, review the list of available print drivers.
¢ Note: For additional information on each driver, click Description.

To select the print driver for your printer model and operating system, click its name.

To begin the download, read the End User License Agreement, then click accept.

The file automatically downloads to the default location for your computer file downloads.
8. To install the Xerox® Print Driver package:

e Open the package with your OS package manager.

e Toinstall using a command-line utility, change to the directory where you downloaded the
file. To run the installer, type the appropriate command-line utility for your operating system.
For example:

e Red Hat: rpm -U <filename>.rpm

e Debian-based Linux: dpkg -i <filename>.deb
e AIX:rpm -U <filename>.rpm

e HPUX: <filename>.depot.gz

e Solaris: pkgadd -d <filename>.pkg

¥ Note: Most installations create a Xerox directory in /opt/Xerox/prtsys. For additional
information about utilities included in the OS package manager, refer to the manual included
with the package. For example, man xeroxprtmagr.

Launching Xerox® Printer Manager
To launch Xerox®Printer Manager, do one of the following tasks.

e For UNIX, log in as root. From a terminal window, type xosdprtmgr, then press Enter or Return.

e For Linux, type sudo xeroxprtmgr, then press Enter or Return.

Printing with xeroxprint
Xerox has its own print command. You can use the following command:
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xeroxprint -d<Some_Queue> -o[Options] <Somefile>

Printing from a Linux Workstation

To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS (Common
UNIX Printing System) print driver. You do not need both drivers.

Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate
drivers for your printer, go to www.xerox.com/drivers.

If you use CUPS, ensure that CUPS is installed and running on your workstation. For instructions to
install and build CUPS, refer to Easy Software Products in the CUPS Software Administrators Manual.
For complete information on CUPS printing capabilities, refer to the CUPS Software Users Manual
available from www.cups.org/documentation.php.

Installing the PPD File on the Workstation

1. On the Xerox Support website, from the Drivers and Downloads page, download the Xerox® PPD
for CUPS (Common UNIX Printing System).

2. Copy the PPD file to the CUPS ppd/Xerox folder on your workstation. If you are unsure of the
folder location, use the Find command to find the folder.

3. Follow the instructions that are included with the PPD file.

Adding the Printer

1. Verify that the CUPS (Common UNIX Printing System) daemon is running.

2. Open a Web browser, type http://localhost:631/admin, then press Enter or Return.
3. For User ID, type root. For password, type the root password.

4. Click Add Printer, then follow the onscreen prompts to add the printer to the CUPS printer list.

Printing with CUPS (Common UNIX Printing System)
CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands.
1. To print to a specific printer in System V, type 1p -dprinter filename, then press Enter.

2. To print to a specific printer in Berkeley, type 1pr -Pprinter filename, then press Enter.

AS/400

Xerox provides Work Station Customization Object (WSCO) files to support IBM i V6R1 or later. A
Work Station Customization Object is a lookup table that the host print transform (HPT) uses to
translate AS/400 commands to the equivalent PCL code that is specific to a particular printer. A
WSCO file can modify many print features, including: paper input tray, 2-sided printing, characters per
inch, lines per inch, orientation, fonts, and margins.

The XTOOLS library provides a source WSCO file for each supported Xerox® printer or device. The
library and installation instructions are available from www.support.xerox.com.

To install the XTOOLS library, select the downloadable files for the IBM AS/400 operating system,
unzip the downloaded XTOOLSxxxx . z1ip file, then follow the instructions to install the library.
Download and install the library only once.
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e The host print transform works only on AFPDS and SCS files. To use the WSCO for printing, convert
IPDS-formatted printer files to AFPDS files.

e Administrator credentials with IOSYSCFG permissions are required to create a device description
or a remote queue.

e For details on AS/400, refer to the IBM AS/400 Printing V, (Red Book), available on the IBM
website.

Mobile Printing Options

This printer can print from iOS and Android mobile devices.

Printing with Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or
smartphone, using Wi-Fi Direct.

For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device.

¢ Note: Depending on which mobile device you are using, the printing procedure varies.

Printing with AirPrint

You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint®. To enable AirPrint®
for your printer, refer to Configuring AirPrint. To use AirPrint®, ensure that your mobile device is
connected to the same wireless network as the printer.

To print with AirPrint®:

1. Open the email, photograph, website page, or document that you want to print.
2. Tap the Action icon.

3. Tap Print.

4, Select your printer, then set the printer options.

5. Tap Print.

Printing from a MOPRIA-Enabled Mobile Device

MOPRIA™ is a software feature that enables users to print from mobile devices without requiring a
print driver. You can use MOPRIA™ to print from your mobile device to MOPRIA™-enabled printers.

e MOPRIA™ and all of its required protocols are enabled by default.

e Ensure that you have the latest version of the MOPRIA™ Print Service installed on your mobile
device. You can obtain a free download from the Google Play Store.

e Wireless devices must join the same wireless network as the printer.

e The name and location of your printer appears in a list of MOPRIA™-enabled printers on
connected devices.

To print using MOPRIA™, follow the directions provided with your mobile device.

138  Xerox® VersalLink® B71XX Multifunction Printer
User Guide



Printing

Print Jobs
Managing Jobs

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs.
You can pause, delete, print, or view job progress or job details for a selected job. From the Jobs
window in the Embedded Web Server, you can view a list of active and completed print jobs. For more
information, refer to Managing Jobs Using the Embedded Web Server.

A print job can be held by the printer when it is unable to complete a print job. For example, when the
printer needs attention, paper, or supplies. When the condition is resolved, the printer automatically
resumes printing. When you send a Secure Print job, the job is held until you release it by typing a
passcode at the control panel. For more information, refer to Printing Special Job Types.

Pausing the Print Job with the Option to Delete It
1. At the printer control panel, press the Home button.
2. Touch Jobs, then touch the name of the print job.
3. Do one of the following:
e To pause the print job, touch Pause. To resume the print job, touch Resume.

e To delete the print job, touch Delete. At the prompt, touch Delete.
¢ Note: If you do not make a selection within 60 seconds, the job resumes automatically.

4. To return to the Home screen, press the Home button.

Viewing, Printing, or Deleting Saved and Secure Jobs

The system administrator can restrict users from deleting jobs. If a system administrator has
restricted job deletion, you can view the jobs, but not delete them. Only the user that sent the job or
the system administrator can delete a Secure Print job.

1. At the printer control panel, press the Home button.
2. Toview a list of active and completed jobs, touch Jobs.
3. Toview a list of specific job types, touch an option.

e To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then
touch OK. To delete the job, touch the Trash icon, then touch Delete.

e To view Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then
touch Print All, or Delete All.

e For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number,
then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder,
touch Print All, or Delete All.

4. To view details about a job, touch the job.

To return to the Home screen, press the Home button.
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Printing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer
control panel. To select special job types from the print driver, select Printing Options > Job Type.

Saved Jobs

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use. Any
user can print or delete a Saved Job.

To print a Saved Job, refer to Printing a Saved Job.

Printing a Saved Job

1. In your software application, access the print settings. For most software applications, press CTRL
+P for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.

o For Windows, click Printer Properties. Depending on your application, the title of the button
can vary.

e For Macintosh, in the Print window, click Print Options, then select Xerox Features.
3. For Job Type, select Saved Job.
4. Type a job name or select a name from the list, then click OK.
5. Select any other required printing options.

e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Saved Job

1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. To view Saved Jobs, touch Saved Jobs.

4, To print a Saved Job, touch the job name, enter the quantity, then touch OK.
5

To delete the document after printing, for that job, touch the Trash icon, then at the prompt,
touch Delete.

6. To return to the Home screen, press the Home button.

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the
printer until you enter your passcode at the printer control panel.

To print a Secure Print job, refer to Printing a Secure Print Job.

Printing a Secure Print Job

1. In your software application, access the print settings. For most software applications, press CTRL
+P for Windows or CMD+P for Macintosh.
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Select your printer, then open the print driver.

e For Windows, click Printer Properties. Depending on your application, the title of the button
varies.

e For Macintosh, in the Print window, click Preview, then select Xerox Features.
For Job Type, select Secure Print.

Type the passcode, confirm the passcode, then click OK.

Select any other required printing options.

e For Windows, click OK, then click Print.

e For Macintosh, click Print.

To Release a Secure Print Job

N
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At the printer control panel, press the Home button.

Touch Jobs.

To view Secure Print jobs, touch Personal & Secure Jobs.

Touch your folder.

Enter the passcode number, then touch OK.

Select an option:

e To print a Secure Print job, touch the job.

e To print all the jobs in the folder, touch Print All.

e To delete a Secure Print job, touch the Trash icon, then at the prompt, touch Delete.
e To delete all the jobs in the folder, touch Delete All.

¢ Note: After a Secure Print job is printed, it is deleted automatically.

To return to the Home screen, press the Home button.

Personal Print

Personal Print allows you to store a document in the printer, then print it from the control panel.

¢ Note: The Personal Print feature is only available on a Windows computer printing to a network

printer.

Personal Print is a type of saved job with these features:

A Personal Print job appears in a folder named after the user ID associated with the print job.
A Personal Print job does not use a passcode.

Any user can print or delete a Personal Print job.

You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list.

After a Personal Print job is printed, it is deleted automatically.

To print a Personal Print job, refer to Printing Using Personal Print.
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Printing Using Personal Print

1. In your software application, access the print settings. For most software applications, click File or
for Windows, press CTRL+P.

2. Select your printer, then click Printer Properties. Depending on your application, the title of the
button varies.

3. For Job Type, select Personal Print.
Select any other required printing options, then click OK.
5. To send the job to the printer, click Print.

To Release a Personal Print Job

1. At the printer control panel, press the Home button.
Touch Jobs.

To view Personal Print jobs, touch Personal & Secure Jobs.

Touch your folder.

i & wN

If prompted for a passcode, touch Skip.

¢ Note: When your folder contains Secure Print jobs and Personal Print jobs, the passcode
prompt appears.

6. Select an option.
e To print a Personal Print job, touch the job.
e To print all the jobs in the folder, touch Print All.
e To delete all the jobs in the folder, touch Delete All.

7. To return to the Home screen, press the Home button.

Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining
copies. After reviewing the sample set, you can either print the remaining copies or delete them at
the printer control panel.

Sample Set is a type of saved job with these features:

e A Sample Set job appears in a folder named after the user ID associated with the print job.
e A Sample Set job does not use a passcode.

e Any user can print or delete a Sample Set job.

e A Sample Set prints one copy of a job to allow you to proofread the job before printing any
remaining copies.

After a Sample Set job is printed, it is deleted automatically.

Printing a Sample Set

1. In your software application, access the print settings. For most software applications, press CTRL
+P for Windows or CMD+P for Macintosh.

142 Xerox® VersalLink® B71XX Multifunction Printer
User Guide



Printing

Select your printer, then open the print driver.

e For Windows, click Printer Properties. Depending on your application, the title of the button
varies.

e For Macintosh, in the Print window, click Preview, then select Xerox Features.
For Job Type, select Sample Set.

Select any other required printing options.

e For Windows, click OK, then click Print.

e For Macintosh, click Print.

To Release a Sample Set

1.
2.
3.

At the printer control panel, press the Home button.
To view available jobs, touch Jobs.

Touch the Sample Set job.

¥ Note: The Sample Set file description shows the job as Held for Future Printing, and shows
the number of remaining copies of the job.

Select an option.
e To print the remaining copies of the job, touch Release.
o To delete the remaining copies of the job, touch Delete.

To return to the Home screen, press the Home button.
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Printing Features

Selecting Paper Options for Printing

There are two ways to select the paper for your print job. You can let the printer select which paper to
use based on the document size, paper type, and paper color you specify. You can also select a
specific tray loaded with the desired paper.

Scaling
Scaling reduces or enlarges the original document to match the selected output paper size.
e For Windows, the scale options are on the Printing Options tab, in the Paper field.

e For Macintosh, the scale options are in the Print window. To view more printing options, click Show
Details.

The following scaling options are available:

e Automatically Scale scales the document to fit the selected Output Paper Size. The scaling
amount appears in the percentage box below the sample image.

e No Scaling does not change the size of the page image printed on the output paper, and 100 %
appears in the percentage box. If the original size is larger than the output size, the page image is
cropped. If the original size is smaller than the output size, extra space appears around the page
image.

e Manually Scale scales the document by the amount entered in the percentage box below the
preview image.

Printing on Both Sides of the Paper

Printing a 2-Sided Document

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The
print driver uses the settings for portrait or landscape orientation from the application for printing the
document.

f Note: Ensure that the paper size and weight are supported. For details, refer to Supported
Paper Types and Weights for Automatic 2-Sided Printing.

2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn.
These settings override the application page orientation settings.

e 1-Sided Print: This option prints on one side of the media. Use this option when printing on
envelopes, labels, or other media that cannot be printed on both sides.

e 2-Sided Print: This option prints the job on both sides of the paper to allow binding on the long
edge of the paper. The following illustrations show the result for documents with portrait and
landscape orientation, respectively:
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e 2-Sided Print, Flip on Short Edge: This option prints on both sides of the paper. The images print
to allow binding on the short edge of the paper. The following illustrations show the result for
documents with portrait and landscape orientations, respectively:

N

/’ Note: 2-Sided Printing is part of the Earth Smart settings.

To change your default print driver settings, refer to Setting Default Printing Options for Windows.

Print Quality

Print-quality modes:
e Standard print-quality mode: 600 x 600 dpi
e Enhanced print-quality mode: 1200 x 1200 dpi

Image Options

Image options controls how the printer uses lightness and contrast to produce your document. The
Windows PostScript print driver and the Macintosh print drivers provide the widest range of controls
on the Image Options tab.

Lightness

The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in
your printed job.

Image Shift

Image Shift allows you to modify the location of the image on the page. You can shift the printed
image along the X and Y axes of each sheet of paper.

Contrast

You can use the Contrast feature to adjust the variation between light and dark areas of the print job.
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Printing Multiple Pages to a Single Sheet

When printing a multiple-page document, you can print more than one page on a single sheet of
paper.

Toprint 1, 2,4, 6,9, or 16 pages per side, select Pages Per Sheet on the Pages Per Sheet Page Layout
tab.

e For Windows, Page Layout is on the Document Options tab.

e For Macintosh, in the Print window, Layout is on the Preview list.

1 | A

To print a border around each page, select Page Borders.

Printing Booklets

With 2-sided printing, you can print a document in the form of a small booklet. You can create
booklets from any paper size that is supported for 2-sided printing.

The print driver automatically reduces each page image and prints four page images per sheet of
paper, two page images on each side. The pages are printed in the correct order so that you can fold
and staple the pages to create the booklet.

e For Windows, Booklet Layout is on the Page Layout tab. Page Layout is on the Document Options
tab.

e For Macintosh, in the Print window, in Xerox Features, Booklet Layout is on the Paper/Output list.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter
and creep.

o Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm
(1/72 in.).

e Creep: Specifies how much the page images shift outward in tenths of a point. Shifting
compensates for the thickness of the folded paper, which can cause the page images to shift
outward slightly when folded. You can select a value from zero to 1 point.

Gutter Creep
‘: . :‘ T T
' -,
>
?
4 -
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Using Special Pages

The Special Pages options control how covers, inserts, and exception pages are added to your printed
document.

e For Windows, the Special Pages tab is on the Document Options tab.

e For Macintosh, in the Print window, in Xerox Features, Special Pages is in the Paper field for Paper/
Output.

Printing Cover Pages

A cover page is the first or last page of a document. You can select paper sources for the cover pages
that are different from the source used for the body of a document. For example, you can use your
company letterhead for the first page of a document. You can also use heavyweight paper for the
first and last pages of a report. You can use any applicable paper tray as the source for printing cover
pages.

Select one of these options for printing cover pages:

¢ No Covers: This option does not print cover pages. No cover pages are added to the document.
e Front Only: This option prints the first page on paper from the specified tray.

e Back Only: This option prints the back page on paper from the specified tray.

e Front and Back: Same prints the front and back cover pages from the same tray.

e Front and Back: Different prints the front and back cover pages from different trays.

After making a selection for printing the cover pages, you can select the paper for the front and back
covers by size, color, or type. You can also use blank or pre-printed paper, and you can print side one,
side two, or both sides of the cover pages.

Printing Insert Pages

You can add blank or pre-printed insert pages before page one of each document or after designated
pages within a document. Adding an insert after designated pages within a document separates
sections, or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert
pages.

o Insert Options provides the options to place an insert After Page X, where X is the specified page,
or Before Page 1.

o Insert Quantity specifies the number of pages to insert at each location.

e Pages: Specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to specify pages 1, 6,9, 10, and 11, type 1,6,9-11.

e Paper: Displays the default size, color, and type of paper selected in Use Job Settings.
e Job Setting: Displays the attributes of the paper for the remainder of the job.
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Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify
differences such as page size, page type, and page color. You can also change the side of the paper
on which to print as your job requires. A print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a
special paper, and the remainder of the pages printed 2-sided on regular paper. You can use
exception pages to print the job.

In the Add Exceptions window, you can set the characteristics of the exception pages and select the
alternate paper source:

e Pages: Specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to specify pages 1, 6,9, 10, and 11, type 1, 6, 9-11.

e Paper: Displays the default size, color, and type of paper selected in Use Job Settings.

e 2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select an
option:

— 1-Sided Print prints the exception pages on one side only.

— 2-Sided Print prints the exception pages on both sides of the paper and flips the pages on
the long edge. The job then can be bound on the long edge of the pages.

— 2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and
flips the pages on the short edge. The job then can be bound on the short edge of the pages.

— Use Job Setting prints the job using the attributes shown in the Job Settings box.
e Job Setting: Displays the attributes of the paper for the remainder of the job.

¥ Note: Some combinations of 2-sided printing with certain paper types and sizes can produce
unexpected results.

Printing Watermarks for Windows

A watermark is special-purpose text that can be printed across one or more pages. For example, you
can add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document
before distribution.

e This feature is available only on a Windows computer printing to a network printer.

e Not all options listed are supported on all printers. Some options apply only to a specific printer
model, configuration, operating system, or print driver type.

e Watermarks are not supported for some print drivers when booklet is selected or when more than
one page is printed on a sheet of paper.

To print a watermark:
1. Inthe print driver, click the Document Options tab.
2. Click the Watermark tab.

3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or
create a customized watermark. You can also manage watermarks from this menu.
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4, Under Text, select an option:

e Text: Enter the text in the field, then specify the font.

o Time Stamp: Specify the date and time options, then specify the font.

e Picture: To locate the picture, click the Browse icon.

5. Specify the scaling angle and position of the watermark:

e Select the scaling option that specifies the size of the picture in relation to the original image.
Use the arrows to scale the image in increments of 1%.

e To define the angle of the image on the page, specify the position option or to rotate the
image left or right by increments of 1, use the arrows.

e To define the location of the image on the page, specify the position option, or to move the
image in each direction in increments of 1, use the arrows.

6. Under Layering, select how to print the watermark:

e Print in Background: This option prints the watermark behind the text and graphics in the
document.

e Blend: This option combines the watermark with the text and graphics in the document. A
blended watermark is translucent, so you can see both the watermark and the document
content.

e Print in Foreground: This option prints the watermark over the text and graphics in the
document.

7. Click Pages, then select the pages to print the watermark:

o Print on All Pages: This option prints the watermark on all pages of your document.

e Print on Page 1 Only: This option prints the watermark only on the first page of the
document.

8. If you select a picture as a watermark, specify the lightness settings for the image.
9. Click OK.
Orientation

Orientation allows you to select the direction that the page prints.

For Windows, the Orientation tab is on the Document Options tab.

¢/ Note: The orientation setting in your application print dialog box may override the orientation

options in the print driver.

For Macintosh, Orientation options are in the Print window.

The following options are available:

Portrait: Orients the paper so that the text and images print across the short dimension of the
paper.
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¢ Landscape: Orients the paper so that the text and images print across the long dimension of the
paper.

A

e Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the
long bottom side up.

v

_fg Note: For Macintosh, to print portrait text and images in landscape orientation, clear
the Auto Rotate check box.

Advanced Tab

You can use the Advanced tab to set advanced printing options. Selections on this tab apply to all
jobs that you print with the print driver.

¥ Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

Job Identification

You can use the Job ID feature to change the job identification setting for your print job. You can
print the job identification on a separate banner page or on the pages of your document.

The following options are available:
e Disable Job ID: This option directs the printer not to print a banner page.
e Print ID on a Banner Page: This option prints the job identification on a banner page.

e Print ID in Margins - First Page Only: This option prints the job identification on the first page of
the document in the top-left margin.

e Print ID in Margins - All Pages: This option prints the job identification in the top-left margin on
every page of the document.

Printing Mirror Images

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right
when printed.
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Selecting Job Completion Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer
screen with the name of the job and the name of the printer where it was printed.

j’ Note: This feature is only available on a Windows computer printing to a network printer.

To select job completion notification from the Advanced tab:
1. Click Notifications.
2. Click Notify for Completed Jobs, then select an option.

e Enabled: This option turns on notifications.

o Disabled: This option turns off the Notification feature.
3. Click OK.
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Using Custom Paper Sizes

You can print on custom paper sizes that are within the minimum and maximum size range supported
by the printer. For details, refer to Supported Paper.

Defining Custom Paper Sizes

To print on custom paper sizes, define the custom width and length of the paper in the print driver
software and on the printer control panel. When setting the paper size, ensure that you specify the
same size as the paper in the tray. Setting the wrong size can cause a printer error. Print driver
settings override control panel settings when you print using the print driver software on your
computer.

Creating and Saving Custom Paper Sizes in the Print Driver

Custom-size paper settings are saved in the print driver and are available for you to select in all your
applications.

Use the custom-size paper settings to define a custom paper size for long media, such as banner
paper.

For details on supported paper sizes for each tray, refer to Supported Paper.

For further details about creating and saving custom paper sizes in the print driver, click the Help (?)
button in the bottom-left corner of the printer settings window.

Creating and Saving Custom Sizes for the Windows V3 Print Driver
To create and save custom paper sizes for the Windows V3 print driver, perform the following:

1. In the print driver, click the Printing Options tab.

2. For Paper, click the arrow, then select Other Size > Advanced Paper Size > Output Paper Size >
New.

In the New Custom Paper Size window, enter the height and width of the new size.

To specify the units of measurement, at the bottom of the window, click Measurements, then
select Inches or Millimeters.

5. To save, in the Name field, type a title for the new size, then click OK.

Creating and Saving Custom Sizes for the Windows V4 Print Driver
To create and save custom paper sizes for the Windows V4 print driver, perform the following:

1. From Windows Control Panel, select Devices and Printers.

2. Select the printer, then click Print server properties.

3. On the Forms tab, for Create a new form, click the check box.
4

For Form name, type a name for the new paper size.
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In the Form description (measurements) areaq, enter the settings:
e For Units, select Metric or English.
o For Paper size, enter measurements for Width and Height.

o For Printer area margins, enter measurements for Left, Right, Top, and Bottom.

¥ Note: Ensure that the measurements that you specify are within the supported ranges for
the device.

Click OK.

The new paper size is added to the paper size list.

Creating and Saving Custom Sizes for Macintosh

o v &~ wWw N =

In the application, click File > Print.

Click Paper Size, then select Manage Custom Sizes.

To add a new size, in the Manage Paper Sizes window, click the plus sign (+).
Double-click Untitled, then type a name for the new custom size.

Enter the height and width of the new custom size.

Click the arrow for the Non-Printable Area field, then select the printer from the list. Or, for User
Defined margins, set the top, bottom, right, and left margins.

To save the settings, click OK.

Defining a Custom Paper Size at the Control Panel

You can print on custom-size paper from any paper tray. Custom-size paper settings are saved in the
print driver and are available for you to select in all your applications. At the control panel, you can
view the paper tray settings from Home > Device > Paper Trays.

To set up standard or custom-size paper for any tray, perform the following:

No v bk wN =

At the printer control panel, press the Home button.

Open the required tray and load your paper.

When you close the tray, the Tray Settings menu appears at the control panel.
Touch the current paper size setting, then from the list, touch Custom.

In the Custom Paper Size screen, enter the height and width of the new paper size.
To save the setting, touch OK.

From the Tray Settings menu, you can define your paper type and color.

a. For paper type: Touch the current settings, then from the list, touch your paper type. To enter
a custom paper type, touch Custom Type.

b. For paper color: Touch the current settings, then from the list, touch your paper color. To enter
a custom color, touch Custom.

¢. To save the setting, touch OK.

To return to the Home screen, press the Home button.
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Printing on Custom-Size Paper

® Note: Before you print on custom-size paper, define the custom width and length of the paper

in the print driver software and on the printer control panel. For more information, refer to
Defining a Custom Paper Size at the Control Panel.

Printing on Custom-Size Paper from the Windows V3 Print Driver

# Note: Before you print on custom-size paper, define the custom size in the Printer Properties.

For details, refer to Creating and Saving Custom Sizes for the Windows V3 Print Driver.
Load the custom-size paper in the tray.
In the application, click File > Print, then select your printer.
In the Print dialog box, click Printer Properties.
On the Printing Options tab, from the Paper list, select the required custom paper size and type.
Select any other required options, then click OK.

In the Print dialog box, click Print.

Printing on Custom-Size Paper from the Windows V4 Print Driver

No v s wN =

® Note: Before you print on custom-size paper, define and save the custom paper size as a Form.

For details, refer to Printing on Custom-Size Paper from the Windows V4 Print Driver.
Load the custom-size paper in the tray.
In the application, click File > Print, then select your printer.
In the Print dialog box, click Printer Properties.
On the Printing Options tab, from the Paper list, select Other Size.
To select a custom paper size, select Fit to New Paper Size, then select the custom paper size.
Select any other required options, then click OK.

In the Print dialog box, click Print.

Printing on Custom-Size Paper from Macintosh

1.

2
3.
4
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Load the custom-size paper. For details, refer to Loading Paper.
In the application, click File > Print.

From the Paper Size list, select the custom paper size.

Click Print.
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Paper and Media Overview

The printer can have up to six paper trays, depending on the paper tray configuration.

1. Base Model 3. Configuration with High-Capacity Tandem

2. Configuration with 3-Tray Module Tray Module and High-Capacity Feeder

e For all configurations, Tray 1 is an adjustable paper tray for loading a range of paper sizes.
e For the 3-Tray configuration, Trays 2—-4 are adjustable trays, similar to Tray 1.

e For the Tandem Tray configuration, Tray 2 is an adjustable paper tray, similar to Tray 1. Trays 3-4
are high-capacity trays that can hold A4, Letter, and Executive-size paper.

e The Bypass Tray is designed for loading small amounts of special paper.
— The optional Envelope Tray can replace Tray 1.

— Tray 6 is an optional external high-capacity paper tray that can hold A4, Letter, or Executive-
Size paper.

The printer can use various media types, such as plain, recycled, or colored paper, letterhead, pre-
printed, cardstock, labels, and envelopes. Ensure that you use the correct media for the tray that you
are loading.

Labels are affixed inside each tray to show the correct orientation for loading certain types of media.
The MAX label shows the maximum fill line for the tray.
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Supported Paper

Your printer is designed to use various paper and other media types. To ensure the best print quality
and to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

Ordering Paper

To order paper or other media, contact your local reseller or visit www.xerox.com/office/
VLB71XXsupplies.

General Paper Loading Guidelines

¢ Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.
e Adjust the paper guides to fit the paper size.

e Fan paper before loading it in the paper tray.

o If excessive jams occur, use paper or other approved media from a new package.

e Do not print on label media after a label has been removed from a sheet.

e Use only paper envelopes. Print envelopes 1-sided only.

Paper That Can Damage Your Printer

Some paper and other media types can cause poor output quality, increased paper jams, or damage
your printer. Do not use the following:

e Rough or porous paper

e Inkjet paper

e Non-laser glossy or coated paper

e Paper that has been photocopied

e Paper that has been folded or wrinkled

e Paper with cutouts or perforations

e Stapled paper

e Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes

e Plastic media

e Transparencies

(T Caution: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does
e . . .
not cover damage caused by using unsupported paper or specialty media. The Xerox Total
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary
outside these areas. Please contact your local representative for details.
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Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

e Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from
ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly
damaging to paper.

e Reduce the exposure of paper to strong lights for long periods of time.
e Maintain constant temperatures and relative humidity.

e Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to
collect moisture.

e Store paper flat, either on pallets, cartons, shelves, or in cabinets.
e Avoid food or drinks in the area where paper is stored or handled.

¢ Do not open sealed packages of paper until you are ready to load the paper into the printer.
Leave stored paper in the original packaging. The paper wrapper protects the paper from moisture
loss or gain.

e Some special media is packaged inside resealable plastic bags. Store the media inside the bag
until you are ready to use it. Keep unused media in the bag and reseal it for protection.

Supported Paper Types and Weights

Trays Paper Types Weights
Trays 1-4 of all configurations Bond 60-105 g/m?
Hole-Punched
Letterhead
Plain

Plain Reloaded
Pre-Printed
Recycled

Custom

Lightweight Cardstock 106-169 g/m2
Lightweight Cardstock Reloaded
Lightweight Glossy Cardstock

Lightweight Glossy Cardstock
Reloaded

Cardstock 170-216 g/m?
Cardstock Reloaded
Glossy Cardstock

Glossy Cardstock Reloaded
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Paper Types

Heavyweight Cardstock
Heavyweight Cardstock Reloaded
Heavyweight Glossy Cardstock

Heavyweight Glossy Cardstock
Reloaded

Paper and Media

Weights
217-256 g/m2

Labels
Heavyweight Labels
Extra Heavyweight Labels

106-169 g/m2
170-216 g/m?
217-256 g/m?

Bypass Tray

Bond
Hole-Punched
Letterhead
Plain

Plain Reloaded
Pre-Printed
Recycled

Custom

60-105 g/m?2

Lightweight Cardstock
Lightweight Cardstock Reloaded
Lightweight Glossy Cardstock

Lightweight Glossy Cardstock
Reloaded

106-169 g/m?2

Cardstock

Cardstock Reloaded
Glossy Cardstock

Glossy Cardstock Reloaded

170-216 g/m2

Labels
Heavyweight Labels

106-169 g/m?2
170-216 g/m?2

Envelopes

75-90 g/m?

Tray 6

Bond
Hole-Punched
Letterhead
Plain

Plain Reloaded
Pre-Printed

60-105 g/m?
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Trays

Paper Types Weights
Recycled

Custom

Lightweight Cardstock 106-169 g/m2

Lightweight Cardstock Reloaded
Lightweight Glossy Cardstock

Lightweight Glossy Cardstock
Reloaded

Cardstock

Cardstock Reloaded
Glossy Cardstock

Glossy Cardstock Reloaded

170-216 g/m2

Labels
Heavyweight Labels

106-169 g/m?
170-216 g/m?

Envelope Tray

Envelopes

75-90 g/m?

Supported Standard Paper Sizes

European Standard Sizes

North American Standard
Sizes

Trays 1 and 2 in all configurations

Trays 3 and 4 in the 3-Tray module

A5 (148 x 210 mm, 5.8 x 8.3 in.)
B5 (176 x 250 mm, 6.9 x 9.8 in.)
A4 (210 x 297 mm, 8.3 x 11.7in.)
B4 (250 x 353 mm, 9.8 x 13.9in.)
A3 (297 x 420 mm, 11.7 x 16.5in.)

Statement (140 x 216 mm, 5.5 x
8.5in.)

Executive (184 x 267 mm, 7.25 x
10.5in.)

Letter (216 x 279 mm, 8.5x 11 in.)

US Folio (216 x 330 mm, 8.5x 13
in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

Tabloid (432 x 279 mm, 17 x 11
in.)

Trays 3 and 4 in the Tandem Tray
Module

A4(210x 297 mm, 8.3 x 11.7 in.)

Executive (184 x 267 mm, 7.25 x
10.5in.)

Letter (216 x 279 mm, 8.5x 11 in.)

Bypass Tray

A6 (105 x 148 mm, 4.1 x 5.8 in.)
A5 (148 x 210 mm, 5.8 x 8.3 in.)
A4 (210 x 297 mm, 8.3 x 11.7 in.)

Postcard (89 x 140 mm, 3.5 x 5.5
in.)

Postcard (102 x 152 mm, 4 x 6 in.)
5x7(127 x178 mm, 5x 7 in.)
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North American Standard

European Standard Sizes

A4 Oversized (223 x 297 mm, 8.8 x
11.7 in)

215x315(215x 315 mm, 8.5 x
12.4in.)

A3 (297 x 420 mm, 11.7 x 16.5in.)
B6 (125x176 mm, 4.9 x 6.9 in.)
B5 (176 x 250 mm, 6.9 x 9.8 in.)
B4 (250 x 353 mm, 9.8 x 13.9in.)

Sizes
Statement (140 x 216 mm, 5.5 x
8.5in.)

Executive (184 x 267 mm, 7.25 x
10.5in.)

8x10(203 x 254 mm, 8 x 10in.)
Letter (216 x 279 mm, 8.5 x 11 in.)

US Folio (216 x 330 mm, 8.5 x 13
in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

Tabloid (279 x 432 mm, 11 x 17
in.)

DL envelope (110 x 220 mm, 4.33
x 8.66 in.)

C6 envelope (114 x 162 mm, 4.5 x
6.38in.)

C5 envelope (162 x 229 mm, 6.4 x
9in.)

Envelope (152 x 228 mm, 6 x 9 in.)

Envelope (228 x 305 mm, 9 x 12
in.)

Monarch envelope (98 x 190 mm,
39x75in.)

No. 9 envelope (98 x 225 mm, 3.9
x8.9in.)

No. 10 envelope (105 x 241 mm,
41x9.5in.)

Tray 6

A4 (210 x 297 mm, 8.3 x 11.7 in.)

Executive (184 x 267 mm, 7.25 x
10.5in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

Envelope Tray

DL envelope (110 x 220 mm, 4.33
x 8.66 in.)

C5 envelope (162 x 229 mm, 6.4 x
9in.)

Monarch envelope (98 x 190 mm,
39x75in.)

No. 10 envelope (241 x 105 mm,
41x9.5in)
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Supported Standard Paper Sizes for Automatic 2-

Sided Printing

European Standard Sizes

North American Standard Sizes

A5 (148 x 210 mm, 5.8 x 8.3 in.)

A4(210 x 297 mm, 8.3 x 11.7 in.)

A4 Oversized (223 x 297 mm, 8.8 x 11.7 in.)
215x315(215x 315 mm, 8.5x12.4in.)
A3 (297 x 420 mm, 11.7 x 16.5in.)

B5 (176 x 250 mm, 6.9 x 9.8 in.)

B4 (250 x 353 mm, 9.8 x 13.9 in.)

Statement (140 x 216 mm, 5.5 x 8.5 in.)
Executive (184 x 267 mm, 7.25x 10.5 in.)
8x10 (203 x 254 mm, 8 x 10 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)
85x13(216 x330 mm, 8.5x13in.)
Legal (216 x 356 mm, 8.5 x 14 in.)
Ledger (432 x 279 mm, 17 x 11 in.)
Postcard (152 x 229 mm, 6 x 9 in.)

Supported Paper Types and Weights for Automatic 2-

Sided Printing

Trays Paper Types
Bond
Hole-Punched

Letterhead

Trays 1-4 of all configurations,
Bypass Tray, Tray 6

Plain
Pre-Printed
Recycled

Custom

Weights
60-105 g/m?

Lightweight Cardstock

106-169 g/m?

Supported Custom Paper Sizes

Tray Number Paper Sizes

Trays 1 and 2 in all configurations

Trays 3 and 4 in the 3-Tray Module

Minimum: 139.7 x 182 mm (5.5 x 8.3 in.)
Maximum: 297 x 432 mm (11.7 x 17 in.)

Bypass Tray

Minimum: 105 x 135 mm (4.25 x 5.3 in.)
Maximum: 297 x 432 mm (11.7 x 17 in.)

Envelope Tray

Minimum: 148 x 98 mm (5.8 x 3.9 in.)
Maximum: 241 x 162 mm (9.5 x 6.4 in.)

162  Xerox® VersalLink® B71XX Multifunction Printer

User Guide



Paper and Media

¢ Note: Trays 3 and 4 in the Tandem Tray Module and Tray 6 do not support custom paper sizes.
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Paper Tray Settings
Configuring Tray Settings

The system administrator can set Trays 1-4 of all configurations to Fully Adjustable mode or
Dedicated mode. When a paper tray is set to Fully Adjustable mode, you can change paper settings
each time that you load the tray. When a paper tray is set to Dedicated mode, the control panel
prompts you to load a specific paper size, type, and color.

¥ Note: To configure tray settings, log in as the system administrator. For details, refer to the
System Administrator Guide at www.xerox.com/office/VLB71XXdocs.

To configure the tray settings:
1. At the printer control panel, touch Device.
2. Touch Paper Trays, then select the required tray.
e To set the mode, touch Tray Mode, then select an option.

o To specify the paper settings for a dedicated tray, ensure that Tray Mode is set to Dedicated,
then set the paper size, type, and color.

o To configure the printer to select the tray automatically, touch the Auto Select toggle button.

o To set the priority for each tray, touch the Plus icon (+) or the Minus icon (-). The printer uses
paper from the Priority 1 tray first. If that tray is empty, the printer uses paper from the
Priority 2 tray.

Touch OK.

4, To return to the home screen, press the Home button.

Configuring Trays 3 and 4 of the Tandem Tray
Module

Trays 3 and 4 in the Tandem Tray Module are high-capacity paper trays. Configure Trays 3 and 4 to
support the paper in use.

If you are configuring the trays for the first time, configure them for the paper size that you need. If
you change the paper size, reconfigure the tray for the new paper size. For details on supported paper
sizes, refer to Supported Standard Paper Sizes.

To configure Trays 3 and 4 in the Tandem Tray Module:

¥ Note: Before you make any tray adjustments, compare the paper size to the current Tray 3 and
4 configurations. If the paper size matches the tray configuration, no tray adjustment is
needed.

1. Remove any paper from the tray.

2. Pinch the guide lock on the front paper guide, then slide the paper guide to the required paper
size.

3. To lock the paper guides into place, release the guide lock.

 Note: The paper guides lock into place only at the designated standard paper sizes.
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Configuring Tray 6

Tray 6 is a dedicated high-capacity feeder. You can configure Tray 6 to support the paper size that
you will use. For details on supported paper sizes, refer to Supported Standard Paper Sizes.

To configure Tray 6:

¥ Note: Before you make any tray adjustments, compare the paper size to the current Tray 6
configuration. If the paper size matches the tray configuration, no tray adjustment is needed.

1. Remove the screw that holds the spacer plate at the back of the tray.

2. Toremove the spacer plate, grasp the spacer plate and lift upward.

3. Place the tabs at the bottom of the spacer plate into the slots in the bottom of Tray 6 that
correspond with the paper size.
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4. Slide the top of the spacer plate down to engage the peg on the back of the tray into the
matching hole in the plate.

5. Install the screw to secure the spacer plate.

6. Repeat these steps for the spacer plate at the front of Tray 6.

7. On the top of the side gate, locate the pin.
8. Lift the pin, then guide it to the desired paper size in the slot.
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9. Release the pin to lock the side gate into place.
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Loading Paper
Loading Paper in Trays 1-4

You use the same method to load paper in Trays 1 and 2, and for Trays 3 and 4 when they are part of
the 3-Tray Module. For instructions on how to load paper in Trays 3 and 4 when they are part of the
Tandem Tray Module, refer to Loading Paper in Trays 3 and 4 of the Tandem Tray Module.

The system administrator can set Trays 1-4 to Fully Adjustable mode or Dedicated mode. Each time a
tray is opened and closed, the paper settings appear on the control panel.

e When trays are configured as Fully Adjustable, you can confirm or change the media settings. The
tray guides automatically detect the size of paper that is loaded.

e When trays are configured as Dedicated, the control panel displays the media settings for the
tray. A warning message appears on the control panel when the wrong media is loaded, or when
the tray guides are set incorrectly.

¥ Note: Only the system administrator can change the media settings for a Dedicated
tray. For details on configuring tray settings, refer to Configuring Tray Settings.

When the paper in the tray is in short supply, or when a tray is empty, a warning message appears on
the control panel.

To load paper in Trays 1-4:
1. Pull out the tray until it stops.

2. Remove any paper that is a different size or type.
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3. To move out the length or width paper guides, pinch the guide locks, then slide out the length or
width paper guides.

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.

This procedure separates any sheets that are stuck together and reduces the possibility of jams.

_/’ Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are
ready to use it.
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5. Load paper in the tray. Do one of the following:
e For long-edge feed:
e Insert letterhead and pre-printed paper face up with the top edge toward the back.
e Load hole-punched paper with the holes to the left.

e For short-edge feed:
e Insert letterhead and pre-printed paper face up with the top edge to the left.
e Load hole punched paper with the holes toward the front of the printer.

_fj Note: Do not load paper above the maximum fill line. Overfilling the tray can
cause paper jams.
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6. To adjust the length and width guides to fit the paper, pinch the guide locks, then slide the paper
guides in until they touch the paper.

7. Slide the tray back into the printer.

8. To change the settings to match the paper loaded in the tray, at the control panel, select the
correct options for paper size, type, and color.

9. To confirm the settings, touch OK.

To change the paper settings when the tray is set to Dedicated mode, refer to Configuring Tray
Settings.

Loading Paper in Trays 3 and 4 of the Tandem Tray
Module

The control panel displays a warning message when the paper in the tray is in short supply, or when a
tray is empty.

To change the paper size in Trays 3 and 4, refer to Configuring Trays 3 and 4 of the Tandem Tray
Module.

To load paper in Trays 3 and 4 of the Tandem Tray Module:
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1. Pull out the tray until it stops. Wait for the tray to lower and stop.

2. Fan the edges of the paper before loading it into the paper trays. This procedure separates any
sheets of paper that are stuck together and reduces the possibility of paper jams.

¢ Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until
necessary.

3. Stack the paper against the left-rear corner of the tray.
o Insert letterhead and pre-printed paper face up with the top edge toward the back.
e Load hole-punched paper with the holes to the left.

f Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.
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4. Slide the tray back into the printer.

5. To change the settings to match the loaded paper, at the control panel, select the correct options
for paper type and color.

6. To confirm the settings, touch OK.
To change the paper settings when the tray is set to Dedicated mode, refer to Configuring Tray

Settings.

Loading Paper in the Bypass Tray

The Bypass Tray supports the widest variety of media types. It is intended primarily for small-quantity
jobs that use special media.

To load paper in the bypass tray:

1. Open the bypass tray. If the bypass tray is loaded with paper already, remove any paper that is a
different size or type.

2. Pull out the extension tray for larger sizes.
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3. Move the width guides to the edges of the tray.

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.

_fg Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are
ready to use it.

174  Xerox® VersalLink® B71XX Multifunction Printer
User Guide



Paper and Media

5. Load the paper in the tray.
e For long-edge feed:

e For 1-sided printing, load letterhead or pre-printed paper face down with the top edge
toward the back. Load hole-punched paper with the holes to the right.

e For 2-sided printing, load letterhead or pre-printed paper face up with the top edge toward
the back. Load hole-punched paper with the holes to the left.

e For short-edge feed:

e For 1-sided printing, load letterhead or pre-printed paper face down with the top edge to
the right. Load hole-punched paper with the holes toward the front.
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e For 2-sided printing, load letterhead or pre-printed paper face up with the top edge to the
left. Load hole-punched paper with the holes toward the front.

_fg Note: Do not load paper above the maximum fill line on the width guides. Overfilling the
tray can cause the printer to jam.

6. Adjust the width guides until they touch the edges of the paper.

7. To change the settings to match the loaded paper, at the control panel, select the correct options
for paper size, type, and color.

8. To confirm the settings, touch OK.

Loading Paper in Tray 6

The control panel displays a warning message when the paper in the tray is in short supply, or when
the tray is empty.

To change the paper size in Tray 6, refer to Configuring Tray 6.

176 Xerox® VersalLink® B71XX Multifunction Printer
User Guide



Paper and Media

1. Pull out Tray 6 from the high-capacity feeder until it stops. Open the side gate until it stops.

2. Wait for the tray to lower and stop.

The control panel displays the paper tray settings. Ensure that you load the correct paper type
into the tray.

¢ Note: Do not load custom-size paper into Tray 6.

4. Fan the edges of the paper before loading it into the paper trays. This procedure separates any
sheets of paper that are stuck together and reduces the possibility of paper jams.

¢ Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until
necessary.

5. Load the paper against the right side of the tray.

e Place letterhead or pre-printed paper face up with the top edge toward the back of the tray.
e Place hole-punched paper with the holes toward the left side of the tray.

¢ Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.
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6. Close the side gate. Close Tray 6.
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Printing on Special Paper

To order paper or other media, contact your local reseller or visit www.xerox.com/office/
VLB71XXsupplies.

For reference:

www.xerox.com/rmlna

www.xerox.com/rmleu

Envelopes

You can print envelopes from the Bypass Tray. When the optional Envelope Tray is installed, you can
print envelopes from the Envelope Tray.

Guidelines for Printing Envelopes

Use only paper envelopes.
Do not use envelopes with windows or metal clasps.

Print quality depends on the quality and construction of the envelopes. If you do not get the
desired results, try another envelope brand.

Maintain constant temperatures and relative humidity.

Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect
print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or
during printing.

Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book
on top of the envelopes.

In the print driver software, select Envelope as the paper type.
Do not use padded envelopes. Use envelopes that lie flat on a surface.
Do not use envelopes with heat-activated glue.

Do not use envelopes with press-and-seal flaps.

Loading Envelopes in the Bypass Tray

1.

Open the bypass tray.
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2. Move the width guides to the edges of the tray.

_fg Note: If you do not load envelopes in the bypass tray right after they have been removed
from the packaging, they can bulge. To avoid jams, flatten the envelopes.

3. Load Number 10, C5, DL, or Monarch envelopes with flaps facing up and the long edge going into
the printer first.

_fg Note: For envelopes to print correctly, when you load envelopes with the flaps open, in the
print driver, set the orientation as needed. To flip the images, in the print driver, select
Rotate Image 180 Degrees.

4. If the control panel prompts you, verify the size, type and color on the screen. If you are not
prompted, change the paper settings.

a. At the printer control panel, press the Home button.
b. Touch Device > Paper Trays.
¢. Inthe Paper Trays menu, touch the bypass tray icon.

d. To select an envelope size, touch the current size setting, then select the required size.

¢ Note: When you select an envelope size, the paper type defaults to Envelope.
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e. To select an envelope color, touch the current paper color, then select an envelope color.
f. To save the settings, touch OK.

5. To return to the Home screen, press the Home button.

Loading the Envelope Tray

You can use the optional Envelope Tray in place of Tray 1. The Envelope Tray is a dedicated tray and
holds the following envelope sizes:

e Monarch and No.10

e DLandC5

To load the Envelope Tray:

1. Pull out the Envelope Tray until it stops.
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2. Load envelopes in the tray.
e For DL, Monarch, No. 10, and C5 envelopes with the flap on a long edge:
e Load envelopes face down with the flaps closed, and flaps toward the left.

e Adjust the paper guides so that they rest lightly against the edges of the envelopes.
Ensure that the maximum fill line is visible or that there are no more than 50 envelopes
loaded in the tray.

e For C5 envelopes with the flap on a short edge:
e Load envelopes face down with the flap closed, and flap toward the left.

e Adjust the paper guides so that they rest lightly against the edges of the envelopes.
Ensure that the maximum fill line is visible or that there are no more than 50 envelopes
loaded in the tray.

3. Close the tray.
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The control panel displays the Paper Settings.
e To select a new envelope size, touch Size.

e To select a new paper color, touch Color.
¢ Note: When you select an envelope size, the paper type defaults to Envelope.

To confirm the settings, touch Confirm.

Labels

You can print labels from any tray.

Guidelines for Printing Labels

Use labels designed for laser printing.

Do not use vinyl labels.

Do not feed a sheet of labels through the printer more than once.

Do not use dry gum labels.

Print only on one side of the sheet of labels. Use full-sheet labels only.

Store unused labels flat in their original packaging. Leave the label sheets inside the original
packaging until ready to use. Return any unused label sheets to the original packaging and reseal
it.

Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions.

Storing labels in extreme conditions can cause print-quality problems or cause labels to jam in the
printer.

Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and
jam in the printer.

In the print driver software, select Label as the paper type.

Before loading labels, remove all other paper from the tray.

& WARNING: Do not use any sheet where labels are missing, curled, or pulled away from the

backing sheet. It could damage the printer.

Loading Labels in Trays 1 and 2

1.

Pull out the tray until it stops.
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2. Ensure that the paper guides are set in the correct position for the size labels you are loading.

3. Remove any paper that is a different size or type.

4. To move out the length or width paper guide, release the guide lock, then slide out the length or
width paper guide.

5. Load labels in the tray.
e For long-edge feed, insert labels face up with the top edge toward the back.

e For short-edge feed, insert labels face up with the top edge to the left.

_fj Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.
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6. Adjust the length and width guides to fit the paper.

7. Slide the tray back into the printer.

8. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is
set to Labels.

j’ Note: To change the paper settings when the tray is set to Dedicated mode, refer to
Configuring Tray Settings.

To confirm the settings, touch OK.

10. To return to the Home screen, press the Home button.

Loading Labels in Trays 3 and 4

1. Pull out Tray 3 or Tray 4 until it stops. Wait for the tray to lower and stop.

¥ Note: Ensure that labels are the correct size for the tray. Do not load custom-size paper
into Trays 3 or 4.
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2. To load labels in the tray, insert labels face up with the top edge toward the back. Stack the labels
against the left-rear corner of the tray as shown.

w

Slide the tray back into the printer.

4. At the control panel, select the correct paper type and color. Ensure that the paper type is set to
Labels.

/’ Note: To change the paper settings when the tray is set to Dedicated mode, refer to
Configuring Tray Settings.

bl

To confirm the settings, touch OK.

o

To return to the Home screen, press the Home button.

Loading Labels in the Bypass Tray

1. Open the bypass tray, then for larger sizes of paper, pull out the extension tray. Remove any
paper that is a different size or type.
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2. Move the width guides to the edges of the tray.

3. Load labels in the tray.
e For long-edge feed, load labels face down with the top edge toward the back of the printer.

e For short-edge feed, load labels face down with the top edge to the right.

_fg Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

4. Adjust the width guides until they touch the edges of the paper.
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5. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is
set to Labels.

/’ Note: To change the paper settings when the tray is set to Dedicated mode, refer to
Configuring Tray Settings.

6. To confirm the settings, touch OK.

7. To return to the Home screen, press the Home button.

Loading Labels in Tray 6

1. Pull out Tray 6 from the high-capacity feeder until it stops. Open the side gate until it stops.

2. Wait for the tray to lower and stop.

¥ Note: Ensure that labels are the correct size for the tray. Do not load custom-size paper
into Tray 6.

3. Toload labels in the tray, insert labels face up with the top edge toward the back. Stack the labels
against the right side of the tray as shown.

/’ Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

4, Close the tray door.
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At the control panel, select the correct paper type and color. Ensure that the paper type is set to
Labels.

/’ Note: To change the paper settings when the tray is set to Dedicated mode, refer to
Configuring Tray Settings.

To confirm the settings, touch OK.

To return to the Home screen, press the Home button.
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General Precautions

WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are
open.

& WARNING: Keep all cleaning materials out of the reach of children.

& WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized
sprays contain explosive mixtures and are not suitable for use in electrical applications. Use of
pressurized spray cleaners increases the risk of fire and explosion.

A WARNING: Do not remove the covers or guards that are fastened with screws. You cannot
maintain or service any parts that are behind these covers and guards. Do not attempt any
maintenance procedure that is not described in the documentation supplied with your printer.

(T Caution: When cleaning your printer do not use organic or strong chemical solvents or aerosol

~*’ cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as
directed in this documentation.

(D Caution: Do not place anything on top of the printer.

(T Caution: Do not open covers and doors during printing. Do not leave the covers and doors open

~* for any length of time, especially in well-lighted places. Light exposure can damage the drum
cartridges.

(ﬂ Caution: Do not tilt the printer while it is in use.
./

(ﬂ Caution: Do not touch the electrical contacts or gears. Doing so could damage the printer and
* cause the print quality to deteriorate.

(@ Caution: Ensure that any parts removed during cleaning are replaced before you plug in the
* printer.
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Cleaning the Printer

Cleaning the Exterior

Clean the exterior of the printer once a month.
e Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth.
e After cleaning, wipe with a dry, soft cloth.

e For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain
off.

(D Caution: Do not spray detergent directly on the printer. Liquid detergent could enter the printer
through a gap and cause problems. Never use cleaning agents other than water or mild
detergent.

Cleaning the Scanner

To ensure optimum print quality, clean the document glass regularly. Cleaning helps avoid output
with streaks, smears, and other marks that transfer from the glass while scanning documents.

1. Slightly dampen a soft, lint-free cloth with water.

2. Remove any paper or other media from the output tray.

3. Open the document cover.

4. Wipe the surfaces of the document glass and CVT glass until they are clean and dry.

j’ Note: For best results, to remove marks and streaks, use Xerox® Glass Cleaner.

5. Wipe the white underside of the document cover until it is clean and dry.

6. Close the document cover.
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Cleaning the Second-Side Scanning Lens Assembly

The second-side scanning lens assembly allows you to make 2-sided scans and copies with a single
pass of the original document. The assembly is on the left side of the document cover and includes a
mirrored glass strip, a metal strip, a white-plastic strip, and rollers.

¢ Note: It is recommended that you clean all parts of the second-side scanning lens assembly
regularly.

Follow the below steps to clean the second-side scanning lens assembly

1. To access the second-side scanning lens assembly, do the following:

a. On the left side of the document cover, lower the lever.

b. Separate the left end of the document cover from the lens assembly, and continue to lower
the lever.

2. Using a soft, lint-free cloth moistened with water, wipe the mirrored glass, metal strip, both sides
of the white-plastic strip, and the rollers. If dirt is difficult to remove, moisten the cloth with a
small amount of neutral detergent, then wipe the parts dry with a dry, soft cloth.

(T Caution: To prevent damage to the film around the mirrored glass, do not press heavily on
~*’" the mirrored glass.

3. Return the document cover to the original position, and ensure that the lever is locked in place. If
you touch the document cover, before you close the document feeder, clean the cover.
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Cleaning the Duplex Automatic Document Feeder Rollers
Ensure that you clean the Duplex Automatic Document Feeder Rollers when you clean the scanner.

1. Lift the lever, then open the top cover of the document feeder.

2. With a clean, lint-free cloth that is moistened with water, wipe the feed rollers until they are
clean.

3. Close the document feeder top cover.

Cleaning the Interior

Clean the interior of the printer regularly to prevent stains inside the printer that can deteriorate print
quality. Clean the printer interior whenever you replace a drum cartridge.

After clearing paper jams or replacing a toner cartridge, inspect inside the printer before closing the
printer covers and doors.

e Remove any remaining pieces of paper or debris. For details, refer to Clearing Paper Jams.
e Remove any dust or stains with a clean, dry, lint-free cloth.

& WARNING: Never touch a caution-labeled area in the fuser. You can get burned. If a sheet of
paper is wrapped around the inside of the fuser, do not try to remove it immediately. Power off
the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the paper jam
after the printer has cooled. If the error persists, contact your Xerox representative.

Cleaning the Printhead Lens

The print head LED lens requires regular cleaning to maintain print quality. Clean the print head LED
lens every time the drum cartridge is replaced or if print quality starts to degrade.

(@ Caution: Do not perform this procedure when the printer is copying or printing.

1. Remove, then replace the drum cartridge. Refer to the installation instructions that area included
with the new drum cartridge.
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2. Open the front door of the printer.

3. Remove the print head LED lens-cleaning rod from inside the front door.

4. Slowly push the cleaning rod into the printer until it stops, then pull it out. Repeat this action two
more times.
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5. Return the cleaning rod to its original location.

6. Close the printer front cover.
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Adjustments and Maintenance Procedures

Adjusting Paper Registration

Use Adjust Paper Registration to adjust the placement of the printed image on the page. The
adjustment allows you to place the top, bottom, left, and right margins exactly where you want. You
can specify the image position on both the front and back sides of the paper, for each installed paper
tray.

Verifying Paper Registration
1. At the printer control panel, press the Home button.

2. Log in as administrator. For details, refer to the System Administrator Guide at www.xerox.com/
office/VLB71XXdocs.

3. Touch Device > Support > Image Position.
4. Select the source paper tray for the registration print.
a. Touch Paper Supply.
b. Touch the desired tray.
5. If your printer has automatic 2-sided printing, select the sides that you want to optimize.

e To select a sample registration page for adjusting side 1, touch Adjusted Side, then touch
Side 1.

e To select a sample registration page for adjusting both sides, touch Adjusted Side, then touch
Side 2.

6. Specify the consecutive number of sample pages to print.
a. Touch Print Settings.

b. To increase or decrease the number of sample pages, for Quantity, touch the Plus icon (+) or
the Minus icon (-), then touch OK.

7. To print the sample pages, touch Print Sample.

8. When printing is completed, touch Close.
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9. On the sample pages, for Side 1, use a ruler to measure the distance of the printed image from

the top, bottom, left, and right edges.

¥ Note: For identification, a single dot is printed on Side 1, and two dots are printed on
Side 2.

$ \

10. For Side 2, measure the distance of the printed image from the top, bottom, left, and right edges.

11.If the image is centered, no adjustment is required. If the image is not centered, adjust the paper

registration. For more information, refer to Performing a Paper Registration Adjustment.

Performing a Paper Registration Adjustment

1.
2.

At the control panel, press the Home button.

Log in as administrator. For details, refer to the System Administrator Guide at www.xerox.com/
office/VLB71XXdocs.

3. Touch Device > Support > Image Position.

To adjust registration, select the source paper tray.

a. Touch Paper Supply.

b. Touch the desired tray.

Using the chart printed in Verifying Paper Registration, select the side for registration.
a. For adjusting Side 1, touch Adjusted Side, then touch Side 1.

b. For adjusting Side 2, touch Adjusted Side, then touch Side 2.

To adjust the registration, touch Lead/Side Registration.

a. To adjust the side-to-side registration, for Side Registration, touch the Plus icon (+) or the
Minus icon (-).

b. To adjust the top-to-bottom registration, for Lead Registration, touch the Plus icon (+) or the
Minus icon (-).

For reference, position the chart so that Side-1 or Side-2 dots are at the bottom of the page.
e For Lead Registration, a positive value shifts the image down the page.

e For Side Registration, a positive value shifts the image to the left.
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v

7. To save your settings, touch OK.

8. As needed, to enter additional values, repeat the previous steps.

9. Print another sample page, then repeat the process until you complete the registration

corrections.

10. To return to the Home screen, press the Home button.

Adjusting the Altitude

Use Adjust Altitude to adjust the altitude to match that of the location where the printer is installed.
If the altitude setting is incorrect, it can cause print-quality problems.

To adjust the altitude:

1.

2
3.
4

At the printer control panel, press the Home button.
Touch Device > Support > Altitude Adjustment.
Touch the altitude of the location of the printer, then touch OK.

To return to the Home screen, press the Home button.
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Supplies

Consumables

Consumable supplies are printer supplies that become depleted during the operation of the printer.
Consumable supplies for this printer include the following:

e Genuine Xerox® Black Toner Cartridge
e Staple Cartridges for the following finishers:
— The optional Integrated Office Finisher
— The optional Office Finisher
e Staple Cartridges for optional Office Finisher with Booklet Maker

e Each consumable includes installation instructions. To replace consumables, refer to the
instructions included with the consumable supply.

e Only install new cartridges in your printer. If a used toner cartridge is installed, then the toner
remaining amount displayed can be inaccurate.

e To ensure print quality, the toner cartridge is designed to cease functioning at a predetermined
point.

(T Caution: Use of toner other than genuine Xerox® Toner can affect print quality and printer
7 reliability. Xerox® Toner is the only toner designed and manufactured under strict quality
controls by Xerox for specific use with this printer.

Ordering Supplies

When to Order Supplies

A warning appears on the control panel when supplies near their replacement time. Verify that you
have replacements on hand. It is important to order these items when the messages first appear to
avoid interruptions to your printing. An error message appears on the control panel when supplies
must be replaced.

Order supplies from your local reseller or go to www.xerox.com/office/VLB71XXsupplies.

(ﬂ Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service
*” Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies
not specified for this printer. The Total Satisfaction Guarantee is available in the United States
and Canada. Coverage could vary outside these areas. Please contact your Xerox representative
for details.

Supply Status

You can check the status and percentage of life remaining for your printer supplies at the control
panel or from the Embedded Web Server. When printer supplies near their replacement time, warning
alerts appear on the control panel. You can customize the alerts that appear on the control panel and
configure email alert notifications.
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To check the supplies status and set up alerts using the Embedded Web Server, refer to the System
Administrator Guide at www.xerox.com/office/VLB71XXdocs.

Checking the Supplies Status at the Control Panel

1. To view status information for the printer supplies, touch Device > Supplies.

2. To view details about a specific item, including part numbers for reordering, touch the specific
item.

3. To return to the Supplies screen, touch X.

4,  To return to the Device screen, touch the back arrow.

Customizing Supplies Alert Settings
1. To customize the alerts that appear for printer supplies, touch Device > Supplies > Alerts Setup.
2. To enable supplies alerts that appear on the control panel, touch the Enable Alerts toggle button.

3. To configure the printer to display an alert when an item reaches a specific usage percentage
level, touch the item, then select the percentage.

4. To customize the alerts for each supply item, or to enable or disable an alert, touch the toggle
button.

5. To return to the Supplies screen, touch X.

6. To return to the Device screen, touch the back arrow.

Setting Up Email Alerts

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System
Administrator Guide at www.xerox.com/office/VLB71XXdocs.

1. To set up alerts to send to an email address, touch Device > Supplies > Email Alerts.
2. To enter an email address, touch Add Email, then touch Enter Email Address.

3. Use the touch screen keyboard to enter an email address, or select an entry from the Address
Book, then touch OK.

4. Add more email addresses if necessary.

To customize the alerts for each supply item, or to enable or disable an alert, touch the toggle
button.

To exit the menu, touch OK.

To return to the Device screen, touch the back arrow.

Supplies Usage Report

The Supplies Usage Report provides coverage information and part numbers for reordering supplies.
The date a supply item was installed appears on the report.

To print the Supplies Usage Report:
1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.

3. Touch Supplies Usage Report.
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4, To return to the Home screen, press the Home button.

Recycling Supplies

For more information on the Xerox® supplies recycling program, go to www.xerox.com/gwa.

Toner Cartridges

General Precautions

WARNING: When replacing a toner cartridge, be careful not to spill the toner. If any toner spills,
avoid contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.

& WARNING: Keep toner cartridges out of the reach of children. If a child accidentally swallows
toner, have the child spit out the toner, and rinse the mouth with water. Consult a physician
immediately.

A WARNING: Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove
spills. Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large
volume of toner, contact your local Xerox representative.

A WARNING: Never throw a toner cartridge into an open flame. Remaining toner in the cartridge
can catch fire and cause burn injuries or an explosion.

Replacing a Toner Cartridge

A message appears on the control panel when a toner cartridge must be replaced.

j’ Note: Each toner cartridge includes installation instructions.

Printer Status Message Cause and Solution

Reorder Toner The toner cartridge is low. Order a new toner
cartridge.

Out of Toner The toner cartridge is empty. Replace the toner
cartridge with a new one.
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Routine Maintenance Items

Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.

j’ Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:
e Black Drum Cartridge

e Waste Toner Container

¢ Hole-Punch Waste Container

e Staple Cartridge

e Booklet Staple Cartridge

Replacing the Drum Cartridge

& WARNING: Never throw drum cartridges into an open flame.

A WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get
burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it
immediately. Turn off the printer immediately and wait 40 minutes for the fuser to cool. Try to
remove the jam after the printer has cooled.

@ Caution: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent
lighting. Do not touch or scratch the surface of the drum.

When a drum cartridge requires replacement, a message appears on the control panel.

j’ Note: Each drum cartridge includes installation instructions.

Printer Status Message Cause and Solution

Reorder Drum Cartridge The drum cartridge is nearing the end of its life.
Order a new drum cartridge.

Replace Drum Cartridge The drum cartridge has reached the end of its life.
Replace the drum cartridge with a new one.

Replacing Staples in the Integrated Office Finisher

If the printer has an optional finisher installed, the control panel displays a message when a staple
cartridge is empty and needs replacement. Locate then use the procedure for the finisher installed on
your printer.

@ Caution: Do not perform this procedure while the printer is printing.
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1. Open the finisher front door.

2. Toremove the staple cartridge, grasp the orange handle, then pull it firmly toward you.

3. Check inside the finisher for any loose staples and remove them.

4, Pinch both sides of the staple pack and remove the staple pack from the cartridge.

5. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into
the cartridge.
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6. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler
until it clicks.

7. Close the finisher front door.

Replacing Staples in the Main Stapler of the Office
Finisher

i!/‘ Caution: Do not perform this procedure while the printer is printing.

1. Open the finisher front door.

2. Reach into the finisher cabinet and pull the stapler toward you until it stops.
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3. Push the stapler assembly to the right, as shown.

4. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you.

5. Pinch both sides of the staple pack and remove the staple pack from the cartridge.

6. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into
the cartridge.
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7. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler
assembly until it clicks.

8. Close the finisher front door.

Replacing Staples in the Booklet Maker of the Office
Finisher

(1) Caution: Do not perform this procedure while the printer is printing.

1. Open the booklet maker side cover.

2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening
and slide the panels to the center.
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3. Hold the tabs on both sides of the staple cartridge and pull the cartridge out of the finisher.

4. Hold the tabs on both sides of the new staple cartridge and insert the cartridge into the original
position in the finisher.

® Note: If you have trouble inserting the cartridge, ensure that the staples are positioned
correctly in the cartridge.

_fj Note: The booklet maker uses two staple cartridges. Booklet stapling requires that both
staple cartridges contain staples.

5. Repeat the procedure for the other staple cartridge.

6. Close the booklet maker side cover.
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Replacing Staples in the Convenience Stapler

1. To open the stapler head, rotate the stapler head 180 degrees counterclockwise.

2. Grip the staple cartridge and pull it out of the stapler head.

3. Unpack the new staple cartridge. Remove any partial strips and any staple strips that are not flat.

4, Install the new staple cartridge in the stapler head. The staple cartridge clicks into place.
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5. To close the stapler head, rotate the stapler head 180 degrees clockwise.

Emptying the Hole Punch Waste Container

When the hole punch waste container is full, a message appears on the control panel.

Emptying the Hole Punch Waste Container in the Office Finisher
(@ Caution: Do not perform this procedure while the printer is printing.

1. Lift the finisher transport top cover.

2. Pull out the hole-punch waste container.
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3. Empty the container.

4. Insert the container all the way into the finisher.

5. Close the finisher transport top cover.
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Managing the Printer
Viewing the Meter Reading

The Billing/Usage menu displays the total number of impressions that the printer generated or
printed during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of
paper. For example, a sheet of paper that is printed on two sides counts as two impressions.

 Note: If you provide regular billing information for your device, you can use the Remote

' Services Upload feature to simplify the process. You can enable Remote Services to send billing
meter readings to Xerox automatically so that you do not have to collect the readings
manually. For more information, refer to the System Administrator Guide at www.xerox.com/
office/VLB71XXdocs.

To view the billing information for your printer:

1. At the printer control panel, press the Home button.

2. Touch Device > Billing/Usage.

3. To view more details, touch Usage Counters, then select an option.
4

After viewing the usage readings, to return to the Home screen, press the Home button.

Printing the Billing Summary Report

The Billing Summary Report provides information about the device and a detailed listing of the billing
meters and sheet counts.

To print the Billing Summary Report:

1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.

3. Touch Billing Summary Report.
4

To return to the Home screen, press the Home button.
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Moving the Printer

Before you move the printer:
e Ensure that you always power off the printer, and wait for it to shut down completely.
e Ensure that no jobs are in the print queue.

e Disconnect the power cord and other cables from the back of the printer.

& WARNING: To prevent electric shock, never touch the power plug with wet hands. When
removing the power cord, ensure that you pull the plug and not the cord. Pulling the cord can
damage it, which can lead to fire or electric shock.

o e When moving the printer, do not tilt it more than 10 degrees in any direction. Tilting the
g Note: printer more than 10 degrees can cause toner spillage.
e When moving the printer over a long distance, remove the drum cartridge and toner
cartridge to prevent toner from spilling.

(D Caution: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent
lighting. Do not touch or scratch the surface of the drum.

(T Caution: Failure to repackage the printer properly for shipment can result in damage not

~*’ covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The
Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover damage to
the printer caused by improper moving.

After moving the printer:
1. Reinstall any parts that you removed.
2. Reconnect the printer to the cables and power cord.

3. Plug in and power on the printer.

214 Xerox® VersalLink® B71XX Multifunction Printer
User Guide



Troubleshooting

This chapter contains:

General TroubleshOOtiNg ......ooiiiiii et eeeeeeee s 216
20T oT<] i Lo Ty o - 221
Clearing FINiSher JAMS ...oooiiiiiiiiieeeeee et e e e e e eeeeeeeeees 233
(@Yo Ty T To I oo (S Lo T o - 236
Clearing Hole Punch Jams in the Office FiNISher .......cccoooiiiiiereeeeee e 242
Print-QuUAlity ProblEMS. ......ueiiiiiiiiiiiiiiiiii ettt e e e e e ee e e e e e e e e e e eeeeeeeeeeeeeasssassnnsnnnnnnnnnnnnnnnns 243
(@oT0) VAo aTe BTl g T =/ (o] o] (=T o TP 248
FOX PrODIEMIS. ...ttt et e e e e e ettt e e e e e et eeeeeeaennnneees 249
(CT=YudTaTe [l o =1 o PP 251

Xerox® VersalLink® B71XX Multifunction Printer 215
User Guide



Troubleshooting

General Troubleshooting

This section contains procedures to help you locate and resolve problems. Resolve some problems by
simply restarting the printer.

Printer Does Not Power On

Probable Causes Solutions

The power switch is not switched on.

Open the front door, then and check that the
power switch is in the On position.

At the printer control panel, press the Power/
Wake button. For details, refer to Powering On the
Printer.

The power cord is not plugged into the outlet
correctly.

Power off the printer, then plug the power cord into
the outlet securely. Use the bracket provided with the
printer to secure the power cord in place.

The power cord is not secured in place correctly.

Use the bracket provided with the printer to secure
the power cord in place.

Something is wrong with the outlet connected to the
printer.

Plug another electrical appliance into the outlet
and check if it operates properly.
Try a different outlet.

The printer is connected to an outlet with a voltage
or frequency that does not match the printer
specifications.

Use a power source with the specifications listed in
the Electrical Specifications.

@ Caution: Plug the three-wire cord with grounding prong directly into a grounded AC outlet.

Printer Resets or Powers Off Frequently

Probable Causes Solutions

The power cord is not plugged into the outlet
correctly.

Power off the printer, confirm that the power cord is
plugged in correctly to the printer and the outlet,
then power on the printer.

The power cord is not secured in place correctly.

Use the bracket provided with the printer to secure
the power cord in place.

A system error occurred.

Power off the printer, then power on again. Print the
Error History Report. For details, refer to Printing the
Error History Report. If the error persists, contact your
Xerox representative.

The printer is connected to an uninterruptible power
supply.

Power off the printer, then connect the power cord to
a suitable outlet.

The printer is connected to a power strip shared with
other high-power devices.

Plug the printer directly into the outlet or into a
power strip that is not shared with other devices.
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Printer Does Not Print

Probable Causes Solutions

The printer is in Power Saver mode. On the control panel, press the Power/Wake button.

The printer has an error. If the Status LED is blinking amber, follow the
instructions on the control panel to clear the error. If
the error persists, contact your Xerox representative.

The printer is out of paper. Load paper into the tray.
A toner cartridge is empty. Replace the empty toner cartridge.
The drum cartridge has reached end of life. Replace the drum cartridge.

Note: In some cases, it is possible for the printer to
continue printing temporarily with the Drum
Cartridge Past End of Life message displayed.

The toner waste container is full. Replace the toner waste container.

No control panel indicators are lit. Power off the printer, confirm that the power cord is
plugged in correctly to the printer and the outlet,
then power on the printer. If the error persists,
contact your Xerox representative.

The printer is busy. If the Status LED is flashing blue, a previous print job
could be the problem.

1. At your computer, use the printer properties to
delete all print jobs in the print queue.

2. At the control panel, touch Jobs, then delete all
pending print jobs.

Load the paper in the tray.

If the Status LED does not flash once after you send
a print job, check the connection between the printer

and the computer. Power off the printer, then turn it
on again.

The printer cable is disconnected. If the Status LED does not flash once after you send
a print job, check the connection between the printer
and the computer.
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Probable Causes Solutions

There is a network-connectivity issue. If the printer is connected to a network:

1. Verify that the Ethernet cable is connected to the
printer.

2. On the printer Ethernet connector, verify that the
green LED is On. If not, reseat both ends of the
Ethernet cable.

3. Examine the TCP/IP address in the Communication
section of the Configuration Report. For details, refer
to Printing the Configuration Report.

4. If the TCP/IP address is 0.0.0.0, the printer needs
more time to acquire an IP address from the DHCP
server. Wait 2 minutes, then print the Configuration
Report again.

5. If the TCP/IP address is unchanged, or begins with
169, contact your network administrator.

There is a wireless network setup or connectivity Verify that the Wireless Network Adapter is installed
issue. and properly configured. For details, refer to
Connecting to a Wireless Network.

Printing Takes Too Long

Probable Causes Solutions

The printer is set to a slower printing mode. For It takes more time to print on certain types of special
example, the printer is set to print on Heavyweight paper. Ensure that the paper type is set properly in
paper or Envelopes. the print driver and at the printer control panel. For

details, refer to Print Speed.

The printer is in Power Saver mode. It takes time for printing to start when the printer is
coming out of Power Saver mode.

The way the printer was installed on the network Determine if a print spooler or a computer sharing

could be an issue. the printer is buffering all print jobs and then

spooling them to the printer. Spooling can slow print
speeds. To test the speed of the printer, print some
information pages such as the Demonstration Print.
For details, refer to Information Pages. If the page
prints at the rated speed of the printer, there could
be a network or printer installation issue. For more
help, contact the system administrator.

The job is complex. Wait. No action needed.
The print-quality mode in the driver is set to Change the print-quality mode in the print driver to
Enhanced. Standard.
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Document Prints from Wrong Tray

Probable Causes Solutions

Application and print driver have conflicting tray 1 Check the tray selected in the print driver.

selections. 2 Access the page setup or printer settings of the
application from which you are printing.

3 Set the paper source to match the tray selected in
the print driver or set the paper source to
Automatically Select.

4 Check that you have the latest print driver
installed. For details, go to www.xerox.com/office/
VLB71XXsupport.

® Note: To have the print driver select the tray,
set the tray used as the paper source to Auto
Selection Enabled.

Automatic 2-Sided Printing Problems

Probable Causes Solutions

Unsupported or incorrect paper. Ensure that you are using the correct paper. Do not
use transparencies, envelopes, labels, or reloaded
paper for automatic 2-sided printing. For details, see
Supported Standard Paper Sizes for Automatic 2-
Sided Printing.

Incorrect setting. On the print driver Printing Options tab, select 2-
sided Printing.

Printer is Making Unusual Noises

Probable Causes Solutions

There is an obstruction or debris inside the printer. Power off the printer and remove the obstruction or
debris. If you cannot remove it, contact your Xerox
representative.

Paper Tray Does Not Close

Probable Causes Solutions

The paper tray does not close fully. Some debris or an object is blocking the tray. Power
off the printer, then remove the obstruction or debris.
If you cannot remove it, contact your Xerox
representative.
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Condensation has Formed Inside the Printer

Moisture can condense inside a printer where the humidity is above 85 % or when a cold printer is
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room
that is heated quickly.

Probable Causes Solutions

The printer has been sitting in a cold room. Allow the printer to operate for several hours at room
temperature.
The relative humidity of the room is too high. e Reduce the humidity in the room.

e Move the printer to a location where the
temperature and relative humidity are within the
operating specifications.
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Paper Jams

Locating Paper Jams

& WARNING: Never touch a caution-labeled area in the fuser. You can get burned. If a sheet of
paper is wrapped around the inside of the fuser, do not try to remove it immediately. Power off
the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after
the printer has cooled. If the error persists, contact your Xerox representative.

(T Caution: Do not attempt to clear any paper jams using tools or instruments. This can

~ permanently damage the printer.

The following illustration shows where paper jams can occur along the paper path:

Paper Tray Feed Area - Door B
Bypass Tray
Fuser Area - Door A

Paper Output Area - Door C

v &N =

Duplex Automatic Document Feeder
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6. Document Feeder Output Tray

7. Finisher Areas

8. Paper Trays 1-4

Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox-supported paper. Other
paper types can cause jams. If supported paper is jamming frequently in one areaq, clean that area of
the paper path.

The following can cause paper jams:

Selecting the incorrect paper type in the print driver
Using damaged paper

Using unsupported paper

Loading paper incorrectly

Overfilling the tray

Adjusting the paper guides improperly

Most jams can be prevented by following a simple set of rules:

Use only supported paper. For more information, refer to Supported Paper.
Follow proper paper handling and loading techniques.

Always use clean, undamaged paper.

Avoid paper that is curled, torn, moist, creased, or folded.

To separate the sheets before loading into the tray, fan the paper.

Do not load paper above the maximum fill line.

After loading paper in the trays, adjust the paper guides in all trays. A guide that is not properly
adjusted can cause poor print quality, misfeeds, skewed prints, and printer damage.

After loading paper in the trays, at the control panel, select the correct paper type and size.
Before printing, select the correct paper type and size in the print driver.

Store paper in a dry location.

The following can cause paper jams:

Polyester-coated paper that is designed especially for inkjet printers

Paper that is folded, wrinkled, or excessively curled

Loading more than one type, size, or weight of paper in a tray at the same time
Loading paper above the maximum fill line in the paper tray

Allowing the output tray to become overfilled

For a detailed list of supported paper, refer to Supported Paper.
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Clearing Paper Jams

Clearing Jams in the Document Feeder

To resolve the error that appears on the control panel, remove all paper from the Duplex Automatic
Document Feeder areas.

1. Lift the lever, and open the top cover of the document feeder.

2. If the original document is not caught in the entry to the document feeder, pull the document
straight out in the direction shown.

3. Close the top cover. To close the top cover, press it down until it clicks into place.

4, If the document is not visible when the top cover is opened, lift the document feeder. Remove
any original document from the document glass.
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5. To access the second-side scanning lens assembly, on the left side of the document cover, lower
the lever. Remove the original document in the direction shown.

6. If the original document is not visible when the document feeder is opened, close the document
feeder. Lift the document feeder tray, then remove the jammed paper.

Lower the document feeder tray.

If the original document is not wrinkled or torn, load document into the feeder again, following
the instructions on the control panel.

9. After clearing a paper jam from the Duplex Automatic Document Feeder, reload the entire
original document, including the pages already scanned. The printer automatically skips the
scanned pages and scans the remaining pages.

(T Caution: Torn, wrinkled, or folded original documents can cause jams and damage the
=’ printer. To copy torn, wrinkled, or folded original documents, use the document glass.

Clearing Paper Jams from Trays 1-4
To resolve the error that appears on the control panel, clear all paper from the paper path.

1. Before removing the tray from the printer, review the paper jam message on the control panel. If
another jam error appears, clear that jam inside the printer first.
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2. Pull out the tray until it stops.

3. Remove the paper from the tray.

4, If the paper is torn, remove the tray completely and check inside the printer for torn pieces of
paper.
Reload the tray with undamaged paper, then push the tray in until it stops.

6. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper
settings.

e To confirm the same paper size, type, or color, touch OK.

e To select a new paper size, type, or color, touch the current setting, then select a new setting.
When finished, touch OK.

7. To return to the Home screen, press the Home button.

Clearing Paper Jams from the Bypass Tray

To resolve the error that appears on the control panel, clear all paper from the paper path.
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1. Remove the jammed paper from the tray. Ensure that the paper feed entrance where the tray
connects to the printer is clear.

If the paper is torn, check inside the printer for torn pieces of paper.
Fan the paper that you removed and ensure that all four corners align neatly.

Insert the paper into the Bypass Tray with the print side face down. Ensure that the leading edge
of the paper lightly touches the paper-feed entrance.

5. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper
settings.

e To confirm the same paper size, type, or color, touch OK.

e To select a new paper size, type or color, touch the current setting, then select a new setting.
When finished, touch OK.

6. To return to the Home screen, press the Home button.

Clearing Paper Jams at Doors A, B and C

To resolve the error that appears on the control panel, clear all paper from the paper path.

Clearing Jams at Door A
1. Open the Bypass Tray and Door A.

& WARNING: The area around the Fuser can be hot. Use caution to avoid injury.

(ﬂ Caution: Do not touch the transfer roller. Touching the roller can reduce image quality.
./

a. Open the Bypass Tray.

b. Lift the release lever.
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c. Open Door A.

2. Remove the jammed paper.

3. If paperis jammed at the exit to the output tray, to remove it, carefully pull it straight out in the
direction shown.

_fg Note: Toner can adhere to the transfer roller. This does not affect print quality.

4, If paper is jammed in the Fuser, remove the paper from areas A1 and A2 as shown.

¢ Note:If the paper is torn, remove all torn pieces from the printer.
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5. Close Door A and the Bypass Tray.
a. To close Door A, push the door up firmly until it clicks into place.

b. Close the Bypass Tray.

Clearing Jams at Door B

1. Pull the release lever, then open Door B.

2. Remove the jammed paper from the paper tray feed area.

¢ Note:If the paper is torn, remove all torn pieces from the printer.

3. For paper jammed in the upper position, look inside the printer, locate the paper, then remove it.

¢ Note: If the paper is inaccessible, refer to Clearing Jams at Door A.
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4. For paper jammed in the tray feed roller, open the tray, then remove the paper.

5. Close Door B.

Clearing Jams at Door C
1. Open the Bypass Tray, lift the release lever, then open Door A.

& WARNING: The area around the Fuser can be hot. Use caution to avoid injury.

(T Caution: Do not touch the transfer roller. Touching the roller can reduce image quality.
e

2. At Door G, lift the release lever, then open Door C.
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3. Remove any jammed paper in the paper output area.

¢ Note: If the paper is torn, remove all torn pieces from the printer.

4. To close Door C, push the door up firmly until it clicks into place.

5. To close Door A, push the door up firmly until it clicks into place, then close the Bypass Tray.

Troubleshooting Paper Jams

Multiple Sheets Pulled Together

Probable Causes Solutions

The paper tray is too full. Remove some of the paper. Do not load paper above the maximum
fill line.

The edges of the paper are not even. Remove the paper, align the edges, and then reload the paper.

The paper is moist from humidity. Remove the paper from the paper tray. Load new, dry paper into
the tray.

Too much static electricity is present. Load a new ream of paper.

Using unsupported paper. Use only Xerox®-approved paper. For details, refer to Supported
Paper.
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Probable Causes Solutions

Humidity is too high for coated paper. | o

Feed paper one sheet at a time.
e Try loading paper in the Bypass tray.

The feed rollers are dirty.

With a clean, lint-free cloth moistened with water, wipe the feed
rollers until they are clean. For details, refer to Cleaning the Printer.

Tray is loaded with mixed paper.

Load the tray with only one type and size of paper.

Paper Misfeeds

Probable Causes Solutions

The paper is not correctly positioned in the tray.

Remove the misfed paper and reposition it properly
in the tray.

Adjust the paper guides in the tray to match the size
of the paper.

The paper tray is too full.

Remove some of the paper. Do not load paper past
the fill line.

The paper guides are not correctly adjusted to the
paper size.

Adjust the paper guides in the tray to match the size
of the paper.

The tray contains warped or wrinkled paper.

Remove the paper, smooth it out, and reload it. If it
still misfeeds, do not use that paper.

The paper is moist from humidity.

Remove the moist paper and replace it with new, dry
paper.

Using paper of the wrong size, thickness, or type.

Use only Xerox approved paper. For details, refer to
Supported Paper

The feed rollers are dirty.

With a clean, lint-free cloth moistened with water,
wipe the feed rollers until they are clean. For details,
refer to Cleaning the Printer.

Label and Envelope Misfeeds

Probable Causes

Solutions

The label sheet is facing the wrong way in the tray.

e Load label sheets according to the instructions
from the manufacturer.

e Load labels in the tray, face up.

For details, refer to Labels.

Labels are missing, curled, or pulled away from the
backing sheet.

Do not use any sheet where labels are missing,
curled, or pulled away from the backing sheet.
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Probable Causes

Envelopes are loaded incorrectly.

Solutions

You can print envelopes from the Bypass tray or Tray
1.

For details, refer to Envelopes.

Envelopes are wrinkling.

e The heat and pressure of the laser printing
process can cause wrinkling.

e Use supported envelopes. For details, refer to
Guidelines for Printing Envelopes.

j’ Note: When you load envelopes long-edge
: feed, ensure that you specify landscape
orientation in the print driver.

Paper Jam Message Stays On

Probable Causes

Paper remains jammed in the printer or finisher.

Solutions

Recheck the paper path and ensure that you have
removed all of the jammed paper from the printer
and finisher areas.

One of the printer doors is open.

Check the doors on the printer. Close any door that is
open.

‘&0 Note: Check for, and remove, torn pieces of paper in the paper path.

Jams During Automatic 2-Sided Printing

Probable Causes

Using paper of the wrong size, thickness, or type.

Solutions

Use paper of the correct size, thickness, or type. For
details, refer to Supported Standard Paper Sizes for
Automatic 2-Sided Printing.

Paper is loaded in the wrong tray.

Ensure that paper is loaded into the correct tray.
For details, refer to Supported Paper.

Tray is loaded with mixed paper.

Load the tray with only one type and size of paper.
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Clearing Finisher Jams

Clearing Paper Jams in the Integrated Office Finisher

1. Open the finisher front door.

2. Carefully remove the jammed paper.

/’ Note: If the paper is torn, remove all torn pieces of jammed paper from the printer.

3. Rotate the green knob in the direction shown, then carefully remove the jammed paper.
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4.  Close the finisher front door.

Clearing Paper Jams in the Office Finisher

Clearing Jams Under the Office Finisher Top Cover

1. Pull up the lever on the top cover, then open the top cover.

2. Remove the jammed paper.

¢ Note:If the paper is torn, remove all torn pieces of the jammed paper from the finisher.

3. Close the top cover of the finisher.
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Clearing Jams in the Office Finisher Transport

1. Open the finisher transport cover.

2. Remove the jammed paper.

j’ Note: If the paper is torn, remove all torn pieces of the jammed paper from the finisher.

3. Close the finisher transport cover.
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Clearing Staple Jams

Clearing Staple Jams in the Integrated Office
Finisher

(D Caution: Do not perform this procedure while the printer is printing.

1. Open the finisher front door.

2. Toremove the staple cartridge, grasp the orange handle, then pull it firmly toward you.

3. Check inside the finisher for any loose staples, then remove the staples.

4, To open the clamp to gain access to the jammed staples, pull the clamp in the direction shown.
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5. Remove the jammed staples, then push the clamp in the direction shown until the clamp clicks
into the locked position.

WARNING: The points of the jammed staples are sharp. Remove the jammed staples
carefully.

6. Grasp the staple cartridge handle, then insert the cartridge into the stapler until the cartridge
clicks into position.

7. Close the finisher front door.

Staple Jams in the Office Finisher

Clearing Staple Jams in the Office Finisher

(U Caution: Do not perform this procedure while the printer is printing.
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1. Open the finisher front door.

2. Pull the stapler assembly toward you until it stops.

3. Push the stapler assembly to the right, as shown.

4. To remove the staple cartridge, grasp the orange handle, then pull the handle toward you.

5. Check inside the finisher for any loose staples, then remove the staples.
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6. To open the staple cartridge clamp, pull the clamp in the direction shown.

7. Remove the jammed staples, then push the clamp in the direction shown until the clamp clicks
into the locked position.

& WARNING: The points of the jammed staples are sharp. Remove the jammed staples
carefully.

8. Grasp the orange handle, then insert the cartridge into the stapler assembly until the cartridge
clicks into place.

9. Close the finisher front door.

Clearing Booklet Staple Jams in the Office Finisher

(@ Caution: Do not perform this procedure while the printer is printing.
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1. Open the booklet maker side cover.

2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening
and slide the panels to the center.

3. Hold the tabs on both sides of the staple cartridge and pull the cartridge out of the finisher.
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4. To remove the jammed staples, pull the staples in the direction shown.

& WARNING: The points of the jammed staples are sharp. Remove the jammed staples
carefully.

5. Hold the tabs on both sides of the staple cartridge and insert the cartridge into the original
position in the finisher.

® Note: If you have trouble inserting the cartridge, ensure that the staples are positioned
correctly in the cartridge.

_fg Note: The booklet maker uses two staple cartridges. Booklet stapling requires that both
staple cartridges contain staples.

6. Repeat the procedure for the other staple cartridge.

7. Close the booklet maker side cover.
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Clearing Hole Punch Jams in the Office Finisher

If the printer stops printing and reports a hole-punch jam, empty the hole-punch waste container. For
details on the finisher installed on your printer, refer to Emptying the Hole Punch Waste Container in
the Office Finisher.

After you empty the hole-punch waste container, locate and remove any paper jams.
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Print-Quality Problems

Your printer is designed to produce consistently high-quality prints. If you observe print-quality
problems, use the information in this section to troubleshoot the problem. For more information, go
to www.xerox.com/office/VLB71XXsupport.

(T Caution: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does

~*’ not cover damage caused by using unsupported paper or specialty media. The Xerox Total
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary
outside these areas. Contact your local Xerox representative for details.

¢ Note: To ensure consistent print quality, the toner, print, and drum cartridges for many devices
are designed to cease functioning at a predetermined point.

Controlling Print Quality

Various factors can affect the quality of the output of your printer. For consistent and optimum print
quality, use paper designed for your printer and set the paper type correctly. Follow the guidelines in
this section to maintain optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. The range for optimal print
quality is 15-28°C (59-82°F) and 20-70 % relative humidity. However, print quality can be affected
when operating near the limits for both temperature and humidity.

Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this
section for the best print quality and to avoid jams:

e Use only Xerox-approved paper. For details, refer to Supported Paper.
e Use only dry, undamaged paper.

e Ensure that the paper type selected in your print driver matches the paper type on which you are
printing.

e If you have the same size paper loaded in more than one tray, ensure that the proper tray is
selected in the print driver.

e Store your paper and other media properly for optimum print quality. For details, refer to Paper
Storage Guidelines.

/D Caution: Some paper and other media types can cause poor output quality, increased paper
jams, or damage your printer.

Do not use the following:

e Rough or porous paper

e Inkjet paper

e Paper that has been photocopied

e Paper that has been folded or wrinkled
e Paper with cutouts or perforations

e Stapled paper
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e Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes
¢ Plastic media

e Transparencies

Solving Print-Quality Problems

When the print quality is poor, select the closest symptom from the following table and refer to the
corresponding solution to correct the problem. You can print a Demonstration Print page to more
precisely determine the print-quality problem. For details, refer to Information Pages.

If the print quality does not improve after performing the appropriate action, contact your Xerox
representative.

j’ Note: To maintain print quality, the toner cartridge is designed to provide a warning message

‘ when the toner level is low. When the toner cartridge reaches this level, a warning message
appears. When the toner cartridge is empty, another message prompts you to replace the toner
cartridge. The printer stops printing until you install a new toner cartridge.

Symptom Solutions

The output is too light. e To check the toner level, check the control panel,
. use the print driver, or the Embedded Web Server.
AN If the toner cartridge is near empty, replace it.

o Verify that the toner cartridge is approved for use
in this printer, and replace it as needed. For best
results, use a genuine Xerox toner cartridge.

e Replace the paper with a recommended size and
type, and confirm that your printer and print
driver settings are correct.

e Verify that the paper is dry and that supported
paper is used. If not, change the paper.

e Change the Paper Type settings in the print driver.
In the print driver Printing Options tab, select
Paper, then change the Other Type setting.

Toner smears or print rubs off. e Change the Paper Type settings in the print driver.
For example, change Plain to Lightweight
Cardstock. In the print driver Printing Options tab,
e select Paper, then change the Other Type setting.
/ °® e Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.

® e Verify that the printer is plugged into an outlet
that is providing the correct voltage and power.
Review the electrical specification of the printer

The output has stains on the back side.

¢ with an electrician if necessary. For details, refer
to Electrical Specifications.
Random spots on the output, or the image is blurry. | «  Ensure that the toner cartridge is installed

correctly.

e If you used a non-genuine brand toner cartridge,
install a genuine Xerox toner cartridge.
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Symptom Solutions

e Use the Rough paper type setting, or try a paper
with a smoother surface.

e Ensure that the humidity in the room is within
specifications. For details, see Relative Humidity.

The output is blank.  Power off the printer, then power on again.

e If the error persists, contact your Xerox
representative.

Streaks appear in the output. e Replace the Drum Cartridge.

e If the error persists, contact your Xerox
representative.

The output has a mottled appearance. « Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.

e Ensure that the humidity in the room is within
specifications. For details, refer to Relative
Humidity.

e Choose a different paper type at the control
panel, in the application, and in the print driver.

e Replace the paper.

Ghosting appears in the printed output. « Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.

e Change the Paper Type settings in the print driver.
In the print driver Printing Options tab, select
Paper, then change the Other Type setting.

e Replace the Drum Cartridge.
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Symptom

Solutions

Auger marks appear on the printed output. o

To check the toner level, check the control panel,
use the print driver, or the Embedded Web Server.
If the toner cartridge is near empty, replace it.
Verify that the toner cartridge is approved for use
in this printer, and replace it as needed. For best
results, use a genuine Xerox toner cartridge.

The output print is wrinkled or stained. o

Verify that the paper is the correct size, type, and
weight for the printer and that it is loaded
properly. If not, change the paper.

Try a new ream of paper.

Change the Paper Type settings in the print driver.
In the print driver Printing Options tab, select
Paper, then change the Other Type setting.

Envelopes are wrinkled or creased when printed.

Check if the crease is within 30 mm (1.2 in.) of the
four edges of the envelope.

If yes, it is printing as expected. Your printer is not
faulty.

If not, take the following actions:
Ensure that envelopes are loaded properly in the

bypass tray. For details, see Loading Envelopes in
the Bypass Tray.

Follow the guidelines for printing on envelopes.
For details, see Guidelines for Printing Envelopes.

If the problem persists, use a different size
envelope.
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Symptom Solutions

The top margin is incorrect.

Ensure that the paper is loaded properly.
Ensure that the margins are set correctly in the
application you are using.

Adjust the paper registration. For details, see
Adjusting Paper Registration.

The printed surface of the paper is bumpy.

Print a solid image over the entire surface of one
sheet of paper.

Load the printed sheet into the tray with the
printed side face down.

Print five blank pages to remove debris from the
fuser rollers.
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Copy and Scan Problems

If the copy or scan quality is poor, refer to the following table.

If the problem persists, for online support information, go to www.xerox.com/office/VLB71XXsupport.

Symptoms Solutions

Lines or streaks only present in copies made from the | There is debris on the CVT glass or the second-side
document feeder. scanning lens assembly. When scanning, the paper
from the document feeder passes over the debris on
the glass surfaces, resulting in lines and streaks. Clean
all glass surfaces with a lint-free cloth. For more
information, refer to Cleaning the Scanner.

Spots present in copies made from the document There is debris on the document glass. When

glass. scanning, the debris creates a spot on the image.
Clean all glass surfaces with a lint-free cloth.

Image is too light or too dark. Adjust the lighten/darken setting.

Image quality is poor when scanning color original For best results, select Black & White output.

documents.
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Fax Problems

Troubleshooting

f Note: If the printer cannot send and receive faxes, make sure that you are connected to an
approved analog telephone line. The fax cannot send or receive when connected to a digital

phone line.

If you cannot send or receive faxes correctly, refer to the following tables.

Problems Sending Faxes

Symptoms

The document is not scanned
using the document feeder.

Causes

The document is too thick, too
thin, or too small.

Solutions

Use the document glass to send
the fax.

The document is scanned at an
angle.

The document feeder guides are
not adjusted to the width of the
document.

Adjust the document feeder
guides to fit the width of the
document.

The fax received by the recipient is
blurry.

The document is positioned
incorrectly.

Position the document correctly.

The document glass is dirty.

Clean the document glass.

The text in the document is too
light.

Adjust the resolution.

There is a problem with the
telephone connection.

Verify that the telephone line is
working, then send the fax again.

There is a problem with the fax
machine of the caller.

Make a copy to verify that your
printer is operating correctly. If the
copy was printed correctly, have
the recipient verify the condition
of the receiving fax machine.

The fax received by the recipient is
blank.

The document was loaded
incorrectly.

e Document feeder: Place the
original document face up.

e Document glass: Place the
original document face down.

Fax was not transmitted.

The fax number is wrong.

Verify the fax number.

The telephone line is connected
incorrectly.

Verify the telephone connection. If
it is disconnected, connect it.

There is a problem with the fax
machine of the recipient.

Contact the recipient.

The fax is not installed or is not
enabled.

Verify that the fax is installed and
enabled.

If the problem persists, for online support information, go to www.xerox.com/office/VLB71XXsupport.
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Problems Receiving Faxes

Symptoms

The received fax is blank.

Causes

There is a problem with the
telephone connection or with the
fax machine of the sender.

Solutions

Verify that the printer can make
copies. Request that the sender
resent the fax.

The sender loaded the pages
incorrectly.

Contact the sender.

The printer answers the call, but
does not accept incoming data.

Not enough memory.

If the job contains several
graphics, the printer could not
have enough memory. The printer
does not answer when memory is
low. Delete stored documents and
jobs then wait for the existing job
to complete. This increases
available memory.

The received fax size is reduced.

The paper supply in the printer
does not match the document size
sent.

Confirm the original size of the
documents. Documents could be
reduced based on the available
paper supply in the printer.

Faxes cannot be received
automatically.

The printer is set to receive faxes
manually.

Set the printer to automatic
reception.

The memory is full.

Load paper if it is empty, and then
print the faxes stored in the
memory.

The telephone line is connected
incorrectly.

Verify the telephone line
connection. If it is disconnected,
connect it.

There is a problem with the fax
machine of the sender.

Make a copy to verify that your
printer is operating correctly. If the
copy prints correctly, have the
recipient verify that the receiving
fax machine is operating correctly.

If the problem persists, for online support information, go to www.xerox.com/office/VLB71XXsupport.
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Troubleshooting

Getting Help

Your printer includes utilities and resources to help you troubleshoot printing problems.

Viewing Warning Messages on the Control Panel

When a warning condition occurs, the printer alerts you of the problem. A message appears on the
control panel and the LED status light on the control panel flashes amber or red. Warning alerts
inform you about printer conditions, such as low supplies or open doors, that require your attention. If
more than one warning condition occurs, only one warning message appears on the control panel at
a time.

Viewing Current Errors on the Control Panel

When an error condition occurs, a message appears on the control panel to inform you of the
problem. Error messages warn you about printer conditions that prevent the printer from printing or
degrade printing performance. If more than one error occurs, only one is displayed on the control
panel.

Using the Integrated Troubleshooting Tools

Your printer has a set of reports that you can print. These reports include the Demonstration Print
page and the Error History report that can assist you in troubleshooting certain problems. The
Demonstration Print page prints an image to show print quality. You can use this page to
troubleshoot print-quality issues with the printer. The Error History report prints information on the
most recent printer errors.

For more information, refer to Printing Information Pages.

Printing the Error History Report
1. At the printer control panel, press the Home button.

2. To print the Error History Report, touch Device > Support > Support Pages > Error History
Report.

3. To return to the Home screen, press the Home button.

Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help
to solve your printer problems. You can find solutions for print-quality problems, paper jams, software
installation issues, and more.

To access the Online Support Assistant, go to www.xerox.com/office/VLB71XXsupport.
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Troubleshooting

Helpful Information Pages
To assist with troubleshooting, your printer has a set of Information Pages that you can print. These

pages include configuration and font information, demonstration pages, and more. For more
information, refer to Information Pages.

More Information about Your Printer

To obtain more information about your printer, refer to More Information.
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Printer Configurations and Options

Available Configurations

This printer is a network printer with copy, automatic 2-sided printing, scan functions, fax functions,
and USB or network connectivity.

Available configurations:

e Base Model; an optional second tray without stand is available

e Printer, additional trays with stand

e Printer, additional trays with Tandem Tray Module

e Printer, additional trays, and High-Capacity Feeder

e Printer, additional trays, and Integrated Office Finisher

e Printer, additional trays, High-Capacity Feeder, and Integrated Office Finisher

e Printer, additional trays, and Office Finisher

e Printer, additional trays, High-Capacity Feeder, and Office Finisher

e Printer, additional trays, and Office Finisher with Booklet Maker

e Printer, additional trays, High-Capacity Feeder, and Office Finisher with Booklet Maker

Features

Print Speed for 1-Sided,
Black and White:

VersaLink® B7125

VersaLink® B7130

VersaLink® B7135

A4 (210 x 297 mm),
Letter (8.5x 11 in.)

216 x 356 mm, Legal
(8.5x141in.)

A3 (297 x 420 mm),
Tabloid (11 x 17 in.)

25 ppm maximum

19 ppm maximum

16 ppm maximum

30 ppm maximum

23 ppm maximum

20 ppm maximum

35 ppm maximum

26 ppm maximum

22 ppm maximum

Print Speed for 2-Sided,
Black and White:

VersalLink® B7125

VersalLink® B7130

VersalLink® B7135

A4 (210 x 297 mm),
Letter (8.5x 11 in.)

216 x 356 mm, Legal
(8.5x14in.)

A3 (297 x 420 mm),
Tabloid (11 x 17 in.)

25 ppm maximum

19 ppm maximum

10 ppm maximum

30 ppm maximum

23 ppm maximum

12 ppm maximum

35 ppm maximum

26 ppm maximum

14 ppm maximum

Print or Copy Resolution

Standard Mode: 600 x 600 dpi
Enhanced Mode: 1200 x 1200 dpi

Paper Capacity:

Versalink® B7125/B7130/B7135
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Bypass Tray

Tray 1

Single Tray Module
3-Tray Module
Tandem Tray Module
High-Capacity Feeder
Output Tray

Envelope Tray

100 sheets, 80 g/m?

520 sheets, 80 g/m?

520 sheets, 80 g/m?

520 sheets per tray, 80 g/m?

Tray 2: 520 sheets, Tray 3: 870 sheets, Tray 4: 1130 sheets, 80 g/m?2
2000 sheets, 80 g/m?

500 sheets A4 (Letter), 200 sheets A3 (Tabloid), 80 g/m2

60 envelopes

Output Capacity:

Versalink® B7125/B7130/B7135

Dual Catch Trays

Integrated Office
Finisher Stacking Tray

Office Finisher Stacking
Tray

Booklet Maker

Convenience Stapler

Up to 250 sheets per tray

Up to 500 sheets for A4 (Letter), or 200 sheets for A3 (Tabloid), 80 g/m?

Up to 2000 sheets unstapled, 1000 sheets with one staple, or 750 sheets with
two staples for A4 (Letter), 80 g/m?

Up to 40 booklets, 2-15 sheets per booklet, 80 g/m2 maximum

50-sheet stapling, 5000 staples

Maximum standard print
size

A3 (297 x 410 mm, 11.7 x 16.1 in.)
279.4x 431.8 mm (11 x 17 in.)

Maximum print area

4 mm from the leading edge of the paper, 2 mm from the side edge and trailing
edge of the paper

Maximum printable area for a print job: 291.0 x 476.6 mm (11.5 x 18.8 in.)

Maximum printable area for a copy job, for Document Glass: 291.0 x 425.8 mm
(11.5x16.8in.)

Maximum weight of
paper for 2-Sided
printing

169 g/m2

Maximum standard copy
size

A3 (297 x 410 mm, 11.7 x 16.1 in.)
279.4x431.8 mm (11 x 17 in.)

Document Feeder:

Versalink® B7125/B7130/B7135

Type Duplex Automatic Document Feeder
Capacity 110 sheets
Scan resolution 600 x 600 dpi

Maximum scan size

Document Glass: 291.0 x 425.8 mm (11.5x16.8 in.) (W x L)
Automatic Document Feeder: 297 x 431.8 mm (11.7 x 17 in.) (W x L)
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Scan Speed: VersalLink® B7125/B7130/B7135
1-sided Up to 80 ppm

2-sided Up to 80 ppm

File formats JPEG

TIFF (single page and multi-page)

XPS (single page and multi-page

PDF (single page and multi-page)

Searchable PDF

Password-protected PDF

Linearized PDF set in the Embedded Web Server, and PDF/A

Supported scanning Scan to Home
Scan to USB
Scan to Email

Scan to Network (Browse FTP or Browse SMB)

Email address book Up to 2000 email addresses
Control panel 7-inch LCD touch screen with Home and Power/Wake buttons
Connectivity Ethernet 10/100/1000 Base-T

High-speed USB 3.0

Wi-Fi 801.11n and Wi-Fi Direct with optional Wi-Fi Kit. Concurrent wired and
wireless connections supported.

NFC Tap-to-Pair

Remote access Embedded Web Server

Options and Upgrades
e Paper Trays:

— Single-Tray Module

— Single Tray Module with Stand

—  3-Tray Module

— Tandem Tray Module

— High-Capacity Feeder

— Envelope Tray
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” Note: The Single Tray Module is optional for the base model only, and does not include
a stand.

Output Devices:

— Center Tray

— Integrated Office Finisher

—  Office Finisher

—  Office Finisher with Booklet Maker
—  2-3 Hole Punch for North America
— 2-4 Hole Punch for Europe
Connectivity Options:

— 1-line or 3-line Fax Kit

- Wi-FiKit

—  Fax Over IP Kit

External Keyboard

Bluetooth (AirPrint Discovery)

Support for AirPrint® with iBeacon
Hard drive

Internal Card Reader/RFID Kit

Xerox® Common Access Card Enablement Kit
PostScript Kit

Convenience Stapler, including Work Surface

® Note: The center tray and hard drive are optional only for the base model. They are standard
features for all other available models.
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Performance Specifications

Feature Specifications

Printer warm-up time Power on: 60 seconds

Recovery from sleep mode For VersaLink® B7125: 12 seconds

For VersalLink® B7130/ B7135 : 15 seconds

Recovery from low-power mode For VersaLink® B7125: 12 seconds

For VersalLink® B7130/ B7135 : 15 seconds

Print Speed

Several factors affect the print speed:
e Print mode: The fastest mode is Standard.

o Paper size: Letter (8.5 x 11 in.) prints slightly faster than A4 (210 x 297 mm). Larger paper sizes
reduce print speeds.

e Paper type and weights: For faster printing, use paper weights of 105 g/m2 or less.

Maximum Print Speeds for Black and White:

Paper Type and
Weight A4/Letter A3/Tabloid

1-Sided Printing  2-Sided Printing  1-Sided Printing = 2-Sided Printing

Plain 35 ppm 35 ppm 22 ppm 13 ppm

Heavyweight 1: 25 ppm 25 ppm 16 ppm 10 ppm
106-169 g/m?2

Heavyweight 2: 12 ppm N/A 8 ppm N/A
170-256 g/m2

‘&0 Note: The print speeds are based on Xerox® VersalLink® B7135 Multifunction Printer.
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Physical Specifications

Weights and Dimensions
Base Model

Width: 59.0 cm (23.2 in.)
Depth: 67.1 cm (26.4 in.)
Height: 76.7 cm (30.2 in.)
Weight: 54.2 kg (119.4 |b.)

Base Model with Single Tray and Stand

Width: 61.6 cm (24.2 in.)
Depth: 67.1 cm (26.4 in.)
Height: 111.7 cm (44.0 in.)
Weight: 77.1 kg (169.9 b.)
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Base Model with Tandem Tray Module

Width: 61.6 cm (24.2 in.)
Depth: 67.1 cm (26.4 in.)
Height: 111.7 cm (44.0 in.)
Weight: 85.6 kg (188.7 |b.)

Base Model with 3-Tray Module and Integrated Office Finisher

Width: 66.6 cm (26.2 in.)
Depth: 67.1 cm (26.4 in.)
Height: 111.7 cm (44.0 in.)
Weight: 92.8 kg (204.5 Ib.)
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Base Model with 3-Tray Module and Office Finisher

Width: 113.4 cm (44.6 in.)
Depth: 67.1 cm (26.4 in.)
Height: 111.7 cm (44.0 in.)
Weight: 106.7 kg (235.2 |b.)

Base Model with 3-Tray Module and Office Finisher with Booklet Maker

Width: 113.5 cm (44.6 in.)
Depth: 67.9 cm (26.7 in.)
Height: 111.7 cm (44.0 in.)
Weight: 118.7 kg (261.6 lb.)
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Base Model with 3-Tray Module, Office Finisher, Booklet Maker, and High-Capacity
Feeder

Width: 145.0 cm (57.0 in.)
Depth: 67.9 cm (26.7 in.)
Height: 111.7 cm (44.0 in.)
Weight: 147.7 kg (325.6 Ib.)

Base Model with Tandem Tray Module, Office Finisher, Booklet Maker, and High-Capacity
Feeder

Width: 145.0 cm (57.0 in.)
Depth: 67.9 cm (26.7 in.)
Height: 111.7 cm (44.0 in.)
Weight: 157.7 kg (347.6 |b.)
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Total Space Requirements

Clearance Requirements for Base Model

Width: 108.6 cm (42.8 in.)
Depth: 156.7 cm (61.7 in.)
Height: 112.3 cm (44.2 in.)

Clearance Requirements for Single Tray and Stand

Width: 111.5 cm (43.9 in.)
Depth: 166.6 cm (65.6 in.)
Height: 147.4 cm (58.0 in.)
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Clearance Requirements with Tandem Tray Module

Width: 128.8 cm (50.7 in.)
Depth: 166.6 cm (65.6 in.)
Height: 147.4 cm (58.0 in.)

Clearance Requirements with 3-Tray Module and Integrated Office Finisher

Width: 128.8 cm (50.7 in.)
Depth: 166.6 cm (65.6 in.)
Height: 147.4 cm (58.0 in.)
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Clearance Requirements for 3-Tray Module with Office Finisher

Width: 167.2 cm (65.8 in.)
Depth: 166.6 cm (65.6 in.)
Height: 147.4 cm (58.0 in.)

Clearance Requirements for 3-Tray Module, Office Finisher, and Booklet Maker

Width: 167.2 cm (65.8 in.)
Depth: 166.6 cm (65.6 in.)
Height: 147.4 cm (58.0 in.)
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Clearance Requirements with 3-Tray Module, Office Finisher, Booklet Maker, and High-
Capacity Feeder

Width: 190.9 cm (75.2 in.)
Depth: 166.6 cm (65.6 in.)
Height: 147.4 cm (58.0 in.)
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Clearance Requirements for Tandem Tray Module, Office Finisher, Booklet Maker, and
High-Capacity Feeder

Width: 190.9 cm (75.2 in.)
Depth: 166.6 cm (65.6 in.)
Height: 147.4 cm (58.0 in.)
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Environmental Specifications

Temperature
e Operating Temperature Range: 10-32°C (50-90°F)
e Optimal Temperature Range: 15-28°C (59-82°F)

Relative Humidity
e Operating Humidity Range: 10-85 %
e Optimal Humidity Range: 20-70 % relative humidity at 28°C (82°F)

¥ Note: Under extreme environmental conditions, such as 10°C and 85 % relative humidity,
printing defects can occur due to condensation inside the printer.

Elevation

For optimum performance, use the printer at elevations below 2500 m (8200 ft.).
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Electrical Specifications

Power Supply Voltage and Frequency

Power Supply Voltage Frequency Current Required
110-127 VAC +6 % /-10 % 50/60 Hz +/-3% 12A

(99-135 VAQ)

220-240 VAC +/-10% 50 Hz +/-3 Hz 8A

(198-264 VAQC)

Power Consumption
e 110V:

Maximum power consumption: 1.45 kW
Sleep mode: 0.4 W or less

Low-Power mode: 51.0 W or less
Standby: 100 W or less

e 220V:

Maximum power consumption: 1.76 kW
Sleep mode: 0.4 W or less

Low-Power mode: 51.0 W or less
Standby: 94.0 W or less
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Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards
are designed to mitigate interference caused or received by this printer in a typical office
environment.

ENERGY STAR

The ENERGY STARprogram is a voluntary scheme to promote the development and
purchase of energy efficient models, which help to reduce environmental impact.
Details on the ENERGY STAR program and models qualified to ENERGY STAR can be
EMERGY STAR found at the following website: www.energystar.gov.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United
States, European Union, and Japanese governments and the office equipment
industry to promote energy-efficient copiers, printers, fax, multifunction printers,
personal computers, and monitors. Reducing product energy consumption helps
combat smog, acid rain, and long-term changes to the climate by decreasing the
emissions that result from generating electricity.

Power Consumption and Activation Time

The amount of electricity that a device consumes depends on the way the device is used. This device
is designed and configured to enable you to reduce your electricity usage.

Power Saver modes are enabled on your device to reduce energy consumption. After the last print,
the device transitions to Ready mode. In this mode, the device can print again immediately. If the
device is not used for a specified period, the device transitions to Low Power mode, then to Sleep
mode. In these modes, to enable reduced-power consumption, only essential functions remain active.
The device takes longer to produce the first print after it exits the Power Saver modes than it takes to
print in Ready mode. This delay is the result of the system waking up and is typical of most imaging
devices on the market.

To save power, you can enable Auto Power Off mode on your device. If Auto Power Off mode is
enabled, you can configure the mode as follows:

¢ Always Allowed: The device powers off automatically after the specified time, and the cumulative
Low Power mode and Sleep mode timeouts have elapsed.

e Allowed ONLY When Conditions are Met: The device automatically powers off only after
timeouts have elapsed. The device also powers off if Fax, USB Drive, and Wired and Non-Wired
Network have not been activated.

To change the Power Saver settings, refer to the User Guide at www.xerox.com/office/VLB71XXdocs.
For further assistance, contact your System Administrator or refer to the System Administrator Guide.

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System
Administrator Guide at www.xerox.com/office/VLB71XXdocs.

To learn more about Xerox participation in sustainability initiatives, go to: www.xerox.com/
environment.
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Regulatory Information

¢ Note: Changing the default Power Saver activation times can result in an overall higher energy
consumption of the device. Before you turn off Power Saver modes or set a long activation
time, consider the increase in device power consumption.

Default Power Saver Settings

This device is ENERGY STAR®-qualified under the ENERGY STAR Program Requirements for Imaging
Equipment. The transition time from Ready mode to Low-Power mode can be set up to 60 minutes.
The default value is 1 minute. The transition time from Low-Power mode to Sleep mode can be set up
to 60 minutes. The default value is set at 1 minute. The total transition time from Ready mode to
Sleep mode can take up to 60 minutes.

To change the Power Saver settings, contact your system administrator or refer to System
Administrator Guide at www.xerox.com/office/VLB71XXdocs.

Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you
to print on both sides of the paper automatically, and therefore helps to reduce the use of valuable
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires
that on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm
monochrome the duplex function has been auto enabled, during the setup and driver installation.
Some Xerox models below these speed bands may also be enabled with 2-sided printing settings
defaulted on at the time of install. Continuing to use the duplex function will reduce the
environmental impact of your work. However, should you require simplex/1-sided printing, you may
change the print settings in the print driver.

Paper Types

This product can be used to print on both recycled and virgin paper, approved to an environmental
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight
paper (60 g/m?), which contains less raw material and thus save resources per print, may be used in
certain applications. We encourage you to check if this is suitable for your printing needs.

Reqgulatory Information for 2.4-GHz and 5-GHz
Wireless Network Adapters

This product contains a 2.4-GHz and 5-GHz Wireless LAN radio transmitter module that complies with
the requirements specified in FCC Part 15, Industry Canada RSS-210, and European Council Directive
2014/53/EU. Radio Frequency (RF) output power of this device will not exceed 20 dBm in either
frequency band.

Operation of this device is subject to the following two conditions:
1. This device may not cause harmful interference, and

2. This device must accept any interference received, including interference that may cause
undesired operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void
the user's authority to operate this equipment.
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United States FCC Regulations

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 and Part 18 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy. If the
equipment is not installed and used in accordance with these instructions, it can cause harmful
interference to radio communications. Operation of this equipment in a residential area is likely to
cause harmful interference. Users are required to correct the interference at their own expense.

If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.
e Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

e Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user
to operate this equipment.

& WARNING: To ensure compliance with Part 15 and Part 18 of the FCC rules, use shielded
interface cables.

Canada
This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.

Certifications in Europe

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with the
( € following applicable Directives of the European Union as of the date indicated:

e April 16, 2014: Radio Equipment Directive 2014/53/EU

Hereby, Xerox declares that the radio equipment model VersalLink B71XX is in compliance with
Directive 2014/53/EU. The full text of the EU declaration of conformity can found at the following
internet address:

www.xerox.com/environment_europe

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or
for the environment.

WARNING: Changes or modifications to this equipment not specifically approved by the Xerox
Corporation may void the user’s authority to operate this equipment.
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& WARNING: External radiation from Industrial, Scientific, and Medical (ISM) equipment can
interfere with the operation of this Xerox device. If external radiation from ISM equipment
interferes with this device, contact your Xerox representative for assistance.

& WARNING: This is a class A product. In a domestic environment, this product can cause radio
frequency interference, in which case the user can be required to take adequate measures.

A WARNING: To ensure compliance with European Union regulations, use shielded interface
cables.

European Union Lot 4 Imaging Equipment
Agreement Environmental Information

Environmental Information Providing Environmental Solutions and
Reducing Cost

The following information has been developed to assist users and has been issued in relation to the
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging
Equipment. This requires manufacturers to improve environmental performance of in scope products
and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.

e Standard monochrome format products with a maximum speed less than 66 A4 images per
minute

e Standard color format products with a maximum speed less than 51 A4 images per minute

European Union Lot 19 on Light Sources

According to European Commission Ecodesign Directive, the light source contained within this
product or its components is intended to be used for Image Capture or Image Projection only, and is
not intended for use in other applications.

Eurasian Economic Community Certification

Eurasian Economic Community, or EurAsEC. The Eurasian Economic Community members
anticipate sharing a common regulatory scheme and common EurAsEC certification mark, the

[ H [ Russia, Belarus, and Kazakhstan are working to establish a common customs union, the
EAC Mark.
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Germany

Germany - Blue Angel

RAL, the German Institute for Quality Assurance and Labeling, has awarded this
device the Blue Angel Environmental Label. This label distinguishes it as a device
that satisfies Blue Angel criteria for environmental acceptability in terms of device
design, manufacture, and operation. For more information, go to: www.blauer-
engel.de.

Blendschutz

Das Gerdt ist nicht fur die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um stérende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt
nicht im unmittelbaren Gesichtsfeld platziert werden.

Larmemission

Maschinenlarminformations-Verordnung 3. GPSGV: Der héchste Schalldruckpegel betragt 70 dB(A)
oder weniger gemdf3 EN ISO 7779.

Importeur
Xerox GmbH
Hellersbergstrafe 2-4
41460 Neuss
Deutschland

Turkey RoHS Regulation
In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE yonetmeligine uygundur.”
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Copy Regulations

United States

Congress, by statute, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

1. Obligations or Securities of the United States Government, such as:

Certificates of Indebtedness.
National Bank Currency.
Coupons from Bonds.
Federal Reserve Bank Notes.
Silver Certificates.

Gold Certificates.

United States Bonds.
Treasury Notes.

Federal Reserve Notes.
Fractional Notes.
Certificates of Deposit.
Paper Money.

Bonds and Obligations of certain agencies of the government, such as FHA and so on.

Bonds. United States Savings Bonds may be photographed only for publicity purposes in
connection with the campaign for the sale of such bonds.

Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a
canceled revenue stamp, this may be done provided the reproduction of the document is
performed for lawful purposes.

Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be
photographed, provided the reproduction is in black and white and is less than 75 % or more
than 150 % of the linear dimensions of the original.

Postal Money Orders.
Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

Stamps and other representatives of value, of whatever denomination, which have been or
may be issued under any Act of Congress.

Adjusted Compensation Certificates for Veterans of the World Wars.

2. Obligations or Securities of any Foreign Government, Bank, or Corporation.

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the
reproduction falls within the “fair use” or library reproduction rights provisions of the copyright
law. Further information of these provisions may be obtained from the Copyright Office, Library of
Congress, Washington, D.C. 20559. Ask for Circular R21.
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Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be
photographed.

Passports. Foreign Passports may be photographed.

Immigration papers.

Draft Registration Cards.

Selective Service Induction papers that bear any of the following Registrant’s information:
e Earnings or Income.

e Court Record.

e Physical or mental condition.

e Dependency Status.

e Previous military service.

e Exception: United States military discharge certificates may be photographed.

Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of
the various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered
by the head of such department or bureau).

Reproducing the following is also prohibited in certain states:

Automobile Licenses.
Drivers’ Licenses.

Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In
case of doubt, consult your attorney.

For

more information about these provisions contact the Copyright Office, Library of Congress,

Washington, D.C. 20559. Ask for Circular R21.

Canada

Parliament, by stature, has forbidden the reproduction of the following subjects under certain

circ

umstances. Penalties of fine or imprisonment may be imposed on those guilty of making such

reproductions.

278

Current bank notes or current paper money
Obligations or securities of a government or bank
Exchequer bill paper or revenue paper

The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or
of a court of law

Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely
cause same to purport to have been printed by the Queens Printer for Canada, or the equivalent
printer for a province)

Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of
a province, the government of a state other than Canada or a department, board, Commission, or
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agency established by the Government of Canada or of a province or of a government of a state
other than Canada

Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or
of a province or by the government of a state other than Canada

Documents, registers, or records kept by public officials charged with the duty of making or issuing
certified copies thereof, where the copy falsely purports to be a certified copy thereof

Copyrighted material or trademarks of any manner or kind without the consent of the copyright
or trademark owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is
assumed for its completeness or accuracy. In case of doubt, consult your solicitor.

Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be
imposed on those found guilty of making such reproductions.

Currency notes

Bank notes and checks

Bank and government bonds and securities

Passports and identification cards

Copyright material or trademarks without the consent of the owner

Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of
doubt, contact your legal counsel.
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Fax Regulations

United States

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer
or other electronic device, including a fax machine, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or
other individual sending the message and the telephone number of the sending machine or such
business, other entity, or individual. The telephone number provided may not be a 900 number or any
other number for which charges exceed local or long-distance transmission charges.

For instructions on programming the Fax Send Header information, refer to the section of the System
Administrator Guideon Setting Transmission Defaults.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label
that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If
requested, this number must be provided to the Telephone Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It connects to a compatible modular
jack that is also compliant. See installation instructions for details.

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation
instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be
connected to a telephone line. Excessive RENs on a telephone line could result in the devices not
ringing in response to an incoming call. In most but not all areas, the sum of RENs should not exceed
five (5.0). To be certain of the number of devices that can be connected to a line, as determined by
the RENSs, contact the local Telephone Company. For products approved after July 23, 2001, the REN
is part of the product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ##
are the REN without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is
separately shown on the label.

To order the correct service from the local Telephone Company, you could also have to quote the
codes in the following list:

e Facility Interface Code (FIC) = 02LS2
e Service Order Code (SOC) = 9.0Y

(1) Caution: Ask your local Telephone Company for the modular jack type installed on your line.
d Connecting this machine to an unauthorized jack can damage telephone company equipment.
You, not Xerox, assume all responsibility and/or liability for any damage caused by the
connection of this machine to an unauthorized jack.
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If this Xerox® equipment causes harm to the telephone network, the Telephone Company could
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the
Telephone Company interrupts your service, they can advise you of your right to file a complaint with
the FCC if you believe that it is necessary.

The Telephone Company could change its facilities, equipment, operations, or procedures which could
affect the operation of the equipment. If the Telephone Company changes something that affects
the operation of the equipment, they should notify you in order for you to make necessary
modifications to maintain uninterrupted service.

If you experience trouble with this Xerox® equipment, please contact the appropriate service center
for repair or warranty information. Contact information is contained in the Device app on the printer
and in the back of the Troubleshooting section of the User Guide. If the equipment is causing harm to
the telephone network, the Telephone Company may request you to disconnect the equipment until
the problem is resolved.

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make
repairs to the printer. This applies at any time during or after the service warranty period. If
unauthorized repair is performed, the remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to state
tariffs. Contact the state public utility commission, public service commission, or corporation
commission for information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure
that the installation of this Xerox® equipment does not disable your alarm equipment.

If you have questions about what could disable alarm equipment, consult your Telephone Company
or a qualified installer.

Canada

This product meets the applicable Innovation, Science and Economic Development Canada technical
specifications.

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs
or alterations made by the user to this device, or device malfunctions, could cause the
telecommunications company to request you to disconnect the equipment.

For user protection, make sure that the printer is properly grounded. The electrical ground connections
of the power utility, telephone lines, and internal metallic water pipe systems, if present, must be
connected together. This precaution could be vital in rural areas.

& WARNING: Do not attempt to make such connections yourself. Contact the appropriate electric
inspection authority, or electrician, to make the ground connection.

The Ringer Equivalence Number (REN) indicates the maximum number of devices allowed to be
connected to a telephone interface. The termination of an interface may consist of any combination
of devices subject only to the requirement that the sum of the RENs of all the devices not exceed five.
For the Canadian REN value, please refer to the label on the equipment.

Canada CS-03 Issue 9

This product has been tested to and is compliant with CS-03 issue 9.
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European Union

Radio Equipment and Telecommunications Terminal Equipment
Directive

This device has been designed to work with the national public switched telephone networks and
compatible PBX devices of the following countries:

Pan-European Analog PSTN and Compatible PBX Certifications

Austria Greece Netherlands
Belgium Hungary Norway
Bulgaria Iceland Poland

Cyprus Ireland Portugal

Czech Republic Italy Romania
Denmark Latvia Slovakia

Estonia Liechtenstein Slovenia

Finland Lithuania Spain

France Luxembourg Sweden
Germany Malta United Kingdom

If you have problems with your product, contact your local Xerox representative. This product can be
configured to be compatible with other country networks. Before reconnecting the device to a
network in another country, contact your Xerox representative for assistance.

e Although this product can use either loop disconnect (pulse) or DTMF tone signaling,
Xerox recommends that you use DTMF signaling. DTMF signaling provides reliable and
faster call setup.

e Modification of this product, or connection to external control software or control
apparatus not authorized by Xerox, invalidates its certification.

/" Note:
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New Zealand

1.

The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has
accepted that the item complies with minimum conditions for connection to its network. It
indicates no endorsement of the product by Telecom, it does not provide any sort of warranty,
and it does not imply that any Telepermitted product is compatible with all Telecom network
services. Above all, it provides no assurance that any item will work correctly in all respects with
another item of Telepermitted equipment of a different make or model.

The equipment may not be capable of correct operation at the higher data speeds designated.
33.6 kbps and 56 kbps connections are likely to be restricted to lower bit rates when connected to
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in
such circumstances.

Immediately disconnect this equipment should it become physically damaged, then arrange for
its disposal or repair.

. This modem shall not be used in any manner which could constitute a nuisance to other Telecom

customers.

. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There

is no guarantee that Telecom lines will always continue to support pulse dialing.

Use of pulse dialing, when this equipment is connected to the same line as other equipment, may
give rise to 'bell tinkle’ or noise and cause a false answer condition. If you encounter such
problems, do not contact the Telecom Faults Service.

DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is
readily available on almost all New Zealand telephone exchanges.

& WARNING: No 111" or other calls can be made from this device during a mains power
failure.

This equipment may not provide for the effective hand-over of a call to another device connected
to the same line.

Some parameters required for compliance with Telecom Telepermit requirements are dependent
on the equipment (computer) associated with this device. The associated equipment shall be set
to operate within the following limits for compliance with Telecom Specifications:

For repeat calls to the same number:

e There shall be no more than 10 call attempts to the same number within any 30 minute
period for any single manual call initiation, and

e The equipment shall go on-hook for a period of not less than 30 seconds between the end of
one attempt and the beginning of the next attempt.

For automatic calls to different numbers:

The equipment shall be set to ensure that automatic calls to different numbers are spaced such
that there is no less than five seconds between the end of one call attempt and the beginning of
another.

For correct operation, total of the RNs of all devices connected to a single line at any time should
not exceed five.
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South Africa

This modem must be used in conjunction with an approved surge-protection device.
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Safety Certification

This device is certified by the following Agencies using the following safety standards.

Agency Standard

TUV Rheinland (US/Canada) UL 60950-1, 2nd Edition, 2014-10-14

CAN/CSA C22.2 No. 60950-1-07, 2nd Edition, 2014-10
UL 62368-1

TUV Rheinland (Europe) IEC/EN 62368-1:2014
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Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:
e North America: www.xerox.com/msds
e European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
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Recycling and Disposal

This appendix contains:

e All Countries

e North America

e European Union

e Other Countries
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Recycling and Disposal

All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain
lead, mercury, perchlorate, and other materials whose disposal may be regulated due to
environmental considerations. The presence of these materials is fully consistent with global
regulations applicable at the time that the product was placed on the market. For recycling and
disposal information, contact your local authorities. Perchlorate Material: This product may contain
one or more Perchlorate-containing devices, such as batteries. Special handling may apply. For more
information, go to www.dtsc.ca.gov/hazardouswaste/perchlorate.
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Recycling and Disposal

North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox
representative (1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more

information about Xerox environmental programs, visit www.xerox.com/environment, or for recycling
and disposal information, contact your local authorities.
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Recycling and Disposal

European Union

Domestic/Household Environment

Application of this symbol on your equipment is confirmation that you should not dispose of
the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to
designated collection facilities free of charge. Please contact your local disposal authority for
information.

In some member states, when you purchase new equipment, your local retailer may be required to
take back your old equipment free of charge. Please ask your retailer for information.

Professional/Business Environment

Application of this symbol on your equipment is confirmation that you must dispose of this
equipment in compliance with agreed national procedures.

I
In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back
information.

Collection and Disposal of Equipment and Batteries

These symbols on the products and/or accompanying documents mean that used electrical and
electronic products and batteries should not be mixed with general household waste.

For proper treatment, recovery, and recycling of old products and used batteries, please take them to
applicable collection points, in accordance with your national legislation and the Directive 2002/96/EC
and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to save valuable resources and
prevent any potential negative effects on human health and the environment which could otherwise
arise from inappropriate waste handling.

For more information about collection and recycling of old products and batteries, please contact your
local municipality, your waste disposal service or the point of sale where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in accordance with national legislation.
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Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for
further information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items, please
contact your local authorities or dealer and ask for the correct method of disposal.

Battery Symbol Note

This wheeled bin symbol may be used in combination with a chemical symbol. This establishes
compliance with the requirements set out by the Directive.

Hg

Battery Removal

Batteries should only be replaced by a manufacturer-approved service facility.
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Other Countries

Please contact your local waste management authority to request disposal guidance.
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This appendix contains:
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Feature

Preset

Description

Use Preset to select values that were
stored previously. Select the required
Preset from the menu.

Copy

Email

Fax

ID

Server Scan Card
Fax To Copy

Output Color

Use Output Color to control the color
rendering of the output image or print.

Saturation

Saturation allows you to adjust the color
strength and the amount of gray in the
color.

2-Sided and 2-
Sided Scanning

You can use the 2-Sided options to set
the device to scan one or both sides of an
original document. For Copy jobs, you can
specify 1-Sided or 2-Sided output.

Paper Supply

Use Paper Supply to specify the size, type
and color of the paper required, or the
Paper Tray to use. If Auto is selected, the
printer chooses the paper tray based on
the original document size and the
selected settings.

B

Collated

You can collate multi-page copy jobs
automatically. For example, when making
three 1-Sided copies of a six-page
document, the copies are printed in this
order:

1!2J 31 L" 5) 6;172’ 3’ L'J 5! 6;172’ 37"! 51
6.

Reduce/ Enlarge

You can reduce the image to as little as
25% of its original size or enlarge it as
much as 400 % .
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Feature

Original Type

Description

The printer optimizes the image quality
of the copies based on the type of
images in the original document and how
the original was created.

Fax

Server
Fax

Scan
To

Lighten/Darken

Use the Lighten/Darken slider to make
the output image or print lighter or
darker.

Sharpness

Use this option to sharpen the output
image or print. For best results, sharpen
text images and soften photos.

Original
Orientation

You can use the Original Orientation
option to specify the layout of the
original images. The printer uses the
information to determine if images
require rotation to produce the required
output.

Image Shift

Image Shift allows you to modify the
location of the image on the page. You
can shift the printed image along the X
and Y axes of each sheet of paper.

Auto Background
Suppression

Use the Auto Background Suppression
setting to reduce the sensitivity of the
printer to variations in light background
colors.

Edge Erase

You can erase content from the edges of
your images using the Edge Erase
feature. You can specify the amount to
erase on the right, left, top, and bottom
edges.
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ID

o Server Scan Card
Feature Description Copy Email  Fax Fax To Copy

Original Size To ensure that you are scanning the . . o o .
correct area of the documents, specify
the original document size.

Book Copying You can use the Book Copying featureto | e
copy books, magazines, or other bound
documents.

Front Cover You can print the first page of your copy |

job on different paper, such as colored or
heavyweight paper. The printer selects
the special paper from a different tray.
The cover can be blank or printed.

Annotations You can add Annotations such as page .
numbers and the date, to your copies.

Booklet Creation The Booklet Creation feature prints two .
pages on each side of the paper. The
pages are reordered so that they are in
numerical order when folded.

[0
[}
an

Page Layout You can print the selected number of .
pages on one side of a sheet of paper.
Selecting multiple pages per sheet saves
paper and provides a way to review the
layout of a document.

oo

Sample Copy Sample Copy allows you to print a test .
[-Fo copy of a job to inspect before printing
multiple copies. This feature is useful for
complex or high-volume jobs. After you
print and inspect the test copy, you can
choose to print or cancel the remaining
copies.
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Feature

Quantity

Server
Description Fax Fax

Use this option to enter the number of .
required ID card copies.

Preview

Use this option to view a sample image. . . . .
You can use Preview to continue scanning
and adding pages to a job.

Resolution

Resolution determines how fine or grainy . . o .
graphic images appear. Image resolution
is measured in dots per inch (dpi).

Contrast

You can use the Contrast feature to . .
adjust the variation between light and
dark areas of the image.

Remove Blank
Pages

Remove Blank Pages configures the . . . .
printer to ignore blank pages.

J L SliD] B INloE] o #

Book Scanning You can use the Book Scanning feature to . .
scan books, magazines, or other bound
documents.

Subject Use the Subject option to add a title or . .
heading to an email.

From Use the From option to specify the . .
originator of the email.

Reply To Use the Reply To option to include an . .

email address that you want the recipient
to reply to. This option is useful if you
want the recipient to reply to your email
address rather than to the device.
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Feature

Description

¥ Note: The system administrator
can preset this option.

Message Use Message to enter information to
accompany the email.
File Format Use the File Format option to specify the

format of the saved image or to define a
searchable image. You can add a
password to protect the image or choose
to combine multiple images into a single
file.

File Already Exists

Use the File Already Exists option to
define what action the device takes when
the file name is used already.

File Name Use the File Name option to specify a
name for the file containing the scanned
images.

Book Faxing You can use the Book Faxing feature to

scan images from books, magazines, or
other bound documents for faxing.

Starting Rate

Select the highest starting rate for
transmitting the fax, unless the
destination for the fax you are sending
has special requirements.

Cover Sheet

You can use the Cover Sheet option to
add an introduction page to the
beginning of your fax. You can add a
short comment to the cover sheet, as well
as To and From details.
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ID

Server Scan Card
Feature Description Copy  Email Fax Fax To Copy
Transmission It is unlawful to send a message from a .
Header Text fax machine without the proper

Transmission Header Text. Ensure that
the name and telephone number of the
sender, and the date and time of the
transmission is included on all faxes.

Delay Send You can set a time in the future for the . .
printer to send your fax job. You can
delay the send of your fax job for up to
24 hours.

Priority Send Use Priority Send to identify urgent faxes. .
Priority faxes are sent first.

& B

Manual Send You can use the Manual Send feature to .
enable the fax modem speaker
temporarily. This feature is helpful to dial
international numbers, or to use phone
systems that require you to wait for a
specific audio tone.

Polling Polling allows you to retrieve faxes stored .
((.)) on other fax machines.
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